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Notas de seguridad

Nota: Para cumplir los requisitos de la norma de seguridad BS EN61010, el 
dispositivo deberá contar con uno de los elementos siguientes como dispositivo de 
desconexión, identificado como tal e instalado al alcance del operador.

1. Un conmutador o disyuntor que cumpla los requisitos de IEC947-1 e IEC947-3.

2. Un acoplador separable que pueda desconectarse sin necesidad de 
herramientas.

3. Un enchufe separable, sin dispositivo de bloqueo, para conectar a la toma de 
corriente del edificio.

Nota: Con golpes fuertes a lo largo del eje de la placa base, el módulo IOC 
versadac podría restablecerse y reiniciarse.Mientras se reinicia, el registro se 
suspende temporalmente.El segmento 1 del switch de configuración en la unidad de 
terminal debe ajustarse en «OFF» (Desactivado) para evitar que el versadac acceda 
al modo de depuración al reiniciarse.

1. Antes de realizar ninguna otra conexión, deberá conectarse el terminal de 
protección de toma de tierra a un conductor de protección.El cableado eléctrico 
(corriente de alimentación) con la fuente de alimentación debe tener una 
terminación de forma que, en caso de que se suelte, el cable de tierra sea el 
último cable que se desconecte.

2. El terminal de tierra debe seguir conectado (aunque el equipo esté aislado de la 
corriente de alimentación) si alguno de los circuitos de E/S está conectado a 
tensiones peligrosas*.

3. Los fusibles no pueden ser reemplazados por el usuario.Si se sospecha que el 
fusible está defectuoso, deberá ponerse en contacto con el centro de servicio 
más próximo del fabricante.

4. Cuando sea probable que la protección esté dañada, la unidad deberá dejar de 
utilizarse y protegerse contra su uso accidental.Será preciso ponerse en 
contacto con el centro de servicio más próximo del fabricante.

5. Debe evitarse en la medida de lo posible realizar cualquier ajuste, 
mantenimiento o reparación del equipo abierto bajo tensión y, si es inevitable, 
solo deberá ser realizado por una persona cualificada al corriente de los riesgos 
que implica la operación.

6. Cuando pueda darse contaminación conductora (como condensación, polvo de 
carbón, etc.), deberá instalarse un sistema de acondicionamiento de aire,filtrado 
o sellado apropiado en la carcasa del registrador.

7. Si el equipo se utiliza de modo distinto a lo establecido por el fabricante, podría 
resultar afectada la protección que incorpora el equipo.

AVISO
Cualquier interrupción del conductor de protección en el interior o el exterior 
del aparato, o la desconexión del terminal de puesta a tierra puede motivar 
que el equipo sea peligroso en determinadas condiciones de avería.Se 
prohíbe su interrupción intencionada.
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8. Para cumplir los requisitos de BS EN61010, la tensión aplicada a los terminales 
de E/S no puede sobrepasar la tensión de aislamiento de dichos terminales.Para 
los terminales especificados como ‘sin aislamiento’, la tensión máxima permitida 
es de 30 V CA o 60V CC.

* Se incluye una definición completa de tensiones ‘peligrosas’ en ‘tensión peligrosa’ 
en BS EN61010.Brevemente, en condiciones operativas normales, las tensiones 
peligrosas se definen como 42,2 V pico CA (30 V RMS) o > 60 V CC.

Estrategia de aislamiento de E/S
El aislamiento se implementa en forma de una barrera de doble aislamiento (300 V) 
que separa todos los canales de E/S en un módulo del resto del sistema.

Esto evita que los voltajes peligrosos en cualquiera de los canales de E/S entrañen 
riesgos para el cableado relacionado con cualquier otro módulo de E/S o que pongan 
en peligro al resto del sistema.

Los módulos que incluyen aislamiento entre los canales garantizan aún más la 
seguridad y una buena calidad de la señal en todos los canales de dichos 
módulos.Para más información, consulte la sección correspondiente de "Anexo A: 
Especificaciones".

EMC
Este instrumento satisface los requisitos básicos de protección de la Directiva sobre 
EMC 89/336/EEC, modificada por 93/68/ECC.También satisface las emisiones y 
normas de inmunidad para entornos industriales.

La toma de tierra en el extremo inferior de la placa base también ofrece posibilidades 
de terminación para EMC, pantallas de cable, etc.

Para garantizar el cumplimiento de la Directiva Europea sobre EMC es necesario 
tomar ciertas precauciones durante la instalación:

• Si la placa base se monta en un carril DIN, este debe estar en contacto eléctrico 
con la hoja de aluminio o metal conectada a tierra que forma parte del 
aislamiento.Si este contacto no es posible, conecte ambos extremos del carril 
DIN o las dos conexiones a tierra de seguridad en los extremos de la placa base 
del aislamiento con dos trenzas de tierra (10 mm x 2 mm) de menos de 100 mm 
de longitud.

• Si la placa base se monta directamente en un panel, este debe estar en contacto 
eléctrico con la hoja de aluminio o metal conectada a tierra que forma parte del 
aislamiento.Si este contacto no es posible, las conexiones de toma a tierra en 
los extremos de la placa base tienen que conectarse al aislamiento con dos 
trenzas de tierra (10 mm x 2 mm) de menos de 100 mm de longitud.

Si estas conexiones no son prácticas, también se pueden utilizar abrazaderas de 
ferrita sobre los conductores de entrada lo más cerca posible del conector de unidad 
de terminal.No es necesario tener una abrazadera única para cada par de entrada; 
se pueden introducir varios pares de entradas mediante una abrazadera única.Las 
abrazaderas deben tener una impedancia mínima de 200 Ω a 100 MHz.Una 
abrazadera adecuada es Richco MSFC -13K.

General guidance (Directrices generales)   Consulte las directrices generales en 
la Guía de instalación de EMC (ref. HA025464).

Relay outputs (Salidas de relé)   Si se emplean salidas de relé puede ser nece-
sario instalar un filtro adecuado para suprimir las emisio-
nes conducidas.Las condiciones que deba cumplir el filtro 
dependerán del tipo de carga.
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Routing of wires (Enrutamiento de cables)   Para reducir al mínimo el ruido eléc-
trico, las conexiones CC de baja tensión y los cables de 
entrada del sensor deben mantenerse lejos de cables de 
alimentación de gran amperaje.Cuando no sea posible, 
deberán usarse cables apantallados.

Power supply (Alimentación eléctrica)   El dispositivo debe conectarse a la ali-
mentación eléctrica local y no debe conectarse a una red 
de distribución de CC.La alimentación debe contar con 
toma de tierra de acuerdo con las instrucciones del fabri-
cante para obtener el mejor rendimiento EMC para el sis-
tema.

Símbolos utilizados en el etiquetado del dispositivo
Las etiquetas del registrador pueden aparecer como parte del etiquetado de los 
artículos que componen este dispositivo.En algunos casos, los símbolos pueden 
incorporarse en las molduras o grabados en el metal.

Nombrar los archivos
Los nombres de archivo tan solo pueden contener los siguientes caracteres: 
números, letras (mayúsculas y minúsculas) y barra baja.Deben evitarse el resto de 
caracteres, ya que puede crear archivos históricos inválidos que no pueden 
transferirse.

40

Consulte las instrucciones en el manual del usuario

Terminal conductor de protección (toma a tierra).

Deben tomarse precauciones contra las descargas electroestáticas antes 
de manejar este artículo o cualquiera de sus componentes electrónicos.

Cumple la directiva RoHS2 (2011/65/EU).

Por motivos medioambientales, este artículo debe reciclarse antes de que 
su antigüedad supere el número de años que se muestra en el círculo.

Marca listada de Underwriters Laboratories para los Estados Unidos 
y Canadá

Este artículo cumple las directivas CE 

Este artículo cumple las directivas ACMA

Riesgo de descarga eléctrica
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Introducción
Este documento describe la instalación, operación y configuración de un registrador 
de datos versadac.El dispositivo admite hasta 16 módulos de E/S (según el tamaño 
de la unidad base) y está equipado para la trasferencia de archivos seguros via FTP 
o en unidad de memoria USB.

Estructura física
La unidad consta de un módulo de controlador de entrada salida (IOC) y una serie de 
módulos de entrada/salida (E/S), cada uno de los cuales se conecta a su propia 
unidad de terminal, que sirve de terminal para el cableado del usuario.Las unidades 
de terminales están situadas en una unidad base que se instala en un raíl DIN o un 
panel, según se requiera.Las unidades base están disponibles en distintos tamaños 
para adaptarse a distintos números de módulos de E/S (16 como máximo).

La parte inferior del frontal de la unidad está cubierto por una pestaña desmontable 
que protege el cableado pero deja los LED de estado a la vista.

Puede realizarse la sustitución en línea de un módulo de control que falle sin 
desconectar ningún cable.La indicación completa del estado del hardware y el 
software permite una rápida verificación y diagnóstico.

Al arrancar se realizan comprobaciones automáticas del estado, prueba automática 
e inicialización.El estado de E/S y las comunicaciones externas se comprueba 
continuamente y todos los módulos incluyen LED para indicar el estado de las 
comunicaciones y de E/S del módulo.

Módulos válidos
AI2  Dos canales de entrada analógica universal
AI3  Tres canales de entrada analógica usados para lazos de corriente, autoa-

limentados o con alimentación externa
AI4   Cuatro canales de entrada analógica válidos para su uso con termopares, 

entradas de mA o mV
AI8 Ocho canales de entrada analógica válidos para su uso 

con termopares, entradas de mA o mV y resistencias ter-
mométricas de cuatro canales de platino (RTD)

AO2   Dos canales de salida analógica que suministran señales de 0 a 20 mA o 
de 0 a 10 V

DI16   16 canales de entrada digital (entradas universales)
RLY8 Ocho relés (normalmente abiertos)

Alimentación
Se aplica corriente a los terminales instalados en el módulo IOC, como se muestra 
en la "Unidad de terminal del módulo controlador (IOC)" en la página 17.El sistema 
supervisa la tensión de alimentación y, en caso de que caiga por debajo de un valor 
aceptable, se activa una alarma.
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Instalación
Desembalaje del dispositivo

Las unidades se entregan en un paquete especial diseñado para ofrecer la 
protección adecuada durante el transporte. Si alguna de las cajas externas presenta 
señales de daño, ábrala inmediatamente y examine el registrador. En caso de 
confirmarse los daños, no ponga en funcionamiento el instrumento y contacte con su 
representante local para recibir instrucciones.

Después de sacar el dispositivo de su embalaje, inspeccione el embalaje para 
comprobar que ha retirado todos los accesorios y la documentación. Guarde el 
embalaje por si se necesita para su futuro transporte.

Instalación mecánica
Figura 1 proporciona detalles sobre las dimensiones; Figura 2 proporciona detalles 
de fijación

Figura 1 Dimensiones generales

132 mm (5,2 in)

Perfil del 
módulo 0:

Raíl DIN

70
 m

m
 (2

,7
5

in
)

18
0 

m
m

 (7
,1

 in
)

83,5 mm (3,29 in)

Cubierta 
abierta

Máx.: 160 mm (6,3 in)

Tamaño de 

0 Módulos 71 2,8
4 Módulos 172,5 6,8
8 Módulos 274 10,8
16 Módulos v477 18,8

Cubierta
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Figura 2 Detalles de fijación

Figura 3 Detalles de una base sin módulos

A A

Protección 
de las 
conexiones 

Raíl DIN

Clips de fijación 
del raíl DIN

Tamaño de 
la base
0 Módulos 26 1,02
4 Módulos 127,4 5,02
8 Módulos 229 9,02
16 Módulos 432,2 17,02

Clips de fijación del raíl 

Centros de fijación

Centros de fijación (véase tabla)
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Montaje de la unidad base
Esta unidad base está destinada a su instalación en un carril DIN o panel en una 
carcasa.

Montaje en carril DIN
Para el montaje en carril DIN, este debe ser simétrico, montado en horizontal y de 
35 x 7,5 o 35 x 15 de acuerdo a la normativa BS EN50022.

1. Monte el carril DIN usando los tornillos adecuados y compruebe que haga buen 
contacto eléctrico con la carcasa metálica mediante los tornillos o por medio de 
un cable de tierra apropiado.

2. Afloje los tornillos («A» en Figura 2 y Figura 3) de la unidad base dos o tres 
vueltas y permita que tanto ellos como los clips de fijación correspondientes se 
deslicen hasta el fondo de la ranura del tornillo.

3. Baje la unidad base sobre el carril DIN de forma que el borde superior del riel 
encaje en la ranura en la parte inferior de la barra de soporte (véase Figura 2 y 
Figura 3).

4. Deslice los tornillos (A) y los clips correspondientes tanto como pueda hacia la 
parte superior de las ranuras para tornillos y compruebe que la parte superior de 
cada clip de fijación se encuentre por detrás del borde inferior del carril DIN.

5. Apriete los tornillos y compruebe que la unidad base esté totalmente asegurada 
sobre el carril.

Montaje en panel

1. Retire los tornillos («A» en Figura 2 y Figura 3) y los clips de fijación 
correspondientes.

2. Sujete la unidad base horizontalmente sobre el panel y marque en este la 
posición de los dos orificios.

3. Haga dos orificios en el panel y use dos tornillos apropiados (se recomienda M5) 
para fijar la unidad al panel. Compruebe que exista buen contacto eléctrico con 
la carcasa metálica mediante los tornillos o por medio de un cable de tierra 
apropiado.

AVISO
El equipo no debe utilizarse sin conectar una toma de tierra de protección a 
uno de los terminales de tierra de la unidad base. El cable de tierra debe 
admitir al menos la misma corriente que el cable de alimentación más grande 
conectado al instrumento.
El cable de la toma de tierra de protección debe terminarse con un aro de 
cobre cubierto de estaño y apretarse hasta un par de 1,2 Nm empleando el 
tornillo y la arandela que se incluyen con la unidad base.
Esta conexión sirve también de toma de tierra de protección para EMC.

AVISO
Las cabezas de los tornillos no deben tener más de 5 mm de alto o no habrá 
suficiente espacio de separación entre la cabeza del tornillo y las unidades de 
terminales correspondientes.
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Cumplimiento de la directiva europea de EMC
Consulte las instrucciones de la sección NOTAS DE SEGURIDAD - EMC en la parte 
delantera de este manual, donde se describen las precauciones que deben tomarse 
para cumplir con la directiva.

Instalación de la unidad de terminal
1. Inserte la pestaña en la parte superior de la placa de circuito impreso de la 

unidad de terminal en la ranura correspondiente de la unidad base (acción «B» 
en Figura 4).

2. Presione la parte inferior de la unidad de terminal hasta escuchar un «clic» que 
confirme que el clip de fijación ha encajado perfectamente para sujetar la unidad 
de terminal (acción «C»).

Nota: Si la unidad base no tiene todos los módulos instalados, debe instalarse de 
inmediato una unidad terminal (incluida) a la derecha del último módulo para 
mantener la categoría IP20.

Desinstalación de la unidad de terminal
1. Desmonte el módulo de E/S de la unidad terminal, si está instalado ("Instalación 

del módulo" en la página 14, a continuación).

2. En caso necesario, retire todo el cableado de la unidad de terminal.

3. Presione el clip de fijación en la parte inferior de la unidad terminal y extraiga la 
unidad terminal (acción ‘D’).

Figura 4 Instalación y desinstalación de la unidad de terminal

Instalación del módulo

Módulos IOC
El módulo de controlador de entrada/salida (IOC) operativo (Figura 5) está instalado 
en la ranura más a la izquierda; se instala un tapón ciego en la ranura adyacente.



Versadac Instalación

HA031352 Edición 3 15

Para instalar un IOC:

1. Use un destornillador plano de 3 mm para girar el 
tornillo de fijación en sentido antihorario (hacia la 
izquierda) hasta la posición de desbloqueo.

2. Introduzca el módulo en la unidad de terminal y la 
placa base, y presione hasta que encaje.

3. Use un destornillador plano de 3 mm para 
asegurarse de girar el tornillo de fijación 90 grados 
en sentido horario hasta la posición de bloqueo.

Para desinstalar el IOC:

1. Use un destornillador plano de 3 mm para girar el 
tornillo de fijación 90 grados en sentido antihorario 
(hacia la izquierda) hasta la posición de 
desbloqueo.

2. Suelte el módulo y extráigalo de la unidad base.

Nota: Aunque puede retirarse la pestaña de cubierta E/S (unidades de 4/8/16 vías) 
para facilitar el acceso a las unidades de terminal, las piezas laterales deben dejarse 
en su sitio para ofrecer apoyo y orientar la inserción.

Módulos de E/S
Para insertar un módulo de E/S:

1. Mueva la palanca de sujeción del módulo 
hacia delante hasta la posición de 
desbloqueo, como se muestra en Figura 6.

2. Introduzca el módulo en la unidad de 
terminal y la placa base, y presione hasta 
que encaje.

3. Devuelva la palanca de sujeción a la 
posición de bloqueo.

Para desinstalar un módulo de E/S:

1. Mueva la palanca de sujeción del módulo 
hacia delante hasta la posición de 
desbloqueo, como se muestra en Figura 6.

2. Libere el módulo del conector de la placa 
base y extráigalo de la unidad base.

Bloqueado

Desbloqueado

Figura 5  Instalación 
de IOC

PRECAUCIÓN
Asegúrese de usar la unidad de terminal correcta para el tipo de módulo de 
E/S que se instala. En particular, la instalación de un módulo AI2 en una 
unidad de terminal AI4 o viceversa provoca un comportamiento inesperado 
que puede dañar el proceso controlado.

Figura 6 Instalación 
del módulo de E/S



Instalación Versadac

16 HA031352 Edición 3 

Identificación de módulos
El interior de la cubierta contiene ubicaciones (‘ranuras’) para etiquetas que pueden 
usarse para identificar el módulo instalado ‘encima’ de cada ranura.

Se incluye una plantilla de documento en el DVD que permite al usuario imprimir 
sobre una hoja adhesiva precortada (GA030486, incluida con el instrumento). Una 
vez imprimidas, las etiquetas correspondientes pueden despegarse de la hoja y 
adherirse a sus respectivas ranuras.

Figura 7 Cubierta interior

Instalación eléctrica

Localizaciones de etiqueta 
(1 por módulo)
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Unidad de terminal del módulo controlador (IOC)

Figura 8 Cableado de la unidad de terminal del IOC

Cableado de alimentación
Figura 8 muestra la unidad de terminal del módulo de control con detalles del 
cableado para la alimentación y para la batería.

Nota: Si la tensión de alimentación cae por debajo de 19,2 V durante el inicio, el 
dispositivo no arrancará con éxito y se reiniciará repetidamente.

La tensión de alimentación del instrumento es de 24 V CC ± 20%.

Los requisitos por defecto de potencia son 150 mA (3,6 W) por módulo de control, 
más 0,5 A (12 W) para una unidad de cuatro módulos, 1 A (24 W) para una unidad 
de ocho módulos o 2 A (48 W) para una unidad de 16 módulos.

Fusibles
La línea de alimentación positiva debe incluir un fusible. Un fusible 4A tipo T es 
apropiado.

Tamaños de cables
CABLEADO DE ALIMENTACIÓN de 0,25 mm2 a 2,5 mm2 (de 20 AWG a 14 AWG)

+

-

+

-

Batería:

Código de pedido 
SUBVERSA.BATT (Se 
muestra con la cubierta 
retirada)

Conector 
USB

Fusible 4A 
tipo T

PSU

(24 VCC) ±20 %

PRECAUCIÓN
Ninguna línea de alimentación debe superar los 30 voltios en relación con la 
toma a tierra.
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Nota: Los diámetros anteriores hacen referencia a la sección total de los 
conductores insertados en el terminal.

Detalles del terminal
Tipo de destornillador recomendado para el conector de corriente de alimentación: 
punta plana de 3mm.

Par de apriete máximo: 0,6 Nm (5,31 lb in)

Capacidad máxima de transporte de corriente: 5 A por patilla.

Toma a tierra
A continuación, Figura 2 y el texto adjunto ofrecen detalles sobre la toma a tierra.

Conectores de comunicaciones
Se utiliza una toma de conector tipo D de 9 vías, situada como se muestra arriba en 
Figura 8, para las comunicaciones serie EIA485. Figura 9 muestra las patillas y su 
disposición para el conector de 9 vías correspondiente.

Consulte "Configuración de tendencia de grupo" en la página 89 para más 
información sobre la configuración.

Figura 9 Patillaje de RJ45 (EIA485)
Notas:

1. El mejor rendimiento de RFI se obtiene si la pantalla también está conectada a 
tierra en el otro extremo, pero consulte la advertencia a continuación.

2. Seleccione el funcionamiento de 3 o 5 hilos usando el interruptor deslizante de 
ocho elementos (SW3) situado en la placa de terminales del módulo IOC. Las 
líneas Tx y Rx también pueden terminarse (con resistencia de 150 Ω) usando 
otros elementos de este interruptor. Consulte la figura 10 para más detalles.

PRECAUCIÓN
Debe tenerse en cuenta la capacidad máxima de transporte de corriente para 
la conexión en cadena.

AVISO
Si la pantalla está conectada a tierra en ambos extremos, compruebe que las 
diferencias de potencial de tierra en los extremos del cable son iguales. Si no 
es así, corrientes muy grandes pueden transmitirse a través de la pantalla y 
hacer que el cable se caliente lo suficiente como para causar daños al 
personal que entre en contacto con él y/o causar un incendio.

Vista de caja de contactos 
soldados del conector macho 
(enchufe)

Patilla 3 hilos 5 hilos

1 NC NC
2 B TXB
3 Reservado RxB
4 Tierra Tierra
5 Tierra Tierra
6 Tierra Tierra
7 A TxA
8 Reservado RxB
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Configuración del hardware de comunicaciones
La configuración de las comunicaciones se realiza usando SW2 en la unidad de 
terminal del IOC, como se muestra a continuación:

Figura 10 Detalles de configuración del hardware de comunicaciones

Conector USB
Un solo conector USB tipo A, para comunicaciones host USB 2.0, está situado en la 
unidad de terminales del IOC como se muestra en Figura 8.

El conector está destinado a su uso con unidades de memoria USB y puede 
suministrar hasta 500 mA. Cualquier intento de obtener más de 500 mA originará 
que el circuito limitador de corriente desconecte el USB.

El módulo IOC consta de un fusible USB que impide que el sistema completo de 
fuente de alimentación 
se vea afectado en el caso improbable de que se produzca un fallo del USB. El 
usuario no puede sustituir los fusibles, por lo que en caso de fallo, el módulo debe 
devolverse al proveedor para su mantenimiento.

Indicadores de estado de IOC
Figura 11 muestra los LED del panel frontal de IOC A continuación, se describen los 
LED de otros módulos en las secciones correspondientes.

Figura 11 LED de IOC

+ +

--

Configure en «DE» para habilitar la depuración en serie* y en «OFF» (Desactivado) 
para deshabilitarla.
Configure en «TR» para terminar la línea Rx y en «OFF» (Desactivado) para dejar Rx 
sin terminar.
Ajustar en ‘TT’ para terminar la línea Tx; ajustar en ‘OFF’ para dejar Tx sin terminar.
Ajustar en ‘B3’ para comunicaciones serie de 3 hilos; ajustar en ‘B5’ para 5 hilos.
Ajustar en ‘A3’ para comunicaciones serie de 3 hilos; ajustar en ‘A5’ para 5 hilos.
Reservado
Reservado

*Consulte «Ethernet (Modbus TCP) Communications» 
(Comunicaciones Ethernet [Moodbus/TCP]) en la página 24.

Estado
Fallo

Batería

Estado de la IP de Ethernet

Software USB
Hardware USB

Velocidad de Ethernet
Actividad de Ethernet
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Interpretación de los LED
LED Función
Status (Estado) (verde) On (Activado): Entrada de alimentación válida

Off: Fallo de alimentación
Fault (Fallo) (rojo) On (Activado): Falta el módulo o está defectuoso

Parpadeando: Fallo del relé de vigilancia
Off: No se han detectado fallos de hardware

Battery (Batería) (verde) On (Activado): Batería OK
Flashing (Intermitente): no instalación o fallo de batería

Estado de IP de Ethernet On (Activado): versadac en línea con al menos una 
conexión CIP

(verde) Flashing (Intermitente): versadac en línea pero sin cone-
xiones CIP
Off (Desactivado): versadac está inicializando las comuni-
caciones o se ha excedido el tiempo de una conexión 

Software USB (verde) On (Activado): dispositivo USB conectado.
Parpadeando: se está accediendo al dispositivo USB. no 
debe desconectarse el dispositivo USB.
Off: El dispositivo USB no está usándose y puede desco-
nectarse.

Hardware USB (amarillo) On (Activado): se ha intentado obtener demasiada in-
tensidad (>500 mA) de la toma USB. Se ha suspendido la 
actividad USB.
Off: no se han comunicado fallos de hardware.

Ethernet speed (Velocidad Ethernet) On (Activado): 100MB
(verde) Off (Desactivado): 10MB
Ethernet activity (Actividad Ethernet) On (Activado): conectado a una red Ether-

net activa
(amarillo) Flickering (Intermitente): se detecta tráfico en la red

Off: conexión Ethernet no válida

Módulo de entrada de dos canales analógicos(AI2)
Este módulo puede encargarse en distintas versiones para medir entradas de 
termopar, entradas de resistencia termométrica, voltios/mV o mA. Figura 12 ofrece 
detalles del patillaje.
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Figura 12 Patillaje de módulo AI2
Nota: Nota: Los terminales del módulo aceptan secciones de cable de entre 0,20 y 
2,5 mm2  (de 14 a 22 AWG). Los tornillos deberán ajustarse a 0,4 Nm (3,54 lb in) 
con un destornillador de punta plana de 3,5 mm.

A2 C2

H1 C1 H2 C2

C2 B2A2 I2C1 B1A1 I1

C2 B2A2 I2C1 B1A1 I1

H1 B1 H2 B2

I1 D1 I2 D2

A1 C1 A2 C2

H1 B1 H2 B2

I1 D1 I2 D2

A1 C1 A2 C2

mA mA

A1 C1 A2 C2A1 C1 A2 C2

H1 B1 H2 B2

I1 D1 I2 D2

A1 C1 A2 C2

2 2

150mV

1 1

1 1 2 2

1+ 1- 2+ 2-

150mV

150mV 150mV

C2 B2A2 I2C1 B1A1 I1

C2 B2A2 I2C1 B1A1 I1

C2 B2A2 I2C1 B1A1 I1

No se recomienda conectar 
más de una entrada a una 
fuente única, en concreto, 
termopares, ya que podría 
poner en riesgo la medida y 
acción de desconexión del 
sensor.

Tampoco se recomienda 
conectar instrumentos 
adicionales a una fuente de 
entrada única.

Termopar Termopar RTD (2 hilos) RTD (2 hilos)

RTD (3 hilos) RTD (3 hilos)

0 a 1,8V RTD (4 hilos) RTD (4 hilos)

Resistencia Resistencia

Potenciómetro Potenciómetr

Aislamiento básico

Se montan de fábrica resistores 
de derivación en la parte trasera  
de la unidad terminal

mV mV

mV mV mA mA

V V

V

Entrada de termopar/mV Entrada de tensión Entrada de RTD Entrada de mA
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Indicadores de estado

Figura 13 Indicadores AI2 de estado

Módulo de entrada analógica de tres canales (AI3)
Este módulo ofrece tres canales de entrada mA aislados. Los terminales «P» y «C» 
proporcionan una corriente aislada de 24 V (nominal) para alimentar el lazo de 
corriente. Si el bucle de corriente es autoalimentado, deben usarse los terminales ‘C’ 
e ‘I’. Figura 14 muestra el patillaje.

Figura 14 Patillaje de módulo AI3

En verde

Off

Funcionamiento normal

No recibe alimentación,
No hay comunicación
Tipo de módulo 
incorrecto

Off

En rojo

Parpadeo en 
rojo/apagado

Funcionamiento normal

Desconexión sensor Ch1
Inicialización del canal 1

Fallo CJC Ch1
Datos cal incorrecto Ch1

Como arriba pero para el canal 2

Nota:  Intermitente = 0,5 s encendido, 
0.5 s desactivado

Corriente suministrada al módulo
T  = transmisor de 4 a 20 mA de dos cables

Entradas fuente de corriente

Aislamiento básico

Entrada de mA Entrada de mA
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Indicadores de estado

Figura 15 Indicadores AI3 de estado
Nota: Los terminales del módulo aceptan secciones de cable de entre 0,20 y 2,5 
mm2  (de 14 a 22 AWG).

Los tornillos deberán ajustarse a 0,4 Nm (3,54 lb in) con un destornillador de punta 
plana de 3,5 mm.

Compatibilidad con Hart
Se instala una resistencia de 195 Ω en cada canal en el circuito de entrada al 
amplificador. Normalmente, estas resistencias se derivan mediante conexiones de 
circuito impreso en la parte inferior de la unidad terminal. Para hacer que el módulo 
sea compatible con Hart, es posible cortar estas conexiones y poner las resistencias 
en serie con las entradas del amplificador.

Figura 16 muestra el circuito equivalente del módulo y Figura 17 muestra la 
ubicación de las conexiones en la parte inferior de la unidad de terminal.

Figura 16 Circuito equivalente del módulo AI3

En verde

Off

Funcionamiento normal

No recibe alimentación,
No hay comunicación
Tipo de módulo 
incorrecto

Off

En rojo

Parpadeo en 
rojo/apagado

Funcionamiento normal

Desconexión sensor Ch1
Inicialización del canal 1

Datos cal incorrecto Ch1

Como arriba pero para los canales 2 y 3

Nota:  Intermitente = 0,5 s encendido, 
0.5 s desactivado

Conexión cortable (una por canal)

Fuente de corriente 
24V

Amplificador 
de entrada
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Figura 17 Ubicación de las conexiones en la parte inferior de la unidad de terminal

Módulo de entrada analógica de cuatro canales (AI4)
Este módulo puede encargarse en distintas versiones para medir entradas de 
termopar, mV o mA. Figura 18 ofrece detalles del patillaje.

Figura 18 Patillaje de módulo AI4 

Los números son números de canales

Para las entradas mixtas de termopar y mV, el canal 
1 debe ser una entrada de termopar (para garantizar 
el correcto funcionamiento de CJC).

Las entradas de mV pueden convertirse en entradas 
de mA si se conecta a las entradas una resistencia 
de 5 Ω.

No se recomienda conectar más de una entrada a 
una fuente única, en concreto, termopares, ya que 
podría poner en riesgo la medida y acción de 
desconexión del sensor.

Tampoco se recomienda conectar instrumentos 
adicionales a una fuente de entrada única.

Para las versiones de mA, se instalan resistencias de 
derivación de 5 Ω de fábrica en la unidad de terminal.

Las versiones mA no deben tener entradas de termopar o 
mV conectadas.

Para todas las versiones:

el terminal 1 se conecta internamente al terminal 2 y el 
terminal 3 se conecta internamente al terminal 4.

Termopares, milivoltios y miliamperios

Aislamiento básico

Termopar

Termopar

Termopar

Termopar
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Nota: Nota: Los terminales del módulo aceptan secciones de cable de entre 0,20 y 
2,5 mm2  (de 14 a 22 AWG). Los tornillos deberán ajustarse a 0,4 Nm (3,54 lb in) 
con un destornillador de punta plana de 3,5 mm.

Indicadores de estado

Figura 19 Indicadores de estado de AI4

Módulo de entrada analógica de ocho canales (AI8)
Este módulo puede encargarse como una de las tres versiones para medir ocho 
entradas de termopar/mV, ocho entradas de mA o cuatro entradas de resistencia 
termométrica de platino de 3 hilos (RTD). Las siguientes figuras ofrecen detalles del 
patillaje de cada versión.

El sistema reconoce automáticamente cada tipo de módulo cuando se conecta.

En verde

Off

Funcionamiento normal

No recibe alimentación,
No hay comunicación
Tipo de módulo 
incorrecto

Off

En rojo

Parpadeo en 
rojo/apagado

Funcionamiento normal

Desconexión sensor Ch1/2
Inicialización de los canales 1 y 2

Fallo CJC Ch1/2
Datos cal incorrecto Ch1/2

Como arriba pero para los canales 3 y 4

Nota: Intermitente = 0,5 s encendido, 
0.5 s desactivado



Instalación Versadac

26 HA031352 Edición 3 

Entradas de termopares, milivoltios y miliamperios

Figura 20 Patillaje de módulo AI8 para entradas de termopar, mV y mA

Entradas de resistencia termométrica de platino (RTD)

Figura 21 Entradas RTD del AI8

Entradas de termopares, milivoltios y miliamperios

Termopares y milivoltios miliamperios

Aislamiento básico 
entre parejas de 
canales.

Si el cableado del termopar 
necesita ampliarse, utilice el 
cable de compensación 
adecuado y asegúrese de 
que se respeta la polaridad.

Los módulos de mA (AI8) 
tienen resistencias 
integrales de 3,33 Ω 
instaladas.

Termopares miliamperios

Si se activa la desconexión del sensor (véase «IO 
Main» [E/S principal] en la página 79), no se 
recomienda conectar más de una entrada a una 
fuente única ( p. ej. termopar o mV), ya que podría 
poner en riesgo la medida y acción de desconexión 
del sensor.

Tampoco se recomienda conectar instrumentos 
adicionales a una fuente de entrada única.

milivoltios AI8-TC AI8-MA

Entradas de resistencia termométrica de platino entrada

Aislamiento básico entre 
todos los canales.

RTD

AI8-RT

Se muestra la conexión RTD de 3 cables. 

Los RTD de 2 y 4 hilos pueden usarse mediante las 
siguientes conexiones:

Si es un RTD de 2 hilos, conecte el terminal b y el c.

Si es un RTD de 4 hilos, no conecte uno de los cables de 
compensación
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Descargas electrostáticas 
Es posible que se aplique una descarga de 4 kV a los terminales de entrada del 
módulo AI8 sin que provoque ningún daño. Sin embargo, hay que tener en cuenta 
que la lectura media variará cuando se aplique la descarga y necesitará 20 s hasta 
volver a la normalidad después de que haya suprimido la descarga.

Indicadores de estado
El estado del módulo se muestra con un único LED verde. El estado de los canales 
individuales se muestran con ocho LED rojas como se muestra en Figura 22.

Figura 22 Indicadores de estado del módulo AI8

Módulo de entrada de dos canales de salida analógica(AO2)
Este módulo ofrece dos canales de salida aislados que pueden configurarse 
independientemente (en el software) como salidas de tensión o corriente. El rango 
de salida de tensión especificado (de 0 a 10 V) puede ampliarse ligeramente (de 
-0,3 V a +10,3 V) limitando la carga a un valor mínimo de 1500 Ω. Figura 23 muestra 
el patillaje del módulo

Off No recibe alimentación
Módulo desconocido

En verde Funcionamiento normal -
Módulo siendo analizado

Verde 
intermitente

Condición de error

Off Funcionamiento normal
En rojo Condición de error

Por ejemplo, debido a la 
desconexión de sensor, 
superar por encima o por 
debajo el rango de 
hardware o una mala 
calibración.

Es igual para cada canal
Solo para la versión RTD, se utilizan los LED 
del 1 al 4. Los LED del 5 al 8 no se utilizan.
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Figura 23 Patillaje de módulo AO2
Nota: Los terminales del módulo aceptan secciones de cable de entre 0,20 y 2,5 
mm2  (de 14 a 22 AWG). Los tornillos deberán ajustarse a 0,4 Nm (3,54 lb in) con un 
destornillador de punta plana de 3,5 mm.

Indicadores de estado

Figura 24 Indicadores de estado del módulo AO2

Rv

1+ 1- 2+ 2-

1 1

Rv

2 2

Ri Ri

1 1 2 2

Rv min = 550R

Ri  max = 500R

Tensión, salidas de miliamperios

0 a 10V 0 a 10V

De 0 a 20mA De 0 a 20mA

En verde Funcionamiento normal

Off
No recibe alimentación,
No hay comunicación
Tipo de módulo incorrecto

Off Funcionamiento normal

En rojo
Ch1 saturado
Inicialización del canal 1

Parpadeo en 
rojo/apagado

Datos cal incorrecto Ch1

Como arriba pero para el canal 2
Nota: Intermitente = 0,5 s encendido, 0.5 s 
desactivado
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Módulo de entrada digital de 16 canales (DI16)
Este módulo ofrece 16 entradas digitales que admiten entradas lógicas o de cierre 
de contacto. Es posible mezclar libremente ambos tipos de entrada en cada módulo 
DI16.

Nota: Los terminales ‘P’ están conectados internamente entre ellos y los terminales 
‘C’ están conectados internamente entre ellos.

Figura 25 Patillaje de módulo DI16
Nota: Los terminales del módulo aceptan secciones de cable de entre 0,20 y 2,5 
mm2  (de 14 a 22 AWG). Los tornillos deberán ajustarse a 0,4 Nm (3,54 lb in) con un 
destornillador de punta plana de 3,5 mm.

Indicadores de estado

Figura 26 Indicadores de estado del módulo DI16

Entradas lógicas/de cierre de contacto

Se muestra el canal 1;

Es el mismo caso en 
los otros canales

Entradas lógicas (CC)
Off (Desactivado) = de 
-30 V a +5 VDC
On (Activado) = de 
10,8 V a 30 VDC

Off (Desactivado) = >7 kΩ
On (Activado) = <1 kΩ
Patillas de tensión de circuito abierto
P = 18 VDC PRT

Entrada lógica Entradas de contacto

Se muestra el canal 1;

Es el mismo caso en 
los otros canales

On Funcionamiento normal

Off
No recibe alimentación,
Tipo de módulo incorrecto
No hay comunicación

Off Entrada relevante 
desconectada

En amarillo Entrada relevante 
conectada

Es igual para cada canal
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Módulo de relé de 8 salidas (RLY8)
Este módulo ofrece ocho salidas de relé con contactos comunes/normalmente 
abiertos. Este módulo no incluye circuitería de amortiguación, por lo que el usuario 
tiene la responsabilidad de incorporar los elementos necesarios para proteger los 
contactos de relé contra el desgaste indebido y para mantener la conformidad CE del 
sistema.

Figura 27 Patillaje de módulo RLY8
Nota: Los terminales del módulo aceptan secciones de cable de entre 0,20 y 2,5 
mm2  (de 14 a 22 AWG). Los tornillos deberán ajustarse a 0,4 Nm (3,54 lb in) con un 
destornillador de punta plana de 3,5 mm.

Indicadores de estado

Figura 28 Indicadores de estado de RLY8

Salidas de relé

Intensidad máxima:

2 A a hasta 240 V RMS.

De 0,5 A en 200 VDC y aumento a 2 A en 50 VDC

Intensidad mínima: 100 mA a 12 V.

Las especificaciones anteriores son para cargas 
resistivas.

Para más información, consulte «RLY8 Module» 
(Módulo RLY8) en la página 189.

Se muestra el canal 
1;
Es el mismo caso 
para otros canales

Salida de relé

En verde Funcionamiento normal

Off
No recibe alimentación,
No hay comunicación
Tipo de módulo incorrecto

Off Salida correspondiente off 
(desactivada)

En amarillo Salida correspondiente on (activada)
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iTools
Gracias a iTools, un software propietario ejecutable en Windows, se puede 
configurar la unidad y monitorizar los valores de los parámetros. iTools permite 
acceder de manera rápida y fácil a la configuración de la unidad y le ofrece al usuario 
la posibilidad de crear el cableado del software entre los bloques de funciones 
usando el editor de cableado gráfico.

iTools puede usarse para asignar canales de entrada y matemáticos individuales a 
uno o varios grupos de registro. El contenido de estos grupos puede descargarse 
después en el software "Software Review" en la página 68 que presenta los canales 
en una tabla u hoja de cálculo.

Además de las instrucciones incluidas en el resto de la sección, iTools cuenta con 
dos sistemas de ayuda online: la ayuda de parámetros y la ayuda de iTools. Para 
acceder a la ayuda de parámetros, pulse «Ayuda» en la barra de herramientas (se 
abrirá el sistema de ayuda de parámetros completo), haga clic con el botón derecho 
del ratón en un parámetro y seleccione «Ayuda de parámetro» en el menú contextual 
que aparece, o bien abra el menú «Ayuda» y seleccione «Ayuda de dispositivo». 
Para acceder a la ayuda de iTools, abra el menú «Ayuda» y seleccione 
«Contenidos». La ayuda de iTools también está disponible en forma de manual con 
número de referencia HA028838, tanto como manual físico como en formato PDF.

Figura 29 Acceso a la ayuda de iTools

Conexión de iTools
En lo que sigue, se da por supuesto que el software iTools se ha instalado 
correctamente en el PC.

Comunicaciones Ethernet (Modbus TCP)
Nota: La siguiente descripción se basa en Windows XP. Para Windows 7 es similar.

En primer lugar, hay que determinar la dirección IP de la unidad, tal como se explica 
en "Interfaz" en la página 80.

Una vez instalada la conexión Ethernet, efectúe las siguientes operaciones en el PC:

1. Haga clic en Inicio

2. Haga clic en Panel de control. (Si el panel de control se abre en la vista por 
categorías, seleccione la vista clásica).

3. Haga doble clic en iTools.

4. Haga clic en la ficha TCP/IP en la configuración de ajustes del registro.
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5. Haga clic en «Add...» (Añadir...). Se abrirá la pantalla «New TCP/IP Port» 
(Nuevo puerto TCP/IP).

6. Escriba un nombre para el puerto y vuelva a hacer clic en «Add...» (Añadir...).

7. Escriba la dirección IP de la unidad en el campo «Host Name/Address:» 
(Nombre/dirección de host:). Haga clic en OK.

8. Compruebe los datos en el cuadro Nuevo puerto TCP/IP y, a continuación, haga 
clic en Aceptar.

9. Haga clic en Aceptar en el cuadro Ajustes de registro para confirmar el nuevo 
puerto.

Figura 30 Configuración de un nuevo puerto Ethernet
Para comprobar que el PC pueda comunicarse con el registrador, haga clic en 
«Start» (Inicio). «Todos los programas», «Accesorios», «Símbolo del sistema».

Cuando se abra la ventana Símbolo del sistema, escriba:

Ping<espacio>IP1.IP2.IP3.IP4<Intro> (donde IP1 a IP4 es la dirección IP del 
instrumento). La dirección predeterminada es 192.168.111.222.

Si el enlace Ethernet con el instrumento funciona correctamente, llega la respuesta 
satisfactoria. De lo contrario, se recibirá la respuesta «failed» (error), en cuyo caso 
deberá verificarse el enlace Ethernet, la dirección IP y el puerto del PC.
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Figura 31 Pantallas «Ping» en el símbolo del sistema (habitual)
Después de verificar el enlace Ethernet con el registrador, puede iniciar iTools (o 
cerrar y reiniciar) y utilizar el icono «Scan» (Escanear) en la barra de herramientas 
para encontrar el registrador.

Puede detener la búsqueda en cualquier momento volviendo a pulsar en el icono 
"Scan".

Consulte la "Escaneo de instrumentos" en la página 37 para obtener más detalles 
sobre el procedimiento de búsqueda.

Recuperación en caso de configuración con dirección IP 
desconocida
Si el interruptor DE (Habilitar depuración) de la unidad terminal se establece en 
«ON» (Activado) (véase «Controller Module (IOC) Terminal Unit» [Unidad de 
terminal del módulo controlador (IOC)] en la página 10) y el dispositivo se reinicia, el 
puerto serie de comunicaciones de la placa terminal se convierte en un puerto de 
depuración (38 400 baudios, un bit de stop, sin paridad)*. Esto presenta un sencillo 
menú en un emulador de terminal que permite ver los ajustes de red.

Una vez terminado con el puerto de depuración, el interruptor DE debe ajustarse en 
«OFF» (Desactivado) y reiniciar el dispositivo para reanudar el funcionamiento 
normal.

Nota: *El protocolo usado es EIA-485. Hay disponible un convertidor apropiado 
para comunicación con un ordenador (código de pedido 
SUBVERSA.DEBUGCABLE)
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Conexión directa
Esta sección explica cómo conectar un PC directamente con el 
dispositivo.

La conexión se realiza entre el conector Ethernet del dispositivo y 
un conector Ethernet RJ45, que normalmente está situado en la 
parte posterior del PC. El cable puede ser cruzado o directo.

Después de conectar y encender la unidad, especifique la dirección 
IP y la máscara de subred en la configuración de comunicaciones 
de versadac. Esta información se puede localizar como sigue:

1. En el PC, haga clic en «Inicio». Todos los programas, Accesorios, Símbolo del 
sistema.

2. Cuando aparezca el símbolo del sistema, escriba: IPConfig<Intro>

La respuesta es una pantalla como la mostrada debajo que indica la dirección IP 
y la máscara de subred del PC.

Seleccione una direción en el rango cubierto por estos dos valores.

Un elemento de máscara de subred de 255 significa que el elemento equivalente 
de la dirección IP debe usarse sin cambiarlo. mientras que un elemento de 
máscara de subred de 0 significa que el elemento equivalente de la dirección IP 
puede tener cualquier valor entre 1 y 255 (no se permite el 0). En el  siguiente 
ejemplo, el rango de direcciones IP que se pueden seleccionar es de 
123.123.123.2 a 123.123.123.255.

Tenga en cuenta que no se permite la dirección 123.123.123.0 ni 123.123.123.1 
al ser la misma que la del PC.

Figura 32 Comando IP Config
3. En la configuración Network.Interface (véase «Interface» [Interfaz] en la página 

67), introduzca la dirección IP y la máscara de subred (como aparecen en la 
ventana del símbolo del sistema) en el campo del parámetro correspondiente.

4. Compruebe las comunicaciones mediante el comando Ping, según se describe 
en "Comunicaciones Ethernet (Modbus TCP)" en la página 32.

Después de verificar el enlace con el instrumento, puede iniciar iTools (o cerrar y 
reiniciar) y utilizar el icono Scan en la barra de herramientas para encontrar el 
instrumento. Puede detener la búsqueda en cualquier momento volviendo a pulsar 
en el icono "Scan".

Conector 
Ethernet 
del PC
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Consulte la "Escaneo de instrumentos" en la página 37 para obtener más detalles 
sobre el procedimiento de búsqueda.

Figura 33 Máscara de subred y rango de direcciones IP reconocidas

Direcciones IP y máscaras de subred
Las máscaras de subred se entienden mejor si se ven en formato binario.

Por ejemplo, una máscara de 255.255.240.10 se puede reescribir como:
11111111.11111111.11110000.00001010. En este caso, se reconocerán las direcciones IP
11111111.11111111.1111Xxxx.xxxx1x1x se reconocen (donde x puede ser 0 o 1)

Máscara de subred
Direcciones IP (binario)

Direcciones IP 255 255 240 a 255 10, 11, 14, 15, 26, 
27, 30, 31, 42, 43, 
46, 47 etc.
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Escaneo de instrumentos
Para definir un rango de búsqueda de direcciones, haga clic en el icono «Scan» 
(Escanear) de la barra de herramientas y se mostrará «Enable Background Scan» 
(Habilitar escaneo en segundo plano).

Notas:

1. La dirección del dispositivo es la especificada en el área de configuración 
Network.Modbus (véase "ModBus TCP" en la página 86), y puede adoptar 
cualquier valor entre 1 y 254 inclusive, siempre y cuando sea exclusiva para el 
enlace de comunicaciones.

2. La opción predeterminada («Scan all device addresses...» [Escanear las 
direcciones de todos los dispositivos...]) detectará cualquier dispositivo en la red 
que tenga una dirección válida.

A medida que avanza la búsqueda, los dispositivos detectados aparecen como 
miniaturas en el área Panel Views (Vistas de panel), situado normalmente en la parte 
inferior de la pantalla de iTools, y en la lista de dispositivos cerca de la esquina 
inferior izquierda de la ventana. Para buscar un único dispositivo, haga clic en la 
casilla «Terminate Scan when first device found» (Finalizar escaneo cuando se 
encuentre el primer dispositivo).

Figura 34 Habilitar rango de búsqueda
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Figura 35 La ventana de inicio de iTools con un dispositivo detectado
Cuando se haya detectado, detenga la búsqueda (si es necesario) y espere a que se 
sincronice el dispositivo (véase abajo) Cualquier intento de acceder a la 
configuración del dispositivo antes de que finalice la sincronización generará un 
mensaje de error.

Figura 36 Sincronizado

Establecer contraseña de ingeniero
A partir de la versión de Vedasac 2.39, se requerirá establecer la contraseña de 
Engineer (Ingeniería) en la primera conexión a iTools. Para establecerla, siga los 
siguientes pasos:

1. Haga clic en «Scan» (Escanear) Cuando se detecte un dispositivo, iTools 
mostrará un mensaje en el que le indica al usuario la necesidad de 
establecer la Contraseña de ingeniero antes de continuar.

Dispositivo 
sincronizándose
Dispositivo sincronizado
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2. Haga clic en «Yes» (Sí) Se mostrará un cuadro de diálogo para establecer 
la contraseña.

3. Entre, confirme la contraseña y haga clic en «OK»

Tenga en cuenta lo siguiente:

• La contraseña debe contener al menos ocho caracteres.

• Es necesario que la contraseña incluya uno de los cuatro siguientes tipos de 
carácter:

– MAYÚSCULAS [A-Z]

– minúsculas [a-z]

– Números (0-9)

– caracteres especiales [! $ # %, etc]

• Aplique un período de bloqueo después de tres intentos fallidos.

Si la contraseña introducida no cumple todos los requisitos indicados, se mostrará el 
siguiente mensaje:

Inicio de sesión 

Pulse el botón «Login» (Inicio de sesión) e introduzca la contraseña de ingeniero. A 
continuación, introduzca el «User Name» (Nombre de usuario) y el «Password» 
(Contraseña) (distingue mayúsculas y minúsculas). La descripción del botón «Log 
In» (Iniciar sesión) cambia a «Log Out» (Cerrar sesión).

Si se intenta acceder al dispositivo antes de iniciar sesión, se recibirá una solicitud 
de inicio de sesión.
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Figura 37 Ventana de inicio de sesión y mensaje de solicitud de inicio de sesión.
Para cerrar la sesión, haga clic en el botón «Log Out» (Cerrar sesión).

Nota: Ya no existe un nombre de usuario ni contraseña predeterminados. 
Establezca la contraseña en el área de configuración de la seguridad (véase "Editor 
de seguridad" en la página 62).

Fallo de inicio de sesión
Para los usuarios de Active Directory (Directorio activo), si falla el inicio de sesión, 
compruebe que la alarma del sistema de Active Directory (Directorio activo) no esté 
activa y que su nivel de seguridad (véase "Interfaz" en la página 80) es correcto 
para el servidor. En el servidor Active Directory (Directorio activo), compruebe que la 
contraseña no ha expirado y que «Change Password at next login» (Cambiar 
contraseña en el próximo inicio de sesión) no esté habilitada. Normalmente es 
necesario preguntar a los administradores del servidor Active Directory (Directorio 
activo) para realizar estas comprobaciones.

Acceso a la configuración 

Haga clic en el botón «Access» (Acceder) para ingresar al modo de configuración. 
Vuelva a pulsar "Access" para salir del modo de configuración cuando haya 
terminado la sesión.
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Editor gráfico de conexiones 
Al hacer clic en Graphical Wiring Editor (Editor de cableado gráfico) en la barra de 
herramientas, se abre la ventana del editor de cableado gráfico para la configuración 
del dispositivo actual. El botón de la barra de herramientas aparece en el modo solo 
lectura si el usuario conectado no tiene permiso para editar la configuración.

Figura 38 Editor gráfico de conexiones
Graphical Wiring Editor (Editor de cableado gráfico) permite:

1. Arrastrar y soltar bloques de funciones, notas, comentarios, etc. en el diagrama 
de cableado desde el árbol de bloques (panel izquierdo).

2. Conectar los parámetros entre sí haciendo clic en la salida y, a continuación, en 
la entrada deseada (véase la nota siguiente).

3. Ver y modificar los valores de los parámetros haciendo clic con el botón derecho 
del ratón sobre un bloque funcional y seleccionando «Function Block View» 
(Vista del bloque funcional) o haciendo doble clic en el bloque.

4. Seleccionar listas de parámetros y alternar entre los editores de cableado y 
parámetros.

5. Descargar el cableado completo en el dispositivo. Los bloques funcionales y 
objetos de conexión con un contorno de línea discontinua son nuevos o se han 
modificado desde la última descarga.

Nota: Solo es posible asociar un parámetro de entrada de tipo límite de 
compensación automática (por ejemplo, un parámetro de activación de mensaje) a 
cualquier parámetro de salida.
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Barra de herramientas

Descargar cableado al instrumento

Mouse select (Selección de ratón). y modo normal de funcionamiento del 
ratón. Se excluye mutuamente con «Mouse Pan» (Desplazamiento del 

ratón), más información abajo.

Mouse Pan. (ratón panorámico) Cuando está activo, el cursor del ratón es 
un icono en forma de mano que permite arrastrar el diagrama gráfico de 

conexiones dentro de de la ventana del editor.

Ampliar. Permite elegir el factor de aumento del diagrama de cableado

Herramienta panorámica. Al pulsar con el botón izquierdo del ratón, el 
cursor se convierte en un rectángulo que indica la parte del diagrama de 

conexiones que aparece en pantalla. Si se arrastra con el ratón, el rectángulo se 
puede mover libremente por el diagrama. El tamaño del rectángulo depende del 
factor de aumento elegido.

Mostrar/ocultar cuadrícula. Permite ver y ocultar la cuadrícula de alineación.

«Undo» (Deshacer), «redo» (rehacer). Permite al usuario deshacer la 
última acción o, después de deshacer una acción, rehacerla. Los atajos de 

teclado son <Ctrl>+<Z> para deshacer y <Ctrl>+<R> para rehacer.

Cortar, copiar, pegar Funciones de corte (copiar y borrar), copia (sin borrar) 
y pegado (insertar). Las combinaciones de teclas equivalentes son Los 

atajos de teclado son <Ctrl>+<X> para cortar, <Ctrl>+<C> para copiar y <Ctrl>+<V> 
para pegar.

Copiar fragmento de diagrama; Pegar fragmento de diagrama. Permite 
seleccionar una parte del diagrama de conexiones, asignarle un nombre y 

guardarla en un archivo. Luego es posible pegar el fragmento en cualquier diagrama 
de conexiones, incluido el diagrama de origen. 

Crear conjunto; aplanar conjunto. Estos dos iconos permiten crear y 
«aplanar» conjuntos (es decir, volver a integrarlos en el diagrama matriz).

Uso de Graphical Wiring Editor (Editor de cableado gráfico)
Un bloque funcional se activa arrastrándolo al diagrama, conectándolo y 
descargándolo al dispositivo. Los bloques y sus conexiones aparecen inicialmente 
con líneas de puntos; en este estado, la lista de parámetros del bloque está activada 
pero el dispositivo no ejecuta el bloque. El bloque se añade a la lista de ejecución de 
bloques funcionales del dispositivo al pulsar el icono «Download» (Descargar); 
después, los objetos aparecen con líneas continuas.

Si se elimina un bloque ya descargado, aparecerá difuminado en el diagrama hasta 
que se pulse el botón de descarga Esto se debe a que el dispositivo seguirá 
ejecutando el bloque y las conexiones que empiecen o terminen en él. Al realizar la 
descargar, el bloque desaparecerá del diagrama y de la lista de ejecución del 
dispositivo. Es posible deshacer la eliminación de un bloque sombreado, como se 
describe en «Function Block Context Menu» (Menú contextual de bloque funcional) 
en la página 34. Cuando se elimina un bloque sombreado, desaparece 
inmediatamente.
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Selección de componentes
Los cables aparecen con cuadros en los ángulos al seleccionarlos. Al seleccionar 
más de un cable como parte de un grupo, el color de los cables cambia a magenta. 
Todos los demás objetos tienen un contorno de línea cuando se seleccionan.

Haga clic en un objeto para seleccionarlo. Se puede añadir un objeto a la selección 
manteniendo pulsada la tecla Control (Ctrl) mientras hace clic en el objeto Es posible 
deseleccionar un objeto del mismo modo. Si se selecciona un bloque, se 
seleccionan también todos los cables asociados.

Como opción, es posible arrastrar con el ratón sobre el fondo para crear una banda 
alrededor de la zona relevante; cualquier objeto dentro de este área se seleccionará 
al soltar el ratón.

<Ctrl>+<A> selecciona todos los objetos del diagrama activo.

Orden de ejecución en bloque
El orden en que el dispositivo ejecuta los bloques depende de la forma en que estén 
conectados. Cada bloque muestra su lugar en la secuencia con un bloque de color 
en la esquina inferior izquierda (Figura 39).

Bloques de función
Un bloque funcional es un algoritmo que se puede conectar a y desde otros bloques 
funcionales para crear una estrategia de control. Todos los bloques funcionales 
tienen entradas y salidas. Una conexión puede empezar en cualquier parámetro, 
pero sólo puede terminar en parámetros que sean modificables en modo "Operator". 
Un bloque funcional puede incluir todos los parámetros que sean necesarios para 
configurar o aplicar el algoritmo. Las entradas y salidas consideradas más útiles se 
muestran siempre. En la mayor parte de los casos será necesario conectarlas todas 
para que el bloque pueda ejecutar una tarea útil.

Los bloques funcionales que no aparezcan sombreados en el árbol de bloques 
pueden ser arrastrados y colocados en el diagrama. Para desplazar el bloque en el 
diagrama se utiliza el ratón.

Como ejemplo, a continuación se muestra un canal de módulo de E/S. Si la 
información del tipo de bloque se puede modificar, como en este caso, haga clic en 
la flecha hacia abajo para abrir un cuadro de edición que permite modificar el valor.

Figura 39 Ejemplo de bloque funcional

Flecha hacia abajo

Posición en el
orden de ejecución
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Si es necesario conectar desde un parámetro que no se muestre como 
salida recomendada, haga clic en el icono «Clic para seleccionar salida» 
en el ángulo inferior derecho para mostrar un listado completo de los 
parámetros del bloque (Figura 40, abajo). Haga clic en uno de ellos para iniciar la 
conexión.

Menú contextual de bloque funcional
Pulse con el botón derecho del ratón en el bloque funcional para ver el menú 
contextual.

Figura 40 Menú contextual de Function Block View (Vista del bloque funcional)
Function Block View (Vista del bloque funcional)

Muestra una lista de parámetros relacionados con el blo-
que funcional. Es posible mostrar los parámetros ocultos 
deseleccionando «Hide Parameters and Lists when not 
Relevant» (Ocultar los parámetros y listas cuando no sean 
pertinenetes) en el menú de opciones en «Parameter avai-
lability settings» (Ajustes de accesibilidad de los paráme-
tros).
Function Block View  (Vista del bloque funcional) muestra 
los mismos objetos que un Parameter Explorer View (Vista 
de explorador de parámetros), pero está dedicado al blo-
que funcional para el que se abre. Es posible abrir más de 
una vista y pueden traerse al frente haciendo clic en el bo-
tón «Function Block» (Bloque funcional) en la barra de he-
rramientas, que aparece junto al Graphical Wiring 
(Cableado gráfico) en la barra de herramientas «Views» 
(Vista) de iTools.

Re-Route Wires (Reenrutamiento del cableado)    Vuelve a trazar todo el ca-
bleado asociadao con el bloque funcional.

Re-route Input Wires (Reenrutamiento del cableado de entrada)
Vuelve a trazar el cableado de entrada asociado con el 
bloque funcional.

Re-route Output Wires (Reenrutamiento del cableado de salida)
Vuelve a trazar todos los cables de salida relacionados 
con el bloque funcional.

Show Wiring using tags (Mostrar el cableado con etiquetas)
No se dibujan los cables, sino que se indican los puntos de 
inicio y fin mediante etiquetas. Esto permite ver con más 
claridad diagramas en los que el origen y el destino están 
muy separados.
Al pasar el cursor sobre una etiqueta se muestran sus pa-
rámetros de origen y de destino, así como sus valores.
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Figura 41 Ejemplo de cableado con etiquetas
Hide Unwired Connections
Hace que solo se muestren los objetos conectados.

Cut (Cortar)   Permite mover uno o más objetos seleccionados al portapapeles 
para pegarlos en otro diagrama o conjunto. Los objetos 
originales aparecen en gris y los bloques de función y co-
nexiones aparecen con líneas de puntos hasta la siguiente 
descarga, después de la cual desaparecen del diagrama. 
Atajo de teclado = <Ctrl>+<X>. Es posible deshacer las 
operaciones de cortar realizadas desde la última descarga 
utilizando el icono «Undo» (Deshacer) de la barra de he-
rramientas y seleccionado «Undelete» (Deshacer) o utili-
zando el atajo de teclado <Ctrl>+<Z>.

Copy (Copiar)    Permite copiar uno o más objetos seleccionados al portapape-
les para pegarlos en otro diagrama o conjunto, o bien para 
utilizarlos en una ventana de vigilancia o en OPC Scope.
Los objetos originales se mantienen en el diagrama de co-
nexiones. Atajo de teclado = <Ctrl>+<C>. Si los objetos se 
pegan en el mismo diagrama del que fueron copiados, to-
dos los objetos se replicarán con instancias de bloques di-
ferentes. Si esto produce más instancias de un bloque de 
las que haya disponibles, aparece un error que muestra 
los detalles de los objetos que no pudieron copiarse.

Paste (Pegar) Copia objetos del portapapeles al diagrama de cableado 
actual. Atajo de teclado = <Ctrl>+<V>. Si los objetos se 
pegan en el mismo diagrama del que fueron copiados, to-
dos los objetos se replicarán con instancias de bloques di-
ferentes. Si esto produce más instancias de un bloque de 
las que hay disponibles, aparece un mensaje de error con 
información sobre los objetos que no se pudieron copiar.

Figura 42 Error al pegar
Delete (Eliminar) Marca todos los objetos seleccionados para eliminarlos. 

Estos objetos aparecen con líneas de puntos hasta la si-



iTools Versadac

46 HA031352 Edición 3 

guiente descarga, después de la cual desaparecen del 
diagrama. Atajo de teclado = <Eliminar>

Undelete (Deshacer)Deshace las operaciones de «Delete» (Eliminar) y «Cut» 
(Cortar) realizadas en los objetos seleccionados desde la 
última descarga.

Bring to Front (Traer al frente)Trae los objetos seleccionados al frente del dia-
grama.

Push to Back (Enviar al fondo)Envía los objetos seleccionados al fondo del dia-
grama.

Modificar valor de parámetro...
Este menú está activo si se pasa el cursor sobre un pará-
metro modificable. Al seleccionar esta opción del menú, 
aparece la ventana «Parameter Value» (Valor de paráme-
tro) que permite al usuario editar el valor del parámetro (si 
tiene los permisos necesarios).

Figura 43 Editar el PV principal
Parameter Properties

Este menú está activo si se pasa el cursor sobre un pará-
metro modificable. Al seleccionar este objeto del menú, 
aparece la ventana «Parameter Information» (Información 
del parámetro) que permite al usuario ver las propiedades 
del parámetro y la ayuda del parámetro (haciendo clic en 
la pestaña «Help» [Ayuda]).

Figura 44 Propiedades y ayuda del parámetro
Parameter Help (Ayuda del parámetro)    Muestra las propiedades del paráme-

tro y la información de ayuda para el bloque funcional o 
parámetro seleccionado, dependiendo de la posición del 
cursor cuando se pulsa el botón derecho del ratón.
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Wires
Para establecer una conexión:

Figura 45 Lista de parámetros de conexión de salida.
1. Arrastre dos (o más) bloques al diagrama desde el esquema de bloques 

funcionales.

2. Inicie una conexión haciendo clic sobre la salida recomendada o sobre el icono 
«Click to Select output» (Pulse para seleccionar salida) en el ángulo inferior 
derecho del bloque para mostrar las conexiones disponibles, y seleccionado el 
parámetro requerido. Las conexiones recomendadas se muestran con el 
símbolo de un enchufe verde; los otros parámetros disponibles aparecen en 
amarillo. Si pulsa el botón rojo se mostrarán todos los parámetros. Para cerrar la 
lista de conexiones, pulse en el teclado <Esc> o haga clic en la X de la esquina 
inferior izquierda del cuadro de diálogo.

3. Después de iniciar la conexión, aparece una línea punteada desde la salida 
hasta la posición actual del ratón. Haga clic en el parámetro de destino 
apropiado para completar la conexión.

4. Las conexiones permanecen punteadas hasta que se descargan.

Trazado de conexiones
El sistema traza automáticamente las conexiones creadas usando un algoritmo que 
busca un camino libre entre los dos bloques. Es posible volver a trazar 
automáticamente una conexión utilizando los menús contextuales o haciendo doble 
clic en ella. También se puede modificar manualmente un segmento de conexión 
arrastrándolo con el ratón. Si se mueve el bloque al que está conectado, el extremo 
de la conexión se mueve con él y conserva su trayectoria en la medida que sea 
posible.

Si se selecciona una conexión haciendo clic en ella, aparece con pequeñas cajas en 
sus esquinas.

Menú contextual de conexión
Pulse en una conexión con el botón derecho del ratón para acceder al menú 
contextual:
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Force Exec Break (Forzar detención) Cuando las conexio-
nes forman un lazo, debe introducirse 
un punto de interrupción, donde el valor 
escrito en el bloque procede de la última 
fuente ejecutada en el ciclo anterior.
iTools coloca automáticamente una in-
terrupción, que aparece en rojo. Force 
Exec Break permite al usuario definir 
dónde debe colocarse la interrupción. 
Las interrupciones redundantes apare-
cen en negro.

Re-Route wire (Redirigir conexión)Sustituye la trayectoria ac-
tual de la conexión por una nueva ruta 
generada desde cero.

Use Tags (Utilizar etiquetas) Alterna entre el modo de cone-
xiones y etiquetas entre los parámetros. 
El modo de etiquetas es útil cuando las fuentes y los des-
tinos están muy separados.

Find Start (Buscar inicio)Va hasta el origen de la conexión.
Find End (Buscar fin)Va hasta el destino de la conexión.
Cut (Cortar), Copy (Copiar), Paste (Pegar) No se utilizan en este contexto.
Delete (Eliminar) Marca la conexión para eliminarla. La conexión se mues-

tra con una línea de puntos (o con etiquetas discontinuas) 
hasta la siguiente descarga.
Es posible deshacer la operación hasta después de la si-
guiente descarga.

Undelete (Deshacer)Deshace los efectos de la operación de eliminar hasta la 
siguiente descarga, después de la cual se desactivará.

Bring to Front (Traer al frente)Trae la conexión seleccionada al frente del dia-
grama.

Push to Back (Enviar al fondo)Envía la conexión seleccionada al fondo del dia-
grama.

Colores del cableado
Black (Negro)    Conexión con funcionamiento normal.
Red (Rojo)   El cable se conecta a un parámetro no modificable.

El bloque de destino rechaza los valores.
Magenta El cable tiene el color magenta si no está conectado a un 

bloque seleccionado o si se pasa el cursor del ratón sobre 
el mismo.

Purple (Púrpura) El cable se vuelve de color púrpura al pasar el cursor del 
ratón por encima.

Green (Verde) Cable nuevo (la línea verde discontinua se convierte en 
una línea negra continua después de la descarga).

Consulte "Código de color de los elementos" en la página 50.

Comentarios
Los comentarios se añaden a un diagrama de conexiones arrastrándolos desde el 
árbol de bloques funcionales hasta el diagrama. En cuanto se suelta el ratón, se abre 
un cuadro de entrada de texto que permite introducir el texto del comentario.

Como el texto del comentario no se ajusta, las nuevas líneas deben crearse 
manualmente mediante retornos de carro. Una vez completo el texto, Aceptar hace 
que el comentario aparezca en el diagrama. No hay límites para el tamaño de un 
comentario.

Figura 46  
Menú contex-
tual de cone-
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Los comentarios se guardan en el dispositivo junto a la información de diseño del 
diagrama.

Para vincular un comentario a un bloque funcional o una conexión, pulse en el icono 
de la cadena en la esquina inferior derecha del cuadro del comentario y haga clic en 
el bloque o la conexión que desee. Se trazará una línea de puntos hasta la parte 
superior del bloque o segmento de conexión seleccionado (Figura 48).

Nota: El icono de la cadena desaparece después de vincular el comentario y 
vuelve a aparecer cuando se pasa el cursor del ratón sobre la esquina inferior 
derecha del cuadro del comentario.

Comentario Menú contextual
Edit (Editar) Abre el cuadro de entrada de texto del comentario para 

modificar el texto del comentario.
Unlink (Desconectar)Elimina el vínculo actual del comenta-

rio.
Cut (Cortar) Mueve el comentario al portapapeles, 

listo para pegarlo en otro lugar. Atajo 
de teclado = <Ctrl>+<X>.

Copy (Copiar) Copia el comentario del diagrama de 
cableado al portapapeles, listo para 
pegarlo en otro lugar. Atajo de teclado 
= <Ctrl>+<C>.

Paste Copia un comentario del portapapeles 
al diagrama de cableado.
Atajo de teclado = <Ctrl>+<V>.

Delete (Eliminar) Marca el comentario para eliminarlo en la próxima descar-
ga.

Undelete (Deshacer)Deshace la orden de eliminar si aún no se ha llevado a 
cabo la descarga.

Monitores
Los puntos de monitorización se añaden a un diagrama de conexiones haciendo clic 
y arrastrándolos desde el árbol de bloques de funciones hasta el diagrama. Un 
monitor muestra el valor (actualizado a la velocidad configurada en la lista de 
parámetros de iTools) del parámetro al que está vinculado. De manera 
predeterminada se muestra el nombre del parámetro. Para ocultar el nombre del 
parámetro, haga doble clic en el cuadro del monitor o utilice la opción Show Names 
en el menú contextual (clic derecho) para ocultar o mostrar el nombre del parámetro.

Para vincular un monitor a un bloque de función o un cable, haga clic en el icono de 
la cadena en la esquina inferior derecha del cuadro del monitor y después haga clic 
otra vez en el parámetro que desee. Se trazará una línea de puntos hasta la parte 
superior del bloque o segmento de conexión seleccionado.

Nota: El icono de la cadena desaparece después de vincular el monitor y vuelve a 
aparecer cuando se pasa el cursor del ratón sobre la esquina inferior derecha del 
cuadro del monitor.

Figura 47 Menú 
contextual de co-

mentario
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Figura 48 Comentarios y el aspecto del monitor

Menú contextual de monitor
Show names (Mostrar nombres)Muestra u oculta los 

nombres de parámetros en el cua-
dro de monitor.

Unlink (Desconectar)Elimina el vínculo actual del comen-
tario.

Cut (Cortar)   Mueve el monitor al portapapeles para pe-
garlo en otro lugar. Atajo de teclado 
= <Ctrl>+<X>.

Copy (Copiar) Copia el monitor del diagrama de 
cableado al portapapeles, listo para 
copiarlo en otro lugar. Atajo de tecla-
do = <Ctrl>+<C>.

Paste (Pegar) Copia un monitor del portapapeles 
al diagrama de cableado. Atajo de teclado = <Ctrl>+<V>.

Delete (Eliminar) Marca el comentario para eliminarlo en la próxima descar-
ga.

Undelete (Deshacer)Deshace la orden de eliminar si aún no se ha llevado a 
cabo la descarga.

Bring to Front (Traer al frente)Mueve el objeto a la capa superior del diagrama.
Push to Back (Enviar al fondo)Mueve el objeto a la capa inferior del diagrama.
Parameter Help (Ayuda de parámetro)Muestra la ayuda de parámetro para el 

objeto.

Descarga 
Cuando se abre el editor de conexiones, el sistema lee el diagrama de conexiones 
del dispositivo. No se realizan cambios en la ejecución o conexión de bloques 
funcionales del dispositivo hasta que se pulsa el botón de descarga. Cuando se 
coloca un bloque en el diagrama, los parámetros del dispositivo cambian para que se 
puedan ver los parámetros de ese bloque. Si se realizan cambios y se cierra el editor 
sin guardarlos, se produce un retardo mientras el editor elimina estos parámetros.

Durante la descarga se copia el diagrama de conexiones en el dispositivo, que luego 
calcula el orden de ejecución y comienza a ejecutar los bloques. El diagrama 
(incluidos comentarios y monitores) se copia a la memoria Flash del dispositivo junto 
con la configuración del editor. Al volver a abrir el editor, el diagrama aparece en la 
misma posición que tenía cuando se descargó por última vez.

Código de color de los elementos
Los objetos del diagrama se muestran con los siguientes colores (véase también 
"Colores del cableado" en la página 48):

Red (Rojo) Los objetos que ocultan total o parcialmente otros objetos 
y los objetos ocultos total o parcialmente por otros objetos.

Menú contextual 
de monitor
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Conexiones que empiezan o terminan en parámetros no 
modificables o no disponibles. Interrupciones de ejecu-
ción.

Blue (Azul) Parámetros no disponibles en bloques funcionales.
Green (Verde) Los objetos añadidos al diagrama desde la última descar-

ga se muestran como líneas verdes discontinuas.
Magenta Todos los objetos seleccionados o cualquier objeto sobre 

el que se coloque el cursor.
Purple (Púrpura) Los cables se vuelven de color púrpura al pasar el cursor 

del ratón por encima.
Black (Negro) Todos los objetos añadidos al diagrama antes de la última 

descarga.
Interrupciones de ejecución redundantes. Texto de co-
mentarios y monitores.

Menú contextual de diagrama
Cut (Cortar) Solo está activo cuando se hace 

clic con el botón derecho del ratón 
en el rectángulo que aparece al se-
leccionar más de un objeto. Mueve 
la selección del diagrama al porta-
papeles. Atajo de teclado = 
<Ctrl>+<X>.

Copy (Copiar) Como para «Cut» (Cortar), pero la 
selección se copia y el original per-
manece en el diagrama. Atajo de 
teclado = <Ctrl>+<C>.

Paste (Pegar) Copia el contenido del portapape-
les en el diagrama. Atajo de tecla-
do = <Ctrl>+<V>.

Re-Route Wires (Enrutamiento de los cables)Vuelve a 
enrutar todos los cables seleccio-
nados. Si no se selecciona ninguna 
conexión, se vuelven a trazar todas 
las conexiones.

Align Tops (Alinear parte superior)Alinea el extremo superior de todos los blo-
ques del área seleccionada.

Align Lefts (Alinear extremo izquierdo)   Alinea el borde izquierdo de todos los 
bloques en el área seleccionada.

Space Evenly (Distribución uniforme)Coloca los objetos seleccionados de for-
ma que sus ángulos superiores izquierdos estén distribui-
dos uniformemente en el diagrama. Haga clic en el objeto 
que vaya a estar más a la izquierda y, después, seleccione 
los demás objetos con <Ctrl>+<clic izquierdo> en el orden 
en el que vayan a aparecer.

Delete (Eliminar) Marca el objeto para eliminarlo en la próxima descarga.
La operación puede deshacerse hasta la siguiente descar-
ga.

Undelete (Deshacer)Deshace la operación de «Delente» (Eliminar) el objeto 
seleccionado.

Select All (Seleccionar todo)Selecciona todos los objetos del diagrama actual.
Create Compound (Crear conjunto)Solo está activo cuando se hace clic con el 

botón derecho del ratón, en el diagrama superior, dentro 
del rectángulo que aparece al seleccionar más de un ob-
jeto. Crea un nuevo diagrama de conexiones, como se ex-
plicará en "Conjuntos" en la página 52.

Rename (Cambiar nombre)Permite introducir un nuevo nombre para el diagra-
ma de cableado actual. Este nombre aparece en la ficha 
correspondiente.

Menú contextual de 
diagrama
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Copy Graphic (Copiar gráfico)Copia los objetos seleccionados (o todo el dia-
grama si no se selecciona ningún objeto) en el portapape-
les como metaarchivo de Windows, que puede pegarse en 
una aplicación de documentación.
Las conexiones que entran o salen de la selección (en su 
caso) se muestran en modo de etiquetas.

Guardar gráfico... Igual que para Copiar gráfico, pero se guarda en el archivo 
indicado por el usuario en lugar de al portapapeles.

Copiar fragmento al archivo...
Copia los objetos seleccionados en un archivo indicado 
por el usuario en la carpeta My iTools Wiring Fragments, 
situada en My Documents.

Paste Fragment From File...
Permite al usuario seleccionar un fragmento almacenado 
para incluirlo en el diagrama de conexiones.

Centre (Centrar) Coloca la ventana de visualización en el centro de los ob-
jetos seleccionados. Si se ha pulsado previamente en Se-
leccionar todo, la ventana de visualización se sitúa sobre 
el centro del diagrama.

Conjuntos
Se utilizan conjuntos para simplificar el diagrama de cableado de nivel superior, al 
permitir colocar cualquier número de bloques funcionales en una caja, cuyas 
entradas y salidas funcionan del mismo modo que las de un bloque funcional normal.

Cada vez que se crea un conjunto, aparece una nueva ficha en la parte superior del 
diagrama de conexiones. En principio, los conjuntos y sus fichas se llaman Conjunto 
1, Conjunto 2, etc. pero puede cambiar este nombre haciendo clic sobre el conjunto 
con el botón derecho del ratón en el diagrama de nivel superior o en cualquier punto 
de un conjunto abierto; después, seleccione Renombrar y escriba la cadena de texto 
deseada (máx. 16 caracteres).

Los conjuntos no pueden contener otros conjuntos (es decir, sólo se pueden crear en 
el diagrama de alto nivel).

Para crear un conjunto:

1. Los conjuntos vacíos se crean en el diagrama de nivel superior al hacer clic en el 
icono «Create Compound» (Crear conjunto) en la barra de herramientas.

2. También se pueden crear conjuntos seleccionando 
uno o más bloques funcionales en el diagrama de 
alto nivel superior y pulsando en el icono «Create 
Compound» (Crear conjunto) de la barra de 
herramientas. Los objetos seleccionados pasarán del 
diagrama de alto nivel a un nuevo conjunto.

3. Los conjuntos se eliminan (aplanan) seleccionando el objeto correspondiente en 
el menú del nivel superior y, a continuación, haciendo clic en el icono «Flatten 
Compound» (Aplanar conjunto) en la barra de herramientas. Todos los objetos 
incluidos en el conjunto volverán a aparecer en el diagrama de alto nivel.

4. El cableado entre el nivel superior y los parámetros del conjunto se realiza 
haciendo clic en el parámetro origen y, después, seleccionado el conjunto (o la 
ficha del conjunto) antes de pulsar en el parámetro destino. Las conexiones 
entre parámetros de conjunto y de alto nivel o entre dos conjuntos se realizan de 
forma similar.

Crear 
conjunto

Eliminar 
conjunto
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5. Los bloques de función sin utilizar pueden moverse a los conjuntos 
arrastrándolos desde el esquema en árbol. Los bloques ya existentes se pueden 
arrastrar desde el diagrama de alto nivel o desde otro conjunto hasta la ficha del 
conjunto de destino. Los bloques se mueven desde conjuntos al diagrama de 
alto nivel o a otro conjunto de forma similar. También es posible copiar y pegar 
los bloques funcionales.

6. Los nombres por defecto de los conjuntos (por ejemplo, Conjunto 2) solo se 
utilizan una vez, de modo que, por ejemplo, si se han creado los Conjunto 1 y 2, 
y después se elimina el Conjunto 2, el siguiente conjunto se llamará Conjunto 3.

7. Es posible arrastrar los elementos del nivel superior hasta los conjuntos.

Sugerencias
Al colocar el cursor sobre el bloque, aparecen «pistas» que describen la parte del 
bloque que se encuentra bajo el cursor. En el caso de parámetros de bloques 
funcionales, la información contextual incluye la descripción del parámetro, su 
nombre OPC y (si se ha descargado) su valor. Se muestra información similar al 
pasar el cursor del ratón sobre entradas, salidas y muchos otros objetos en la 
pantalla de iTools.
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Explorador de parámetros 
Puede acceder a esta vista de las siguientes maneras:

1. al hacer clic en el icono Explorador de parámetros en la barra de herramientas

2. al hacer doble clic en el bloque correspondiente del esquema en árbol o en el 
editor de cableado gráfico.

3. al seleccionar «Parameter Explorer» (Explorador de parámetros) en el menú 
«View» (Vista).

4. al utilizar el atajo de teclado <Alt>+<Intro>

En cada caso, los parámetros del bloque funcional aparecen en la ventana de iTools 
en forma de tabla, como en el ejemplo de Figura 49.

Figura 49 Ejemplo de tabla de parámetros
Figura 49 Muestra el diseño de tabla predeterminado. Es posible añadir o eliminar 
columnas de la vista mediante el objeto Columnas del explorador o los menús 
contextuales (Figura 50).

Nota: El menú «Explorer» (Explorar) aparece en la vista «Parameter Explorer» 
(Explorador de parámetros). Se sustituye por el menú «Wiring» (Cableado) si el 
«Graphical Wiring Editor» (Editor de cableado gráfico) es la vista activa.

Figura 50 Activar o desactivar columnas

Desde el menú «Explorer» (Explorar)

Desde el menú contextual
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Detalles del explorador de parámetros
Figura 51 muestra un ejemplo de tabla de parámetros. Este elemento de 
configuración en concreto tiene una serie de subcarpetas asociadas, cada una de 
las cuales se representa mediante una pestaña en la parte superior de la tabla.

Figura 51 Ejemplo de tabla de parámetros
Notas:
1. Los parámetros azules no son editables (solo lectura). Los parámetros de 

lectura/grabación son negros y tienen el símbolo de un lápiz en la columna de 
acceso «Read/Write» (Lectura/escritura) en el extremo izquierdo de la tabla. El 
estado de «Read/Write» (Lectura/escritura) para muchos parámetros depende 
del nivel de acceso del usuario conectado y de si el dispositivo está o no en el 
modo de configuración.

2. Columnas. La ventana del explorador por defecto (Figura 49) contiene las 
columnas «Name» (Nombre), «Description» (Descripción), «Address» 
(Dirección) y «Value» (Valor). Como puede verse en la Figura 50, es posible 
seleccionar las columnas que desea mostrar hasta cierto punto mediante el 
menú del explorador o el menú contextual. Se han activado los límites para el 
ejemplo anterior.

3. Parámetros ocultos. de manera predeterminada, iTools oculta los parámetros 
que se consideran irrelevantes según el contexto. Estos parámetros ocultos 
pueden mostrarse en la tabla utilizando el elemento de configuración 
Disponibilidad de parámetros en el menú de opciones (Figura 52). Estos 
parámetros se muestran con el fondo sombreado.

4. Se muestra el nombre de ruta completo para la lista de parámetros que aparece 
en la esquina inferior izquierda de la ventana, junto con el número total de 
parámetros y el número de parámetros ocultos (en su caso).

Figura 52 Mostrar/ocultar parámetros
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Herramientas de explorador
Sobre la lista de parámetros aparece una serie de botones de la barra de 
herramientas:

Retroceder a: y Avanzar a:. El «Parameter Explorer» (Explorador de 
parámetros) contiene un búfer histórico de hasta 10 listas que se han 
explorado previamente desde que se abrió la ventana. Los iconos Volver a: 
(nombre de lista) y Avanzar a: (nombre de lista) permiten retroceder y 
avanzar en la secuencia de la lista de parámetros.

Si se coloca el cursor del ratón sobre el icono de la herramienta, se muestra 
el nombre de la lista de parámetros que aparece si se hace clic en el icono. Al hacer 
clic en la flecha se muestra una lista de las 10 últimas listas visitadas, que el usuario 
puede seleccionar. Atajo de teclado = <Ctrl>+<B> para «Back to» (Retroceder a) y 
<Ctrl>+<F> para «Forward to» (Avanzar a).

Subir un nivel, bajar un nivel. Para las listas de parámetros anidados, estos 
botones permiten al usuario recorrer los niveles en vertical. Atajos de teclado 
= <Ctrl>+<U> para «Go Up a Level» (Subir un nivel) y <Ctrl>+<D> para «Go 
Down a Level» (Bajar un nivel).

Chincheta para dar alcance global a la ventana. Al hacer clic en este icono, 
se muestra permanentemente la lista de parámetros actual, incluso aunque 
otro instrumento sea el dispositivo actual.

Menú contextual

Copy Parameter (Copiar parámetro)    Copia el parámetro seleccionado al por-
tapapeles. 

Propiedades de parámetro
Muestra las propiedades del parámetro seleccionado.

Ayuda de parámetro...Muestra información de ayuda para el parámetro selec-
cionado.

Columns (Columnas)Permite al usuario activar/desactivar una serie de colum-
nas de la tabla de parámetros.
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Editor de vigilancia/recetas 
El editor «Watch/Recipe» (Vigilancia/receta) se abre haciendo clic en el icono 
«Watch/Recipe» (Vigilancia/receta), seleccionando «Watch/Recipe» 
(Vigilancia/receta) en el menú «Views» (Vista) o utilizando el atajo de teclado 
<Ctrl>+<A>. La ventana presenta dos partes: la parte izquierda contiene la lista de 
vigilancia, mientras que la derecha incluye uno o más grupos de datos inicialmente 
vacíos y sin nombre.

La ventana de vigilancia/recetas se utiliza para:

1. Para supervisar una lista de parámetros. Esta lista puede incluir parámetros de 
muchas listas de parámetros distintas y sin ninguna relación en el mismo 
dispositivo. No puede contener parámetros de dispositivos diferentes.

2. Para crear juegos de datos de valores de parámetros que puedan seleccionarse 
y descargarse en el dispositivo en la secuencia definida en la receta. Es posible 
utilizar el mismo parámetro más de una vez en la misma receta.

Figura 53 Ventana del editor de vigilancia/recetas (con menú contextual)

Crear una lista de vigilancia
Una vez abierta la ventana, puede añadir parámetros como se explica a 
continuación. Los valores de los parámetros se actualizan en tiempo real, lo que 
permite al usuario supervisar simultáneamente una serie de valores.

Añadir parámetros a la lista de vigilancia
1. Es posible arrastrar parámetros a la lista de vigilancia desde otra área de la 

ventana de iTools (por ejemplo, desde la ventana de «Parameter Explorer» 
(Explorador de parámetros), el «Graphical Wiring Editor» (Editor gráfico de 
cableado) o el esquema en árbol). El parámetro ocupará una fila vacía al final de 
la lista o, si se suelta sobre un parámetro ya existente, se insertará encima de 
dicho parámetro y los parámetros restantes bajarán una posición.

2. Es posible arrastrar los parámetros desde una posición de la lista hasta otra. En 
este caso, se crea una copia del parámetro y el parámetros de origen 
permanece en su posición original.

3. Es posible copiar parámetros (<Ctrl>+<C>) y pegarlos con (<Ctrl>+<V>) tanto 
dentro de la lista como desde una fuente externa, como la ventana del 
navegador de parámetros o el editor de cableado gráfico.

4. Para abrir una ventana del navegador en la cual se selecciona un parámetro 
para insertarlo sobre el parámetro seleccionado actualmente, puede utilizarse el 
botón «Insert item...» (Insertar objeto) en el menú «Recipe» (Receta) de iTools, 
en el menú contextual o mediante el atajo de teclado <Insert>.
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Creación de grupos de datos
Después de añadir a la lista todos los parámetros necesarios, seleccione el juego de 
datos vacío haciendo clic en la cabecera de la columna. Asigne los valores de los 
datos del grupo usando uno de los siguientes métodos:

1. Haciendo clic en el icono «Capture current values into a data set» 
(Guardar valores actuales en un conjunto de datos) (también conocido 
como la herramienta «Snapshot Values» [Instantánea de valores]) de la barra de 
herramientas.

2. Seleccionando Instantánea de valores en el menú contextual (clic derecho) o la 
receta.

3. Mediante el atajo de teclado <Ctrl>+<A>.

Es posible modificar el valor de cada uno de los valores de los datos directamente en 
las celdas. Los valores también se pueden borrar o dejar en blanco, en cuyo caso no 
la descarga no incluirá los valores de esos parámetros. Los valores de los datos se 
eliminan al borrar todos los caracteres de la celda y después pasando a otra celda o 
pulsando <Intro>.

El conjunto se llama «Set 1» «Conjunto 1» por defecto, pero puede cambiarse este 
nombre utilizando la opción «Rename Data Set» (Cambiar nombre del conjunto de 
datos) en los menús contextual o «Recipe»  (Receta), o bien utilizando el atajo de 
teclado <Ctrl>+<R>.

Puede añadir nuevos grupos de datos vacíos de una de las siguientes formas:

1. Haciendo clic en el icono de la barra de herramientas Crear nuevo juego de 
datos vacío.

2. Seleccionando «New Data Set» (Nuevo conjunto de datos) en los menús 
contextual o «Recipe»  (Receta).

3. Mediante el atajo de teclado <Ctrl>+<W>.

Los grupos de datos creados se pueden modificar como se explicó anteriormente.

Por último, después de crear, modificar y guardar todos los juegos de datos 
necesarios, pueden descargarse al dispositivo de uno en uno mediante la 
herramienta «Download» (Descargar), el objeto «Download Values» (Descargar 
valores) en los menús contextual o «Recipe» (Receta), o utilizando el atajo de 
teclado <Ctrl>+<D>.

Iconos de la barra de herramientas Vigilancia Receta

Crear nueva lista de vigilancia/receta. Crea una nueva lista, eliminando todos 
los parámetros y grupos de datos de la ventana abierta. Se pide confirmación 
si no se ha guardado la lista. Atajo de teclado = <Ctrl>+<N>.

Abrir archivo existente de vigilancia/receta. Se pide confirmación si no se ha 
guardado la lista o el grupo de datos. Se abre un cuadro de selección de 
archivo que permite al usuario seleccionar el archivo que desea abrir. Atajo de 

teclado = <Ctrl>+<O>.

Guardar lista actual de vigilancia/receta. Permite guardar el grupo de datos en 
la carpeta indicada por el usuario. Atajo de teclado = <Ctrl>+<S>.
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Descargar el juego de datos seleccionado en el dispositivo. Atajo de teclado = 
<Ctrl>+<D>.

Insertar objeto delante del objeto seleccionado. Atajo de teclado = <Insertar>

Eliminar parámetro de receta. Atajo de teclado = <Ctrl>+<Eliminar>.

Mover objeto seleccionado. La flecha hacia arriba desplaza el parámetro 
seleccionado hacia arriba en la lista, mientras que la flecha hacia abajo lo 

desplaza hacia abajo en la lista.

Crear grupo de datos vacío. Atajo de teclado = <Ctrl>+<W>.

Eliminar un juego de datos vacío. Atajo de teclado = <Ctrl>+<Eliminar>.

Capturar los valores actuales en un grupo de datos. Asigna valores al grupo 
de datos seleccionado. Atajo de teclado = <Ctrl>+<A>.

Borrar grupo de datos seleccionado. Borra los valores del conjunto de datos 
seleccionado. Atajo de teclado = <Shift>+<Eliminar>

Abrir OPC Scope. Abre una utilidad que permite analizar tendencias, registrar 
datos y realizar intercambio dinámico de datos (DDE). OPC Scope es un 
explorador OPC que se puede conectar a cualquier servidor OPC incluido en 
el registro de Windows.

OPC es el acrónimo de «OLE for Process Control» (OLE para control de procesos), 
donde OLE significa «Object Linking and Embedding» (Enlace e incrustación de 
datos).

Menú contextual de vigilancia/receta
Las opciones del menú contextual del editor de vigilancia/recetas tienen las mismas 
funciones que los iconos de la barra de herramientas descritos anteriormente.
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Configuración de lote 
Los registros de lotes forman parte del histórico de registro y se incluyen en el 
proceso normal de archivado. Los lotes pueden ser iniciados directamente por el 
operador (si tiene permiso de acceso) o automáticamente cuando cambie un valor 
PV específico, por el trabajo o a distancia mediante el MODBUS/TCP.

El modo de operación de lotes puede configurarse como arranque/detención, 
continuo o ciclo de esterilizador y puede incluir todos los canales o solo aquellos 
asociados con un grupo específico. Para lotes de arranque y detención, el registro 
del lote comienza cuando se inicia el lote y continúa hasta que se detiene. Para lotes 
continuos, el registro del lote comienza cuando se inicia el lote y continúa hasta que 
comienza el siguiente o hasta que se desactiva el registro.

Nota: Consulte "Configuración de grupo" en la página 88 para más información 
sobre la configuración de lote, «Group configuration» (Configuración de grupo) en la 
página 74 y «Sterilizer Block Option» (Opción de esterilizador del bloque ) en la 
página 119 para la congifuración de «Sterilizer» (Esterilizador).

Cuando se usa el software «PC Review» (Revisión de PC) (en la página 56), puede 
usarse la función «Go to Batch» (Ir al lote) para seleccionar un registro de lote 
específico.

Si está habilitado «Name files by Batch» (Nombrar archivos por lotes) (véase «Batch 
Configuration» [Configuración de lote] en la página 49), se crea un archivo histórico 
separado para cada lote.

En cada inicio de lote, se genera un mensaje de inicio:

DD/MM/YY (DD/MM/AA) HH:MM:SS Inicio de lote (Nombre completo de 
usuario)

Donde DD/MM/YY (DD/MM/AA) es la fecha, HH:MM:SS es la hora, y User Full name 
es el nombre completo del usuario actual, el nivel de seguridad (por ejemplo, 
Engineer [Ingeniero]) o «PV» si el lote se ha iniciado mediante «Use PV start» (Usar 
inicio de PV). Se imprime un mensaje similar al detener el lote. No hay mensajes de 
detención asociados con la selección de lote continuo.

Además de los mensajes de arranque y detención anteriores, pueden incluirse hasta 
diez valores de campo de datos con nombre, en caso necesario, en el archivo 
histórico al inicio de un lote o al final de un lote. El número de campos puede 
ajustarse usando la lista desplegable «Batch Fields» (Campos del lote). Los 
nombres de cada campo pueden personalizarse usando este editor y los propios 
valores de datos se introducen en la página «Batch Configuration» (Configuración de 
lote) que se describe en la página 49. El primer campo suele ser un número de lote 
introducido manualmente o un valor generado automáticamente.
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Figura 54 Editor de control de lotes
Batch Scope (Alcance del lote)0 = Instrumento; 1 = Grupo
Enable Batch (Habilitar lote)Al hacer clic en esta casilla se habilita el control de 

lote
Batch Mode (Modo de lote)0 = Continuo; 1 = Arranque/detención; 2 = Ciclo de 

esterilizador
Batch Fields (Campos de lote)Especifica el número de líneas de texto disponi-

bles.
Field 1 Value (Valor del campo 1)El campo 1 usará el texto del campo 1, intro-

ducido a continuación, o el valor del PV de activación.
Field 1 to 10 (Campo 1 a 10)Introduzca aquí las líneas de texto necesarias.
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Editor de seguridad 
Este editor permite establecer contraseñas para los usuarios generales (como 
«Engineer» [Ingeniero]), añadir usuarios específicos, conceder permisos de acceso 
y definir estrategias de ingreso/autorización. Además, puede habilitarse la seguridad 
de usuario y contraseña para que, por ejemplo, se pueda definir la caducidad de una 
contraseña en un período configurable.

Antes de poder acceder a las funciones de seguridad, el usuario debe iniciar sesión 
y definir el nivel de acceso en «Configuration» (Configuración) como se describe en 
"Inicio de sesión" en la página 39. No hacerlo motiva que aparezca el mensaje de 
error correspondiente (véase a continuación).

Nota: Nota: Si está habilitado el gestor de seguridad (véase Instrument.Info), el 
botón de seguridad solo permite que el usuario cambie la contraseña.

Figura 55 Mensajes de error

Pantalla de inicio

Figura 56 Pantalla inicial de seguridad
Una vez conectado y con el modo de configuración ajustado en «Configuration» 
(Configuración), al hacer clic en el botón «Security» (Seguridad) aparece la pantalla 
inicial de seguridad. Como podemos ver en Figura 56, hay tres botones en la barra 
de herramientas (Download [Descargar], Add User [Añadir usuario] y Edit User Login 
[Editar usuarios]), dos pestañas (User Profiles [Perfiles de usuario] y Security 
Management [Gestión de la seguridad]) y numerosas selecciones habilitadas.

Si la opción 21cfr11 no está habilitada, aparecerá también el botón «Remove User» 
(Eliminar usuario) en la barra de herramientas.
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Nota: «Admin.local» (Administrador local) es un usuario especial que nunca utiliza 
un directorio activo. Este usuario está deshabilitado por defecto, pero el usuario 
«Engineer» (Ingeniero) puede habilitarlo, si se necesita. El usuario «Engineer» 
(Ingeniero) puede eliminarse, deshabilitarse y ajustarse con contraseñas que 
caduquen en «Added users» (Usuarios añadidos), como se describe a continuación.

Pestaña de perfiles de usuario
La pantalla inicial (Figura 56) permite al usuario conectado editar los permisos de 
usuario habilitados (marcas verdes de confirmación) para cada ID de usuario. Los 
permisos «sombreados» no pueden ser editados por el usuario conectado en ese 
momento.

El significado de la mayoría de los permisos es claro, pero lo siguiente puede ser útil:
Signing User (Usuario con permiso) Permite a este usuario firmar cambios de 

la configuración (véase "Pestaña de gestión de la seguri-
dad" en la página 66).

Authorising User (Usuario autorizado)Permite a este usuario autorizar cambios 
de la configuración (véase "Pestaña de gestión de la se-
guridad" en la página 66).

Force Password Change (Forzar el cambio de contraseña)
Obliga al usuario a cambiar de contraseña en el primer ini-
cio de sesión.

Habilitado (Nombre de usuario)
Esta casilla permite habilitar y deshabilitar usuarios específicos.

Cuenta del servidor web
Debe seleccionarse para cualquier usuario que vaya a acceder al dispositivo a 
través del servidor web. No es posible habilitar la cuenta del servidor web para los 
usuarios predeterminados (como Supervisor, Operator [Operador] o Logged out 
[Desconectado]).

Consulte "Servidor web" para más detalles sobre el servidor web.

Botón de descarga 
Este botón, que al principio está sombreado, se activa cuando se realiza algún 
cambio en los ajustes de seguridad. Para que los cambios se vuelvan permanentes, 
debe hacer clic en «Download» (Descargar) antes de salir de la configuración de 
seguridad. Aparece un mensaje de advertencia si se intenta salir de la configuración 
de seguridad sin haber hecho antes clic en «Download» (Descargar).

Agregar usuario
Al hacer clic en este botón aparece la pantalla de añadir nuevo usuario, como se 
muestra abajo en Figura 57.
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Figura 57 Pantallas de «Add New User/ FTP» (Añadir nuevo usuario/acceso FTP)
User ID (ID de usuario)El número de este usuario, que se incrementa automá-

ticamente y no es editable.
User Name (Nombre de usuario)Introduzca un nombre de usuario en este cam-

po anteriormente vacío. El nombre de usuario distingue 
mayúsculas y minúsculas.

Domain Name (Nombre de dominio)Aparece solo si el dominio se define con el 
gestor de seguridad y, después, este se desactiva.
De esta manera, el usuario pueda reconfigurarse como un 
usuario no perteneciente al dominio. Si se introduce aquí 
un nombre de dominio, se sombrean los campos de 
«Password» (Contraseña) en iTools en el manual de 
usuario de verdasac y «Confirm Password» (Confirmar 
contraseña) (se vuelven no editables, como se muestra a 
continuación).

Password (Contraseña)Introduzca una contraseña (distingue entre mayúsculas 
y minúsculas). La contraseña debe tener un número de 
caracteres mínimo, que se especifica en «Security Mana-
gement» (Gestión de seguridad), como se describe a con-
tinuación. Sombreado si se introduce un nombre de 
dominio.

Confirm Password (Confirmar contraseña)Vuelva a intro-
ducir la contraseña para asegurarse 
de no haber cometido errores. Si el 
campo «Confirm Password» (Confir-
mar contraseña) no coincide con 
«Password» (Contraseña)  aparece 
un mensaje de error. Sombreado si se introduce un nom-
bre de dominio.

FTP Access (Acceso FTP)El acceso FTP permite configurar un usuario para 
acceder al dispositivo a través de FTP con el dispositivo 
actuando como un servidor FTP, por ejemplo «Review - 
Instrument File Services» (Revisar - Servicios de archivo 
de dispositivo).

Cuando finalice la configuración del nuevo usuario, haga clic en el botón 
«Download» (Descargar) para confirmar los cambios.

Botón de edición de la pantalla de ingreso de usuario 

Al hacer clic en este botón, el usuario puede editar los detalles de conexión del 
usuario seleccionado o del usuario remoto.
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Cuando finalice la edición, haga clic en el botón «Download» (Descargar) para 
confirmar los cambios.
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Pestaña de gestión de la seguridad

Figura 58 Ventana de «Security Management» (Gestión de seguridad)
Esta página permite configurar una serie de parámetros de gestión de la seguridad.

Record Logins (Registros de acceso)Cuando está habilitado, se registran todos 
los inicios de sesión en el archivo histórico con la fecha, 
hora y usuario.

Enable Audit Trail (Habilitar Audit Trail)Registra todos los cambios de la confi-
guración.

Require Signing (Solicitar firma)Si está habilitado, un usuario con el permiso 
«Signing User» (Usuario con el permiso) habilitado debe 
confirmar cualquier cambio en la configuración.

Require Authorisation (Solicitar autorización)
Si está habilitado, un usuario con el permiso «Authorising 
User» (Usuario autorizado) habilitado debe confirmar 
cualquier cambio en la configuración.

Login Timeout (Tiempo límite de inicio de sesión)Si el tiempo desde la última 
operación del usuario supera este valor, el usuario deberá 
volver a iniciar sesión. Si se ajusta a cero, la sesión no ca-
duca nunca.

Password Retries (Intentos de ingreso de contraseña)Define el número de ve-
ces que puede intentarse iniciar sesión con una contrase-
ña incorrecta. Si se supera este número, se deshabilita el 
inicio de sesión del usuario.

Passwords Expire (Expiración de contraseña)Define un número de días des-
pués del cual caducan todas las contraseñas y deben in-
troducirse contraseñas nuevas. Si el valor se ajusta a 
cero, las contraseñas no expiran.

Min. Password Length (Longitud mín. de la contraseña)
Establece una longitud mínima para las contraseñas.

Después de realizar todos los cambios, haga clic en el botón «Download» 
(Descarga) para confirmar.
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Clonar los datos de seguridad
La pestaña de datos de seguridad en «Cloning options» (Opciones de clonación) 
permite al usuario definir si se incluyen o no datos del archivo de seguridad al clonar. 
Otra opción hace que iTools pregunte si se incluyen o no los datos de seguridad 
antes de iniciar la operación de clonación.

Figura 59 Pestaña de clonación de los datos de seguridad
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Software Review
Review es un programa que permite al usuario extraer datos de «Archive» (Archivo) 
de uno o más instrumentos* y verlos en un ordenador en forma de gráfico o de hoja 
de cálculo. El ordenador tiene que estar configurado como servidor FTP (véase este 
proceso en "Configuración de un servidor FTP usando Filezilla" en la página 210).

Como se explica en la ayuda del programa, Review permite al usuario configurar la 
transferencia periódica de datos (mediante FTP) desde los instrumentos conectados 
hasta una base de datos en el ordenador, y desde esta base de datos a un gráfico o 
una hoja de cálculo. El gráfico u hoja de cálculo puede estar configurado para incluir 
uno o más «points» [puntos] de uno o de todos los instrumentos conectados (donde 
«point» [punto] es un término genérico que puede indicar canal, totalizador, 
contador, etc.).

También es posible archivar históricos de un dispositivo en una unidad de memoria, 
una tarjeta Compact Flash, etc. (dependiendo del tipo de dispositivo) para luego 
transferirlos al PC.

Cada tipo de dispositivo tiene su propio nombre de usuario y contraseña de 
configuración remota.

*Los instrumentos deben estar conectados y tener archivos con el sufijo ".uhh".
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Configuración
El proceso de configuración permite acceder a la  
configuración del registrador de datos y editarla 
mediante iTools. El usuario debe iniciar sesión y hacer 
clic en el botón «Access» (Acceso), como se describe en "Inicio de sesión" en la 
página 39.

En el modo de configuración, el icono del dispositivo en el panel 
«Panel Views» (Vistas de panel) en la parte inferior de la ventana de 
iTools tiene el símbolo de una llave inglesa superpuesto.

Nota: Los cambios en la configuración se aplican al salir del modo de 
configuración.

Como se ve en Figura 60, la configuración del registrador se divide en una serie de 
áreas, cada una de las cuales se describirá en un apartado de esta sección, como se 
muestra en la tabla. Si es necesario, es posible volver a la configuración 
predeterminada de fábrica usando una contraseña especial de Engineer (Ingeniero), 
tal como se explica en "Menú de seguridad" en la página 72.

PRECAUCIÓN
Las salidas se desactivan durante la configuración; por lo tanto, la unidad no 
se controlará.
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Figura 60 Menú de configuración de nivel superior

Parámetros del dispositivo

Dispositivo. . . . . . . . . . . . . . . . . . . . . . Parámetros del dispositivo
Red . . . . . . . . . . . . . . . . . . . . . . . . . . . Menú de red
Grupo  . . . . . . . . . . . . . . . . . . . . . . . . . Configuración de grupo
E/S  . . . . . . . . . . . . . . . . . . . . . . . . . . . Configuración de E/S (Entrada/Salida)
Canal virtual  . . . . . . . . . . . . . . . . . . . . Configuración de canal virtual
Unidad maestra de Modbus  . . . . . . . . Configuración maestro Modbus
IP de Ethernet . . . . . . . . . . . . . . . . . . . Configuración de Ethernet/IP
Linealizaciones de usuario . . . . . . . . . LIN de usuario
Mensajes personalizados . . . . . . . . . . Mensajes personalizados
Zirconia  . . . . . . . . . . . . . . . . . . . . . . . Opción de bloque de zirconio
Esterilizadores. . . . . . . . . . . . . . . . . . . Opción de bloque de esterilización
Humedad. . . . . . . . . . . . . . . . . . . . . . . Opción de bloque de humedad
Entrada BCD . . . . . . . . . . . . . . . . . . . . Bloque de entrada BCD
Lgc2  . . . . . . . . . . . . . . . . . . . . . . . . . . Bloque lógico (entrada 2)
Lgc8 . . . . . . . . . . . . . . . . . . . . . . . . . . Bloque lógico (entrada 8)
Mux8 . . . . . . . . . . . . . . . . . . . . . . . . . . Bloque de multiplexor
Math2  . . . . . . . . . . . . . . . . . . . . . . . . . Matemáticas (Entrada 2)
Temporizador . . . . . . . . . . . . . . . . . . . Temporizador
Valores de usuario  . . . . . . . . . . . . . . . Valor de usuario
OR. . . . . . . . . . . . . . . . . . . . . . . . . . . . Bloque OR de ocho entradas
Resumen de alarmas  . . . . . . . . . . . . . Resumen de alarmas
Eventos en tiempo real . . . . . . . . . . . . Configuración de eventos en tiempo real
Correo electrónico. . . . . . . . . . . . . . . . Correo electrónico:
Temperatura cinética media  . . . . . . . . Temperatura cinética media (MKT)
Flujo másico  . . . . . . . . . . . . . . . . . . . . Flujo másico
Vapor saturado . . . . . . . . . . . . . . . . . . Vapor saturado
Informe  . . . . . . . . . . . . . . . . . . . . . . . . Informe
Lote . . . . . . . . . . . . . . . . . . . . . . . . . . . Lote
Profinet IO  . . . . . . . . . . . . . . . . . . . . . E/S Profinet
Servidor web . . . . . . . . . . . . . . . . . . . . Servidor web
Comunicaciones serie . . . . . . . . . . . . . Comunicaciones serie
Diagnósticos . . . . . . . . . . . . . . . . . . . . 
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Reloj

Figura 61 Menú de reloj
La fecha se ajusta introduciendo los valores relevantes en el formato mostrado. El 
formato puede cambiarse en la configuración de «Locale» ("Local" en la página 72).

El valor «DST» está en «On» (Activado) solo si se selecciona «Yes» (Sí) en «DST 
Enable» (Habilitar DTS), en «Locale» ("Local" en la página 72) y si el horario de 
verano está en funcionamiento. «On» (Activado) significa que el tiempo mostrado se 
avanza una hora.
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Local

Figura 62 Menú de configuración de Local
Language (Idioma) Seleccione el idioma para las pantallas etc.
Date format (Formato de fecha)Seleccione uno de los siguientes formatos 

MM/DD/YY (MM/DD/AA) o YY/MM/DD (AA/MM/DD).
Time Zone (Zona horaria)Seleccione la diferencia horaria adecuada respecto a 

GMT (UTC). Esta configuración sólo afecta a la hora indi-
cada. Las horas de copia, registro, etc. se siguen indican-
do en GMT.

DST Enable (Habilitar DST)Habilitar horario de verano. Si se habilita esta op-
ción, los siguientes campos, que antes eran de solo lectu-
ra (azul) se vuelven editables, lo que permite configurar 
las fechas de inicio y fin del horario de verano. Esta confi-
guración sólo afecta a la hora indicada. Las horas de co-
pia, registro, etc. se siguen indicando en GMT.

Start Time (Hora de inicio)Solo aparece si «DST Enable» (Habilitar DST) está 
configurado en «Yes» (Sí). Introduzca la hora de inicio re-
querida.

Start On (Empezar en)Seleccione «Last» (última), «First» (primera), «Second» 
(Segunda), «Third» (tercera) o «Fourth» (cuarta) según la 
semana requerida. Se utiliza junto con las entradas si-
guientes de «Start Day» (día de inicio) y «Start Month» 
(mes de inicio).

Start day (Día de inicio)Seleccione el día de la semana en el que comenzará el 
horario de verano.

Start Month (Mes de inicio)Seleccione el mes en el que comenzará el horario 
de verano.

End Time (Hora de fin), End ON (Terminar en), End Day (Día de fin), End Month 
(Mes de fin)
Igual que «Start Time» (Hora de inicio), etc., pero para es-
pecificar la hora y fecha en que termina el horario de vera-
no.

Menú de seguridad
Permite al usuario cambiar las funciones instaladas y regresar individualmente la 
configuración, los ajustes de seguridad y el SSL a los valores predeterminados de 
fábrica.
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Figura 63 Security
Feature Pass (Contraseña de herramientas)    Una contraseña especificada por 

el fabricante para activar opciones de software (como 
Loop, Zirconia, bloques de Toolkit, etc.). Cuando solicite 
esta contraseña el fabricante le pedirá la dirección MAC 
del dispositivo (menú Network.Interface "Interfaz" en la pá-
gina 80) y la versión del firmware del dispositivo (menú 
Instrument.info "Menú Info" en la página 73). La contrase-
ña depende de la dirección MAC para que no se pueda 
usar en ningún otro dispositivo.

Feature2/3 Pass (Contraseña de herramientas 2/3)Similar a «Feature Pass» 
(Contraseña de herramientas) anterior, pero para funcio-
nes adicionales.

Default Config (Configuración predeterminada)Si selecciona «Yes (1)» (Sí), el 
dispositivo se reiniciará con la configuración predetermi-
nada (se realiza un reinicio en frío del dispositivo). Se ne-
cesita una confirmación antes de realizar esta acción.

Default Security (Seguridad predeterminada)Restablece los parámetros de se-
guridad a los valores predeterminados de fábrica.

Default SSL (SSL predeterminado)Selecciona el SSL suministrado de fábrica 
para usarlo con el servidor web.

Menú Info
Proporciona información sobre el hardware y software, y permite al usuario introducir 
una descripción del dispositivo.

Figura 64 Info
Los siguientes parámetros son de solo lectura, salvo que se indique lo contrario.

Name (Nombre) Leer/escribir. Permite al usuario introducir una descripción 
de hasta 20 caracteres.

Type (Tipo) Muestra el modelo del dispositivo.
Version (Versión) Muestra la versión del software del dispositivo.
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Bootrom (ROM de inicio) Muestra la versión del software Boot ROM del dispo-
sitivo ID de compañía para CNOMO* a través de ModBus 
(1280 decimal, 0500 hexadecimal)

Config Rev (Actualización de la configuración)Este valor se actualiza cada vez 
que sale de la configuración, si se ha cambiado uno o va-
rios parámetros de la configuración.

Security Rev (Actualización de la seguridad)Este número aumenta cada vez que se
descarga la configuración de seguridad.

Micro Board Issue (Tarjeta del microprocesador)El nivel de revisión de la tarjeta 
del microprocesador

Number Groups (Grupos de números)Leer/grabar. Permite al usuario seleccio-
nar el número de grupos de registro habilitados.

21CFR11 Indica si se ha habilitado la opción 21CFR11.
Base Size (Tamaño de la base)Muestra el número máximo de módulos que 

pueden instalarse en esta base.
Batch Enabled (Habilitar lote)Indica si se ha habilitado la opción de lote.
Security Manager Enabled (Gestión de seguridad habilitada)

Indica si se ha habilitado la opción «Security Manager» 
(Gestión de seguridad).

Audit Trail Enabled (Audit Trail habilitada)Indica si se ha habilitado la opción 
Audit Trail.

Actualización
Esta función permite al usuario actualizar el dispositivo mediante un archivo de 
actualización facilitado por el fabricante (descargable en la página web de soporte).

Figura 65 Menú «Upgrade» (Actualización)
Upgrade (Actualización)Seleccione el tipo de actualización necesario, como Fir-

mware vía USB, mediante un servidor FTP, un certificado 
SSL desde USB o un servidor FTP. El versadac utiliza cer-
tificados SSL suministrados en formato PEM. SSL = Secu-
re Socket Layer (Capa de conexiones seguras), es el 
método que se utiliza para cifrar el acceso web al registra-
dor.
Consulte al soporte técnico para más detalles sobre cómo 
instalar los propios certificados SSL de los clientes ("Impo-
sible conectar con el error" en la página 196).

Source path (Ruta fuente)Define la ruta fuente completa donde se almacenan 
los archivos de datos de actualización requeridos en la 
unidad de memoria o el servidor FTP.

Initiate (Iniciar) Ajustar en «yes» (sí) para iniciar la actualización.
Upgrade Copy status (Actualización del estado de copia)

Muestra el estado del proceso de actualización como «Id-
le» (Inactivo), «In progress» (En progreso), «Complete» 
(Completado) o «Failed» (Fallido).
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Procedimiento de actualización
Nota: Se recomienda guardar la configuración del dispositivo en un archivo de 
clonación usando iTools antes de actualizar el firmware versadac. Después de 
actualizar el firmware, puede restablecerse la configuración descargando el archivo 
de clonación.

Se recomienda este procedimiento porque es probable que el versadac realice un 
arranque en frío y se pierda la configuración existente al actualizar el firmware.

1. Actualice iTools a la versión más reciente. Si no se hace, algunas funciones 
podrían no ser compatibles y la representación del dispositivo en «Panel View» 
(Vista de panel) podría no aparecer correctamente.

2. Copie el archivo upgrade.tgz obtenido de buildFiles.zip en una unidad de 
memoria USB o un servidor FTP.

3. Inicie la actualización ajustando «Initiate» (Iniciar) en «Yes» (Sí).

El versadac copia el archivo de actualización en su memoria interna y se reinicia 
automáticamente. Cuando el versadac se reinicia, los LED del IOC parpadean 
mientras se procesa la actualización.

Ajuste de entrada
Notas:
1. El ajuste de entrada no se puede aplicar a canales con entrada de tipo «Digital», 

«Test» (Prueba) y «Off» (Desactivado).
2. Los ajustes de entrada solo pueden ser realizados por usuarios con el permiso 

«Adjust Inputs and Outputs» (Ajustar entradas y salidas) habilitado ("Pestaña de 
perfiles de usuario" en la página 63).

3. El dispositivo tiene que estar encendido el tipo suficiente (30 minutos, por 
ejemplo) para alcanzar el equilibrio térmico antes de realizar ajustes de entrada.

4. Se recomienda seleccionar «Hide parameters and lists when not relevant» 
(Ocultar los parámetros y listas cuando no sean pertinentes) en el elemento del 
menú iTools Options>Parameter availability settings... (Opciones>Configuración 
de parámetros disponibles) ("Detalles del explorador de parámetros" en la 
página 55). En caso contrario, la lista de parámetros incluirá muchos que no son 
relevantes.

5. Si cualquier módulo AI8 está instalado, el ajuste de entrada se dividirá en lotes 
del 1 al 8 y del 9 al 16, ya que una única página no puede soportar todos los 
parámetros que se requieren.

Este menú permite al usuario, por ejemplo, compensar errores de tolerancia. La 
técnica empleada consiste en seleccionar los canales cuya entrada se desea ajustar 
y, para cada uno de ellos:

1. aplicar una señal conocida de bajo nivel (igual o próxima al valor de entrada 
baja) a la entrada correspondiente. y pulsar «Apply» (Aplicar) cuando se 
estabilice la medida del registrador.

2. aplicar una señal conocida de alto nivel (igual o próxima al valor de entrada alta) 
a la entrada correspondiente. y pulsar «Apply» (Aplicar) cuando se estabilice la 
medida del registrador.
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Figura 66 Menú de ajuste de entrada
PointM_C Muestra el estado de ajuste del módulo de punto M canal 

C
Apply Adjust (Aplicar ajuste)Al seleccionar «Yes» (Sí) aparece la página Select 

Point (Selección de puntos), que se describe a continua-
ción.

Remove Adjust (Eliminar ajuste)Seleccione «Yes» (Sí) para iniciar el procedi-
miento de eliminación de ajuste descrito a continuación.

Figura 67 Seleccionar puntos para el ajuste
SelectPointM_C Incluye módulo M, canal C en el procedimiento de ajustar 

o eliminar ajuste. En cuanto se selecciona un punto, apa-
rece el campo «Start IP Adjust» (Iniciar ajuste de IP).

Figura 68 Objetivos alto y bajo de ajustar entrada
StartIPadjust (Iniciar el ajuste de IP)Aplica el valor objetivo bajo a los puntos se-

leccionados (véase «Procedimiento de ajuste» a continua-
ción)

LowTargetValue (Reducir el valor objetivo)El valor que el dispositivo debe leer 
para la entrada baja aplicada.

ConfirmLow (Confirmar reducción)Confirma que los valores son estables y 
avanza al objetivo alto.
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HighTargetValue (Aumentar el valor objetivo)El valor que el dispositivo debe 
leer para la entrada alta aplicada.

ConfirmHigh (Confirmar aumento)Completa el procedimiento de ajuste.
RemoveIPAdjust (Eliminar el ajuste de IP)Permite eliminar el ajuste de los pun-

tos que se han ajustado.
Abort (Abortar) Permite al usuario interrumpir el ajuste de entrada en cual-

quier momento del procedimiento.

Procedimiento de ajuste de entrada
1. Establezca «ApplyAdjust» (Aplicar ajuste) en «Yes» (Sí)

2. Establezca los puntos que van a ajustarse en «Yes» (Sí) (por ejemplo, 
establezca «SelectPoint1_1» en «Yes» [Sí]).

3. Aplique un valor bajo conocido y espere a que se estabilice el valor. Especifique 
el «Low Target Value» (Valor objetivo bajo) (el valor que debe medir el 
registrador para el valor bajo conocido). Cuando se hayan estabilizado los 
valores de los punto seleccionados (como Point1_1Value) establezca 
«ConfirmLow» (Confirmar reducción) en «Yes» (Sí).

4. Aplique un valor bajo conocido y espere a que se estabilice el valor. Especifique 
el «High Target Value» (Valor objetivo alto) (el valor que debe medir el 
registrador para el valor alto conocido). Cuando se hayan estabilizado los 
valores de los punto seleccionados (como Point1_1Value) establezca 
«ConfirmHigh» (Confirmar subida) en «Yes» (Sí).

Eliminar procedimiento de ajuste
1. Establezca «RemoveAdjust» (Eliminar ajuste) en «Yes» (Sí).

2. Establezca los puntos correspondientes, cuyo ajuste va a eliminarse, en «Yes» 
(Sí) (por ejemplo, establezca «SelectPoint1_1» en «Yes» (Sí)).

3. Establezca «RemoveIPAdjust» (Eliminar ajuste de IP) en «Yes» (Sí).

Ajustar salida
Este menú solo puede usarse si se ha instalado uno o varios módulos de salida, y 
permite al usuario compensar errores de compatibilidad, etc. en los equipos 
conectados.

Notas:

1. Los ajustes de entrada solo pueden ser realizados por usuarios con el permiso 
«Adjust Inputs and Outputs» (Ajustar entradas y salidas) habilitado ("Pestaña de 
perfiles de usuario" en la página 63).

2. El dispositivo tiene que estar encendido el tipo suficiente (30 minutos, por 
ejemplo) para alcanzar el equilibrio térmico antes de realizar ajustes de entrada.

3. Se recomienda seleccionar «Hide parameters and lists when not relevant» 
(Ocultar los parámetros y listas cuando no sean pertinentes) en el elemento del 
menú iTools Options>Parameter availability settings... (Opciones>Configuración 
de parámetros disponibles) ("Detalles del explorador de parámetros" en la 
página 55). En caso contrario, la lista de parámetros incluirá muchos que no son 
relevantes.
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Figura 69 Pantalla inicial del ajuste de salida

Procedimiento de ajuste
1. Establezca «ApplyAdjust» (Aplicar ajuste) en «Yes» (Sí).

2. Establezca los parámetros «SelectPoint» (Seleccionar punto) relevantes en 
«Yes» (Sí).

3. Establezca «StartOPAdjust» (Iniciar ajuste de OP) en «Yes» (Sí).

4. Mida la salida en el punto requerido y escriba este valor en el campo «Measured 
Output» (Salida medida). Pase al punto 5 si desea omitir esta acción.

5. Establezca «Confirm Low» (Confirmar reducción) en «Yes» (Sí).

6. Mida la salida en el punto requerido y escriba este valor en el campo «Measured 
Output» (Salida medida) del mismo modo que para el punto bajo. Pase al punto 
7 si desea omitir esta acción.

7. Establezca «Confirm High» (Confirmar aumento) en «Yes» (Sí). Se abrirá la 
pantalla inicial del ajuste de salida, con la palabra «Adjusted» (Ajustado) en el 
campo del punto correspondiente.

El parámetro «Output» (Salida) indica el valor de salida nominal que se está 
enviando a la salida de CC. Los valores posibles son 2 V, 10 V, 4 mA, 20 mA.

«Abort» (Abortar) cancela las operaciones hasta ahora y vuelve a la pantalla inicial 
del ajuste de salida ().
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Eliminación de ajuste
1. Establezca «Remove Adjust» (Eliminar ajuste) en «Yes» (Sí) y use la tecla de 

desplazamiento para acceder al modo de edición.

2. Establezca la salida deseada en «Yes» (Sí). El ajuste de salida se eliminará sin 
pedir confirmación. La descripción del punto volverá a ser «Unadjusted» (Sin 
ajustar).

E/S instalada
Ofrece una pantalla que muestra el tipo de módulo de entrada o salida instalado en 
cada ranura. Al configurar un dispositivo, es posible introducir el tipo de módulos que 
se espera instalar en cada ranura para poder completar el resto de la configuración  
preparada para su descarga en un dispositivo real.

Figura 70 Pantalla E/S instaladas
Module N Fitted (Módulo N instalado)El módulo detectado por el dispositivo en 

la ranura N. Solo lectura
Module N Expected (Módulo N esperado)

Permite al usuario introducir el tipo de módulo que se es-
pera instalar en la ranura N.

Lote
En esta parte de la configuración permite al usuario seleccionar «Instrument» 
(Instrumento) o «Group» (Grupo) como el alcance del lote. El resto de la 
configuración del lote se describe en «Batch Configuration» (Configuración del lote) 
en «Batch» (Lote) en la página 150.

Figura 71 Configuración del alcance del lote
Nota: El alcance se fuerza en «Group» (Grupo) y se vuelve solo lectura si está 
instalada la opción de esterilizador.
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Menú de red

Figura 72 Menú de red de nivel superior

Interfaz
Este área de configuración permite al usuario definir la dirección IP del dispositivo, 
ya sea escribiéndola (fija) o automáticamente (DHCP), siempre y cuando esté 
funcionando un servidor DHCP.

Interface
(Interfaz)

Dirección MAC
Client Identifier

IP type (Tipo CJC)
Dirección IP

Máscara de subred
Gateway

Activar DNS
Servidor DNS
Activar SNTP

Servidor SNTP
Servidor  AD
Seguridad AD

Archivo
(Archivado)
Media Size
Media Free

Media Duration
Frecuencia de archivo

Destino
File Format

Parámetros CSV
Soporte lleno
Remote Path

Dirección IP servidor 
primario

Primary User
Primary Password

Dirección IP servidor 
secundario

Secondary User
Secondary Password

Disparo
Periodo

ModBus
(ModBus TCP)

Prefmaster IP
Dirección

Input Timeout
HabiID Unidad

Formato Tiempo

Demand Archive
(Demanda de archivo)
Suspender programación

Estado
Estado primario

Estado Sec.
Últ. Escritura

network (Red)



Versadac Configuración

HA031352 Edición 3 81

Figura 73 Menú de interfaz de red
MAC Solo lectura. Control de acceso a medios. Una dirección 

exclusiva definida en fábrica para cada dispositivo.
Client Identifier (Identificador de cliente)El identificador de cliente es un identifi-

cador único utilizado por los servidores DHCP que imple-
mentan la opción 61. Cada dispositivo tiene una ID única 
que se obtiene de su dirección MAC. Si está configurado 
para usar la opción 61, el servidor DHCP utilizará este 
identificador en lugar de la dirección MAC para asignar 
una dirección IP dinámica.

IP Type (Tipo de IP)  Si está en «Fixed» (Fijo), el usuario tiene que especificar 
una dirección IP y una máscara de subred en los siguien-
tes campos, así como una dirección de pasarela si es ne-
cesario.
Si es «DHCP», los siguientes campos son de solo lectura 
y el servidor DHCP genera sus entradas automáticamen-
te.
el sistema necesita unos segundos para obtener la direc-
ción IP del servidor DHCP.

IP Address (Dirección IP)Solo lectura si «IP Type» (Tipo IP) = «DHCP».
Si «IP Type» (Tipo IP) es «Fixed» (Fijo), es posible que el 
usuario tenga que especificar una dirección IP (en nota-
ción IPV4). Lo normal es que el administrador de red o el 
departamento de informática del usuario faciliten esta di-
rección.

Subnet Mask (Máscara de subred)Solo lectura si «IP Type» (Tipo IP) = «DH-
CP».
Si «IP Type» (Tipo IP) es «Fixed» (Fijo), este campo defi-
ne el intervalo de direcciones IP a las que se puede acce-
der. Lo normal es que el administrador de red o el 
departamento de informática del usuario faciliten esta in-
formación.

Gateway Solo lectura si «IP Type» (Tipo IP) = «DHCP».
Si «IP Type» (Tipo IP) es «Fixed» (Fijo), este campo per-
mite al usuario especificar una dirección de gateway que 
se utiliza cuando la unidad intenta establecer comunica-
ción fuera de la red local. Lo normal es que el administra-
dor de red o el departamento de informática del usuario 
faciliten esta información.

DNS Enable (DNS habilitado)Habilita el sistema de nombres de dominio. Per-
mite la asignación de nombres de host a direcciones IP y 
viceversa.

DNS Server (Servidor DNS)El departamento técnico o el supervisor o gerente 
de dominios facilitará la dirección IP.

SNTP Enable (SNTP habilitado)Habilita SNTP
SNTP Server (Servidor SNTP)La dirección IP del servidor SNTP.
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AD Server (Servidor de AD)Este elemento solo aparece si está activada la op-
ción «Security Manager» (Gestión de seguridad). Permite 
introducir la dirección IP del servidor Active Directory (Di-
rectorio activo) que se utilizará con esta aplicación. La di-
rección IP se obtiene normalmente del departamento 
técnico o del administrador de red del usuario. Después de 
introducirla, suponiendo que el dispositivo esté conectado 
a la misma red que el servidor, los usuarios con un domi-
nio configurado podrán iniciar sesión usando su contrase-
ña de acceso normal a la red.

AD Security (Seguridad de AD)Este elemento solo aparece si está activada la 
opción Security Manager. Cuando se selecciona TLS 
(puerto 636), todo acceso al servidor se protege usando 
TLS en el puerto 636 mediante el método LDAP_ SER-
VER_START_TLS_OID. TLS (puerto 389) es similar pero 
utiliza TLS en el puerto 389.

Archivado
Este área de configuración permite definir los parámetros que se utilizan durante la 
copia automática de archivos. Algunos de los campos sólo aparecen si los otros 
campos tienen un valor concreto. Por ejemplo, los campos de CSV solo se muestran 
si «File Format» (Formato de fichero) está configurado como «CSV» o «Both» 
(Ambos).

Los datos archivados no se borran de la memoria Flash del dispositivo. Si la 
memoria Flash está llena, la entrada de nuevos datos hace que se borren los 
archivos más antiguos.

Nota: Para el archivado remoto, el ordenador host debe configurarse para 
responder al comando Ping. Esto se debe a que el dispositivo envía un ping al host 
al establecer la conexión y, si no recibe una respuesta, el intento de archivado 
fracasa.

Figura 74 Menú de configuración de archivo sin supervisar
Media Size (Tamaño de medios)Aparece solo si «File Format» (Formato de ar-

chivo) = «Binary (UHHH)» (Binario (UHH)). Es un valor 
solo lectura que muestra la capacidad de la unidad de me-
moria conectada al puerto USB. Indica cero si no está co-
nectada ninguna unidad de memoria.

Media Free (Media libre)Aparece solo si File Format (Formato de archivo) = 
«Binary (UHHH)» (Binario (UHH)). Es un valor solo lectura 
que muestra el espacio restante en la unidad de memoria 
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conectada al puerto USB. Indica cero si no está conectada 
ninguna unidad de memoria.

Media Duration (Duración de medios)Aparece solo si File Format (Formato de 
archivo) = «Binary (UHH)» (Binario (UHH)). Un valor solo 
lectura que muestra el tiempo necesario para llenar la uni-
dad de memoria si no se modifica la configuración del re-
gistrador.

Archive Rate (Frecuencia)Permite al usuario especificar la frecuencia con que 
los contenidos de la unidad de memoria se deben archivar 
a través del puerto USB o a un ordenador a través de FTP.

Las posibles opciones son:
None (Ninguna) Se desactiva el archivado automáti-

co.
Hourly (Horaria)    El archivado se realiza cada hora a las 

horas en punto.
Daily (Diaria) El archivado se inicia cada día a las 

00:00*
Weekly (Semanal) El archivado se inicia cada domingo a medianoche*
Monthly (Mensual)   El archivado se realiza a las 00:00* del primer día de cada 

mes.

Nota: *El horario de verano no afecta a las horas de archivado. Si la frecuencia de 
archivado está configurada en «Daily» (diaria), «Weekly» (semanal) o «Monthly» 
(mensual), los archivos se realizarán una hora más tarde durante el verano (es decir, 
a la 01:00 en lugar de a media noche).

Automatic (Automático)    El registrador selecciona la opción menos frecuente 
de las anteriores para evitar que se pierdan datos por falta 
de espacio en la memoria flash interna.

Destination (Destino)Seleccione «FTP Server» (Servidor FTP) para archivar en 
un ordenador remoto o «USB» para archivar en un diposi-
tivo conectado al puerto USB.

File format (Formato de archivo)Seleccione «Binary (UHH)» (Binario (UHH)), 
«CSV» o «Both» (Ambos).

Binarios (UHH)
Un formato propio del dispositivo 
que debe ser interpretado por otro 
software (como Review) para que los datos se puedan 
presentar en hojas de cálculo, etc. Los archivos binarios 
tienen la extensión .uhh.

CSV    Un formato de archivo abierto estándar para datos numéricos.
Está basado en ASCII y se puede leer con un gran número 
de aplicaciones informáticas. También es posible impor-
tarlo directamente desde muchas bases de datos comer-
ciales. Los archivos CSV tienen la extensión .csv.

Both (Ambos) El archivado incluye tanto .uhh como .csv.

Nota: CSV está basado en ASCII y no puede interpretar caracteres Unicode. Por 
este motivo, es posible que el usuario utilice algunos caracteres que no aparezcan 
correctamente en archivos .csv.

CSV Values (Valores de CSV)Solo se muestran si «File Format» (Formato de 
archivo) está configurado como «CSV» o «Both» (Ambos). 
Si se elige «Yes» (Sí), los valores de proceso se incluyen 
en el archivo (consulte Figura 75 para más información).

CSV Messages (Mensajes CSV)Solo aparece si «File Format» (Formato de ar-
chivo) está configurado como «CSV» o «Both» (Ambos). 
Si se elige «Yes» (Sí), los mensajes se incluyen en el ar-
chivo (consulte Figura 75 para más información).

CSV Headers (Encabezados CSV)Solo aparece si «File Format» (Formato de 
archivo) está configurado como «CSV» o «Both» (Ambos). 
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Si se elige «Yes» (Sí), los datos de encabezamiento se in-
cluyen en el archivo (consulte Figura 75 para más informa-
ción).

CSV Headings (Títulos CSV)Solo aparece si «File Format» (Formato de archi-
vo) está configurado como «CSV» o «Both» (Ambos). Si 
se elige «Yes» (Sí), los encabezados de columna se inclu-
yen en el archivo (consulte Figura 75 para más informa-
ción).

CSV Date Format (Formato de fecha CSV)Solo aparece si «File Format» (For-
mato de archivo) está configurado como «CSV» o «Both» 
(Ambos). Premite seleccionar «Text» (Texto) o «Spreads-
heet» (Hoja de cálculo). "Text" hace que aparezca una ho-
ra/fecha en la hoja de cálculo. «Spreadsheet Nu» (Hoja de 
cálculo numérica) muestra el número de días desde el 30 
de diciembre de 1899.
La parte decimal del número representa las últimas seis 
horas. Por ejemplo, DDD--- --DD.25 representa 06.00 ho-
ras, mientras que DDD--- --DD.5 corresponde a 12.00 ho-
ras.
El formato «Spreadsheet Numeric» (Hoja de cálculo nu-
mérica) es más fácil de interpretar que el formato «Text» 
(Texto) en algunas aplicaciones de hojas de cálculo.

CSV Tab Del Solo aparece si «File Format» (Formato de archivo) está 
configurado como «CSV» o «Both» (Ambos).
El formato CSV (variables separadas por comas) no siem-
pre emplea comas como separadores. Por ejemplo, el 
punto decimal se representa con un punto en algunos paí-
ses y con una coma en otros. Es posible elegir otro sepa-
rador para evitar la confusión entre el uso de la coma 
como punto decimal y como separador.
Este campo permite usar el carácter «tabulador» (^t) en lu-
gar de una coma.

On Media Full (Media llena)Solo aparece si «Destination» (Destino) está confi-
gurado como «USB». Permite al usuario seleccionar la ac-
ción que se debe realizar si la unidad de memoria está 
llena. Las opciones son «Overwrite» (Sobrescribir) y 
«Stop» (Detener). «Overwrite» (Sobrescibir) hace que los 
datos más antiguos sean eliminados para dejar sitio a los 
nuevos, Mientras que «Stop» (Detener) impide que se 
puedan copiar nuevos datos.

Remote Path (Ruta remota)Se debe dejar en blanco si el directorio de destino 
es el de inicio. Si es una carpeta dentro del directorio de 
inicio, se debe especificar el nombre de la carpeta prece-
dido de un carácter «/» (por ejemplo, «/history»).

Primary Server (Servidor primario)Permite al usuario especificar la dirección IP 
del ordenador que se va a utilizar como servidor principal 
de FTP.

Usuario/Contraseña primarios
Son el nombre de usuario y la contraseña para la cuenta 
en el ordenador remoto, asignados por el administrador de 
red o definidos en la cuenta «Guest» (Invitado) de la con-
figuración «FTP server» (Servidor FTP) o «User Mana-
ger» (Administrador de usuarios) del ordenador remoto.

Sec. Servidor/usuario/contraseña
Igual que para el servidor principal, pero para el servidor 
secundario de FTP que se utiliza cuando por algún motivo 
no es posible acceder al principal.

Trigger (Activador) Este parámetro se puede «conectar», por ejemplo, a una 
alarma que se activa o a una entrada digital para activar 
una operación de copia de forma remota. También se pue-
de configurar manualmente en «Yes» (Sí).
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Period (Período) Permite seleccionar un período del histórico para copiarlo 
cuando «Trigger» (Disparador) es «True» 8Verdadero). 
Las posibles opciones son: None (Ninguno), Last Hour 
(Última hora), Last Day (Último día), Last Week (Última se-
mana), Last Month (Último mes), All (Todo), Bring to Date 
(Actualizar). («Last Month» (Último mes) copia los últimos 
31 días del histórico).

Figura 75 Ejemplo de datos CSV

Incluir datos de 
encabezado

Incluir 
encabezados 

Incluir valores

Incluir mensajesPulse el botón derecho y seleccione:
Formato de celdas...
seleccione «time» (hora) como categoría 
de número y «type» (tipo) de hora/fecha 
según sea necesario.

Haga clic o arrastre el separador para 
editar la anchura del campo de edición
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ModBus TCP
Esta opción permite al usuario configurar el registrador de modo que pueda 
establecer comunicaciones usando el protocolo de control de transmisión (TCP) 
ModBus.

Figura 76 Menú de configuración del Modbus TCP
PrefMaster IP La dirección IP del maestro ModBus correspondiente. El 

maestro preferido es el que puede establecer conexión 
aunque se estén utilizando todas las conexiones esclavas 
(máx. = 4 para TCP).

Address (Dirección) La dirección Modbus para este esclavo. Esta dirección tie-
ne que ser exclusiva en la red a la que pertenece. El regis-
trador responderá a esta dirección y a la dirección 255.

Input Timeout (Tiempo de espera de entrada)Permite definir un tiempo entre 0 
y 3600 segundos para configurar el tiempo de desco-
nexión para canales de entrada Modbus. Si no se realiza 
ninguna operación de escritura en una entrada Modbus 
durante el tiempo especificado, el valor del canal pasa a 
-9999.0 con estado «No Data» (Sin datos). El valor 0 des-
activa la desconexión de comunicaciones por tiempo de 
inactividad.

Unit ID Enable (Habilitar ID de unidad)Activa/desactiva la comprobación del 
campo de identidad de la unidad TCP Modbus.

Strict (Estricto) El campo identidad de unidad Modbus TCP (UIF) no tiene 
por qué coincidir con la dirección del dispositivo. El dispo-
sitivo únicamente responde si el valor hexadecimal del UIF 
es FF. iTools sólo encuentra el dispositivo en la dirección 
255 y luego detiene la búsqueda.

Loose (Suelto) El campo identidad de unidad Modbus TCP (UIF) no tiene 
por qué coincidir con la dirección del dispositivo. Instru-
ment (Instrumento)El campo identidad de unidad Modbus 
TCP (UIF) debe coincidir con la dirección del dispositivo o 
no se responderá a los mensajes.

Time Format (Formato de tiempo)Permite al usuario elegir milisegundos, se-
gundos, minutos u horas como formato de tiempo. Define 
la resolución para la lectura y escritura de parámetros con 
formato de tiempo.

Nota: *Unit ID Enable (Habilitar ID de la unidad) debe ajustarse en «Instrument» 
(Instrumento) para la transmisión Modbus serial. Además, el protocolo del puerto 
serie debe ajustarse en «Modbus Master» (Modbus maestro) ("Comunicaciones 
serie" en la página 170).
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Demanda de archivo

Figura 77 Menú «Demand archive» (Demanda de archivo)
Si el usuario tiene el nivel de acceso adecuado, esta opción permite archivar una 
parte del histórico del registrador a una unidad de memoria conectada al puerto USB 
(copia local) o bien a un ordenador utilizando el protocolo FTP (copia remota). Los 
datos archivados permanecen en la memoria Flash del dispositivo. Si la memoria 
Flash está llena, la entrada de nuevos datos hace que se borren los archivos más 
antiguos.

Archive To (Archivo a)Seleccione «USB» o «FTP Server» (Servidor FTP).
Si se elige «USB», los datos se copiarán a la unidad de 
memoria USB. Si se elige «FTP Server» (Servidor FTP), 
los datos se copiarán al servidor principal o secundario 
(configurados en el área de configuración Network.Archi-
ve, como se explica en "Archivado" en la página 82).

Archive Action (Acción de archivo)     Use el mismo procedimiento para selec-
cionar el período de los datos que desee copiar:

Nota: No se archivará ningún dato (esta opción no se puede cambiar en modo 
"Logged Out").

Last hour (Última hora): Se archivarán todos los archivos creados en los últimos 60 
minutos.

Last Day (Último día): Se archivarán todos los archivos creados en las últimas 24 
horas.

Last week (Última semana): Se archivarán todos los archivos creados en los últimos 
7 días.

Last month (Último mes): Se archivarán todos los archivos creados en los últimos 31 
días.

Archive all (Archivar todo): Se archivarán todos los archivos históricos del 
registrador.

Actualizar: Se archivarán todos los archivos creados o modificados desde la fecha y 
hora de la última copia.

Suspend Schedule (Suspender programación)    Si se elige «Yes» (Sí), el archi-
vado automático (planificado) se detiene una vez termina-
da la transferencia del último archivo.
Para reiniciar el archivado hay que volver a seleccionar 
«No». Esta opción se puede usar para desconectar y co-
nectar de forma segura la unidad de memoria.

Status (Estado) Activo solo para archivar al USB 
«Complete» (Completo) significa que no se está archivando en este momento.
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«Transferring» (Transfiriéndose) indica que está en proceso de archivado. Se 
muestra también un círculo en movimiento.

«Suspended» (Suspendido) significa que el archivado se ha interrumpido, se-
gún solicitado.

PriStatus (Estado principal)    Solo para archivos a servidor FTP. Indica el esta-
do de transferencia entre el dispositivo y el servidor princi-
pal.

SecStatus (Estado secundario)   Solo para archivos a servidor FTP. Indica el es-
tado de transferencia entre el dispositivo y el servidor se-
cundario.

Last Written On (Última copia)    Indica la fecha y la hora en que se realizó un 
archivado por última vez (manual o automática). Si se 
quiere archivar de forma manual o se está realizando un 
archivado manual cuando se inicia uno automático, el ar-
chivado automático tiene prioridad.

Configuración de grupo
La configuración del grupo se divide en tres áreas básicas: características de 
tendencias, características de registro y estado de alarma y confirmación.

Figura 78 Configuración de grupo de nivel superior
Para acceder a los menús de nivel inferior para un grupo, haga clic en la ficha del 
grupo requerido y, después, en la flecha hacia abajo.

Figura 79 Menú de configuración de «Group» (Grupo)

Tendencia
(Configuración de 

tendencia de grupo)
Descriptor

Units (unidades)
Velocidad A
Intervalo A
Velocidad B
Intervalo B

Seleccionar intervalo B
Seleccionar color B

Seleccionar intervalo B y 
zona B

Tipo de cuadrícula
Divisiones mayores
Divisiones menores

Décadas de cuadrícula

Registro
(Configuración de 

tendencia de grupo)
Tamaño de flash
Duración Flash

Enable (Habilitar)
Velocidad A
Intervalo A
Velocidad B
Intervalo B

Seleccionar intervalo B
Compresión

Suspend
Estado

Del punto 1 al punto 240

Alarma
(Alarma de grupo)

Activa
Reconocimiento

Notas
(Notas)

Grupo
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Configuración de tendencia de grupo
Permite al usuario definir el intervalo de tendencias, seleccionar el intervalo de 
tendencias B, el color B y el intervalo y zona B, así como el número de divisiones en 
el gráfico.

Figura 80 muestra un ejemplo por defecto de página de configuración.

Figura 80 Configuración de tendencia de grupo
Nota: Consulte «User LIN» (Usuario de LIN) en la página 117 si desea más 
información sobre la configuración de «Range High/Low» (Rango superior/inferior) y 
de «Input High/Low» (Entrada superior/inferior) cuando «Type» (Tipo) = «User 1 to 
User 4» (de Usuario 1 a Ususario 4).

Descriptor (Descripción)Permite al usuario introducir una descripción (con un 
máximo de 20 caracteres) para el grupo. Es posible intro-
ducir más caracteres, pero solo se aceptan los 20 prime-
ros.

Interval A (B) (Intervalo A [B])El intervalo de representación, que define cuántos 
datos se muestran dentro de una pantalla. Se puede elegir 
un número de intervalos discretos entre 0,125 segundos y 
1 hora. La selección dependerá del nivel de detalle desea-
do y de cuántos datos se quiera ver en la pantalla.

Select Interval/Color/Span/Zone B (Seleccione intervalo/color/intervalo/zona B)
Si se selecciona «Yes» (Sí) , se activan los parámetros de 
«Set B» (Conjunto B), en caso contrario se usan los pará-
metros de «Set A» (Conjunto A).

Grid Type (Tipo de cuadrícula)Seleccione «None» (Ninguna), «Linear» (Lineal) 
o «Log» (Logarítmica)

Major Divisions (Divisiones principales)   Para el tipo de cuadrícula «Linear» (Li-
neal), permite al usuario seleccionar el número de divisio-
nes de la escala, así como el número de líneas en 
pantalla. Si el valor es 1, sólo se mostrarán el cero y el 
máximo de la escala. Si el valor es 10 (el máximo), se 
mostrarán el cero, el máximo de la escala y nueve valores 
intermedios, con las líneas correspondientes.

Minor Divisions (Divisiones secundarias)    Para el tipo de cuadrícula «Linear» 
(Lineal), permite al usuario seleccionar el número de divi-
siones en que se dividen las divisiones mayores.

Grid decades (Décadas de cuadrícula)Para el tipo de cuadrícula «Log» (Loga-
rítmica), permite al usuario seleccionar el número de dé-
cadas que se incluirán en la cuadrícula.
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Configuración de registro de grupo
Es similar a la configuración de tendencia, pero se usa para guardar los datos en 
archivos de historial en la memoria Flash. El registro se puede activar y desactivar 
por separado para cada punto o para todo el grupo.

Figura 81 muestra una ventana por defecto.

Figura 81 Configuración de registro de figuras
Flash Size (Tamaño de flash) Campo de solo lectura. Indica el tamaño (en MB) 

de la memoria Flash.
Flash Duration (Duración Flash)Campo de solo lectura. Indica el tiempo nece-

sario para llenar la memoria Flash si no se modifica la con-
figuración del registrador.

Enable (Habilitar)    «Yes» (Sí) activa el registro de grupo, de manera que todos 
los puntos configurados con «Yes» (Sí)  se almacenan en 
la memoria Flash del registrador. «No» desactiva el regis-
tro de grupo.

Speed A (B) (Velocidad A [B])Introduzca un número de mm/hora o pulga-
das/hora para definir la velocidad de tendencia.

Interval A (B) (Intervalo A [B])Define la frecuencia con la que se guardan los da-
tos en la memoria flash del registrador. Este valor afecta a 
la cantidad de datos de historial que aparecen en pantalla 
en el modo de historial de representación. Se puede elegir 
un número de intervalos discretos entre 0,125 segundos y 
1 hora.

Select IntervalB (Sleccionar intervalo B)Si se selecciona «Yes» (Sí), se activan 
los parámetros del «Set B» (Conjunto B) en caso contrario 
se usan los parámetros del «Set A» (Conjunto A).

Compression (Compresión)Seleccione «Normal» o «High» (Alta). «Normal» 
comprime los datos, pero la copia sigue siendo exacta. 
«High» (Alta) aplica un grado de compresión mayor, pero 
solo copia valores con una resolución de 1 parte en 108.
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Nota: Si hay valores muy elevados (como ocurre con algunos valores de 
totalizador), la compresión «High» (Alta) puede hacer que el valor mostrado en el 
registrador (y guardado en el archivo históricol) sea incorrecto. Este problema se 
puede evitar cambiando a compresión a «Normal» o, en el caso de un totalizador, 
cambiando la escala (por ejemplo, de megawatios-hora a terawatios-hora).

Suspend (Suspender)Esta opción se ignora si el usuario no ha hecho una co-
nexión a este campo. Si se ha hecho la conexión, el regis-
tro está activo si se elige «No» y se detiene si se elige 
«Yes» (Sí).

Status (Estado) El estado actual del registro.
0: Not Recording (El dispositivo no se ha configurado para 
registrar ningún dato).
1: Recording Disabled (El dispositivo no se ha configurado 
para registrar ningún dato).
2: Messages Only  (El dispositivo solo está configurado 
para registrar datos de mensajes).
3: Recording Enabled  (El dispositivo solo está configura-
do para registrar todos los datos).
4: Recording Paused  (El registro de datos del dispositivo 
está detenido actualmente).

Point1 to Point240 (Del punto 1 al punto 240)Permi-
te al usuario seleccionar los 
puntos que se registran hacien-
do clic en el botón de elipsis (...) 
y, después, seleccionando un 
módulo de E/S y el canal aso-
ciado en el cuadro de diálogo 
que aparece.

Nota: Pueden configurarse un máximo de 500 puntos 
entre todos los grupos

Alarma de grupo

Figura 82 Página de menú «Group alarm» (Alarma de grupo)
Esta pantalla muestra si hay una o más alarmas activas en el grupo y permite al 
usuario confirmarlas. El mensaje de alarma permite incluir los mensajes de alarma 
en el histórico del grupo
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Notas

Figura 83 Página de configuración de «Group notes» (Notas grupales)
El operario puede introducir notas en cualquier momento. Las notas tienen hasta 100 
caracteres y no se asocian con el histórico del grupo actual.

Las notas del 1 al 10 son notas prefijadas que pueden incluirse en mensajes, etc.
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Configuración de E/S (Entrada/Salida)

Figura 84 Menú de configuración de canal
Haga clic en la carpeta de flecha abajo para acceder a los niveles de menú inferior 
para el módulo y canal seleccionados.
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Figura 85 Estructura del menú de configuración de E/S

Main
(E/S principal)

Módulos esperados
Descriptor

Tipo de E/S
Salida PV

Estado de salida PV
Entrada PV

Estado de entrada PV
IP Adjust State
OP Adjust State

Resolution(Resolución)
Test Signal

Input Low/High
Lin Type
Rango 

superior/inferior/unidades
Salida baja/alta
Scale Low/High
Units (unidades)

Offset

Principal (cont.)
CJ type (Tipo CJC)
Temp CJC externa
Temp CJ remota

Filtro
Respuesta de desconexión 

del sensor
Fallback PV

Measured Value
Temp CJC interna

Salida
Cadena abierta
Cadena cerrada

Tendencia
(Configuración de 

tendencia)
Colores A y B

Seleccionar color B
Intervalo A (B) bajo
Intervalo A (B) alto

Zona A (B) baja
Zona A (B) alta

Seleccionar intervalo/zona B
Scale Type

Divisiones escala mayor
Divisiones escala menor

Formato PV

Alarm 1/2
(Menú de Alarma 1)
(Menú de Alarma 2)

Type
Estado
Umbral

Histéresis
Retención

Bloque
Mantenimiento

Reconocimiento
Activa

Inactiva
Not Acknowledged
Acknowledgement

Módulos de E/S Selección del número de módulo

Selección del número de puntoN
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E/S principal

Figura 86 Menú principal de canal

Parámetros
Solo aparecen los parámetros relevantes para el módulo de E/S actual (si está 
habilitado Options>Parameter availability settings...[Opciones>Configuración de 
disponibilidad de parámetro]>«Hide parameters and lists when not relevant» [Ocultar 
los parámetros y listas cuando no sean relevantes]).

Module expected (Módulo esperado)El módulo que se espera instalar en esta 
ranura del módulo

Descriptor (Descripción)Permite introducir una descripción (con un máximo de 
20 caracteres) para el canal.

AI Type (Tipo de AI) Seleccione el tipo de entrada (las opciones varían en fun-
ción del tipo de módulo (AI2, AI3, AI4))
0: Off (Desactivado)Todos los tipos de módulos
1: mA. El rango de entrada requerido se es-

pecifica, en mA, mediante los pará-
metros «Input Low» (Entrada baja) e 
«Input High» (Entrada alta). (El rango 
de hardware para todos los tipos de 
módulos es ±30 mA)

2: Thermocouple (Termopar)No válido para los módulos 
AI3. El tipo de termopar se selecciona 
en «Lin Type» (Tipo de Lin) como se 
muestra a continuación.

Entrada analógica (mV) Salida analógica (ajustada)

Entrada digital Salida de relé
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3: mV. No válido para los módulos AI3. El 
rango de entrada requerido se especi-
fica, en mV, mediante los parámetros 
«Input Low» (Entrada baja) e «Input 
High» (Entrada alta).
El rango de hardware para los tipos de 
módulos AI2 y AI4 es ±150 mV)

4: HiZmV (Entradas de milivoltios de alta impe-
dancia - solo el canal 2 de los módulos 
AI2).
El rango de entrada requerido se es-
pecifica, en mV, mediante los pará-
metros «Input Low» (Entrada baja) e 
«Input High» (Entrada alta). El rango 
de hardware es ±1800 mV.

5: V  Solo módulos AI2. El rango de entra-
da requerido se especifica, en voltios, 
mediante los parámetros «Input Low» 
(Entrada baja) e «Input High» (Entra-
da alta). El rango de hardware es ±10 
V).

6: RTD 2 Wire (RTD de 2 hilos)No válido para los módu-
los AI3. El tipo de RTD se selecciona 
en «Lin Type» (Tipo de Lin) como se 
muestra a continuación.

7: RTD 3 Wire (RTD de 2 hilos)No válido para los módu-
los AI3. El tipo de RTD se selecciona 
en «Lin Type» (Tipo de Lin) como se 
muestra a continuación.

8: RTD 4 Wire (RTD de 4 hilos)No válido para los módu-
los AI3 o AI8. El tipo de RTD se selec-
ciona en «Lin Type» (Tipo de Lin) 
como se muestra a continuación.

9: Ohmios Solo módulos AI2. El rango de entra-
da requerido se especifica, en oh-
mios, mediante los parámetros «Input 
Low» (Entrada baja) e «Input High» 
(Entrada alta). Hay dos rangos de 
hardware disponibles (de 0 a 464 Ω y 
de 0 a 7000 Ω), el rango apropiado se 
selecciona automáticamente.

10: Potentiometer (Potenciómetro)Solo módulos AI2
11: Test Solo módulos AI2. La forma de onda 

de prueba requerida se selecciona en 
«Test Signal» (Señal de prueba), a 
continuación.

AO Type (Tipo de AO)0: Tipo de salida de tensión que permite un rango de sa-
lida de 0 a 10 V
1: Tipo de salida de intensidad que permite un rango de 
salida de 0 a 20 mA

PV out (Salida de PV)Valor de solo lectura. Muestra el valor actual del punto de 
E/S.

PV Out Status (Estado de salida PV)Estado de la salida PV
0: Bueno. La variable del proceso es correcta.
1: Off (Desactivado)El canal está configurado para estar 

desactivado.
2: Over range (Superior al rango)La señal de entrada es 

mayor que el límite superior del rango 
de hardware seleccionado.
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3: Under range (Inferior al rango)La señal de entrada es 
mayor que el límite superior del rango 
de hardware seleccionado.

4: Hardware error (Error de hardware)Fallo del hardware 
de entrada.

5: Ranging (Rango)Se está configurando el rango del 
hardware de entrada según lo exigido 
por la configuración del rango.

6: Overflow (Desbordamiento)Desbordamiento de varia-
ble del proceso, posiblemente debido 
a que el cálculo ha intentado dividir un 
número grande por un número muy 
pequeño.

7: Bad (Malo) La variable de proceso no es correcta 
y no debe usarse.

8: Hardware exceeded (Hardware excedido)
Se han excedido las capacidades del 
hardware en el momento de la confi-
guración, por ejemplo la configuración 
se ha ajustado en de 0 a 40 V cuando 
el hardware de entrada es capaz de 
un máximo de 10 V.

9: No data (Sin datos)Muestreos de entrada insuficientes 
para realizar el cálculo

PV In (Entrada PV) Valor de proceso utilizado para manejar una salida.
PV In Status (Estado de la entrada PV)Estado de la señal que facilita PV In. 

Para el «PV Out Status» (Estado de la salida PV) se utili-
zan los mismos valores mostrados anteriormente.

IP Adjust State (Estado de ajuste de entrada)Solo aparece si se ha ajustado 
esta entrada. 1 = ajustado. Para más información, consul-
te el procedimiento de «Adjust Input» (Ajuste de entrada) 
descrito en la página 61.

OP Adjust state (Estado de ajuste de salida)Solo aparece si se ha ajustado 
esta salida. 1 = ajustado. Para más información, consulte 
el procedimiento de «Adjust Input» (Ajuste de entrada) 
descrito en la página 64.

Resolution (Resolución)Especifica la resolución (el número de posiciones deci-
males). Esto determina la resolución de la variable del pro-
ceso (salida) cuando se lee desde la región de 
comunicaciones de entero con factor de escala. Además, 
especifica el número máximo de posiciones decimales 
que se mostrarán.

Test signal (Señal de prueba)Para usar cuando «Test» se selecciona como «AI 
Type» (Tipo AI). Permite seleccionar una forma de onda 
sinusoidal o triangular con ciclos que pueden variar entre 
40 segundos y 5 horas del siguiente modo:
0: Triángulo 5 horas1: Triángulo 40 minutos
2: Triángulo 4 minutos3: Triángulo 40 segundos4:
4: Sinusoidal 5 horas5: Sinusoidal 40 minutos
6: Sinusoidal 4 minutos7: Sinusoidal 40 segundos

Input Low* (Entrada baja)Para tipos de entrada distintos de T/C, RTD o Test, el 
valor mínimo de la señal aplicada en unidades eléctricas.

Input High* (Entrada alta)Igual que «Input Low» (Entrada baja), pero para el va-
lor más alto de la señal aplicada en unidades eléctricas.

Lin Type (Tipo de Lin)Cuando las entradas en mV, V o mA están configuradas 
con linealización de termopar, el rango de entrada se asig-
na directamente a la tabla de linealización. Por ejemplo si 
se configura de forma que de 0 a 20 mA representa de 0 
a 1000 °C o de 0 a 1000 °F o de 10 a 1000K, 0mA repre-
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senta 0 °C, 0 °F o 10 K respectivamente y 20 mA repre-
senta 1000 °C, 1000 °F o 1000 K respectivamente.

Consulte "Anexo A: Especificaciones" si desea más infor-
mación sobre los rangos de entrada, precisiones, etc. de 
los tipos indicados de termopares y RTD. Consulte "LIN de 
usuario" en la página 135 para más detalles sobre las li-
nealizaciones de usuario.

Range Low* (Rango bajo)Solo para termopares, RTD, linealizaciones de usua-
rio y señales retransmitidas. Indica el valor más bajo del 
rango de linealización.

Range High* (Rango alto)Solo para termopares, RTD, linealizaciones de usua-
rio y señales retransmitidas. Indica el valor más alto del 
rango de linealización.

Range Units (Unidades de rango)Para termopares y RTD. 0 = °C; 1 = °F; 2 = K.
Output Low (Salida baja)El valor inferior esperado para la salida analógica.
Output High (Salida alta)El valor superior esperado para la salida analógica.
Scale Low/High (Escala baja/alta)Acota el valor de proceso entre «Scale High» 

(Escala alta) - «Scale Low» (Escala baja). Por ejemplo, 
una entrada de entre 4 y 20 mA se puede acotar entre el 
0 y el 100% configurando "Scale Low" como 0 y "Scale Hi-
gh" como 100.
Para salidas analógicas, se utiliza  «Scale High» (Escala 
alta) y «Scale Low» (Escala baja) para acotar el valor 
«PVIn» (Entrada PV) al valor «Output Low/High» (Salida 
baja/alta) para obtener el valor de salida física necesario. 
Por ejemplo, con un canal de salida configurado como 
«Output Low/High» (Salida baja/alta) de 0 a 10 V y Scale 
Low/High (Escala baja/alta) de 0 a 100, un valor «PVIn» 
(Entrada PV) de 50 produciría un valor de salida de 5V.

Units (Unidades) Permite especificar una cadena de unidades de hasta cin-
co caracteres.

Offset (Compensación)Permite sumar o restar un valor fijo a la variable de pro-
ceso.

CJ Type (Tipo CJ) Para usar solo con tipos de entrada de termopar, permite 
al usuario seleccionar «None» (Ninguno), «Internal» (In-
terno), «External» (Externo) o «Remote» (Remota).
0: None (Ninguno)No se aplica ninguna compensación de 

unión fría (CJC).
1: «Internal» (Interna) utiliza la medida de la temperatura 

de la unión fría interna del dispositivo.
2: «External» (Externo)Indica que el usuario tienen que 

mantener la unión fría a una temperatura 
fija conocida. Esta temperatura se intro-
duce en el campo «External CJ Temp» 
(Temperatura de la unión fría externa), 
véase a continuación.

).
0: Tipo B 9: Tipo R 18: Usuario 2 27: Ni120
1: Tipo C 10: Tipo S 19: Usuario 3 28: Cu53
2: Tipo D 11: Tipo T 20: Usuario 4 29: Lineal
3: Tipo E 12: Tipo U 21: Cu10 30: Sqrt
4: Tipo G2 13: NiMoNiCo 22: Pt100 31: x 3/2
5: Tipo J 14: Platinel 23: Pt100a 32: x 5/2
6: Tipo K 15: NiNiMo 24: JPT100
7: Tipo L 16: Pt20RhPt40Rh 25: PT1000
8: Tipo N 17: Usuario 1 26: Ni100
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3: Remote (Remoto) Significa que la temperatura de 
unión fría está siendo medida por otro ca-
nal de entrada que debe estar conectado 
con el parámetro «Remote CJ Temp» 
(Temperatura de la unión fría remota) en 
el editor gráfico de conexiones, véase a 
continuación.

Ext. «CJ Temp» (Temperatura de la unión fría)Solo aparece si el tipo de CJC 
está configurado como «External» (Externa). Permite al 
usuario especificar la temperatura a la que se mantiene la 
unión fría externa.

Remote CJ Temp (Temperatura de la unión fría remota)Conectado (en el edi-
tor gráfico de conexiones) al canal de entrada utilizado 
para medir la temperatura de la unión fría remota.

Input filter (Filtro de entrada)Puede utili-
zarse filtrado para 
filtrar el ruido en se-
ñales que varían 
lentamente, de ma-
nera que su evolu-
ción se pueda 
apreciar con mayor 
claridad. El valor in-
troducido (entre 0 y 60 segundos) es la constante de tiem-
po de filtro aplicada a la medida de entrada. El PV alcanza 
el 95 % de un cambio de paso de entrada en 3 veces la 
constante del tiempo de filtro.

Nota: El uso de un filtro en un canal de entrada puede afectar al funcionamiento de 
las alarmas de velocidad de cambio que estén configuradas para ese canal.

Sensor Break Response (Respuesta de desconexión del sensor)
0: Ninguno. Desactiva la detección de desconexión del 
sensor.
1: Drive Low (Reducir):El valor se reduce si se detecta la 

desconexión del sensor
2: Drive High (Aumentar):El valor se reduce si se detecta 

la desconexión del sensor
Fallback PV (PV de fallback)El valor que emite un canal de salida si su estado 

PVIn es distinto de «Good» (Bueno).
Measured Value (Valor medido)    El valor del canal de entrada (solo lectura) 

antes de aplicar una escala, linealización o ajuste.
Internal CJ temp (Temperatura de unión fría interna)La temperatura (solo lec-

tura) de la unión fría interna correspondiente al canal.
Invert (Invertir) Para relés y entradas digitales, permite invertir la entrada 

o salida.
Output (Salida) Estado de la salida manejada.
Open String (Cadena abierta)El texto que se asociará con el estado abierto de 

una entrada digital.

3x 
Input Filter

Entrada

Respuesta del 
dispositivo

.
0: 0,125 segundos 5: 5 segundos 10: 2 minutos 15: 1 hora
1: 0,25 segundos 6: 10 segundos 11: 5 minutos 16: 2 horas
2: 0,5 segundos 7: 20 segundos 12: 10 minutos 17: 6 horas
3: 1 segundos 8: 30 segundos 13: 20 minutos 18: 12 horas
4: 2 segundos 9: 1 minuto 14: 30 minutos 19: 24 horas
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Closed String (Cadena cerrada)El texto que se asociará con el estado cerrado 
de una entrada digital.

Configuración de tendencia
Este área de configuración permite definir el color y el intervalo del canal.

Figura 87 Menú de configuración de «Trend» (Tendencia)
Colour A (B) (Color A [B])Permite 

especificar 
dos colores 
alternativos 
(A y B) para el 
canal. Figura 
88 da una re-
presentación 
aproximada.

Select Colour B (Seleccionar color 
B)Al ajustarlo 
en «Yes» (Sí) 
(1) se selecciona el color B, en caso contrario (0) se utiliza 
el color (A) predeterminado.

Span LowA/HighA (Intervalo bajoA/altoA)Ajusta los valores inferior y superior 
del intervalo «A».

Zone LowA/HighA (Zona bajaA/altoA)Ajusta los valores inferior y superior de la 
zona «A» en %, para definir el área del gráfico que se ocu-
pará.

Span LowB/HighB (Intervalo bajoB/altoB)Ajusta los valores inferior y superior 
del intervalo «B».

Zone LowB/HighB (Zona bajaB/altoB)Ajusta los valores inferior y superior de la 
zona «B» en %, para definir el área del gráfico que se ocu-
pará.

Select SpanZone B (Seleccionar IntervaloZona B)Al ajustarlo en «Yes» (Sí) (1) 
se selecciona el intervalo B y la zona B, en caso contrario 
(0), se usan los valores predeterminados (A).

Scale Type (Tipo de escala)0 = Sin escala; 1 = Escala lineal; 2 = Escala logarít-
mica.

Major Divisions (Divisiones principales)   Para el tipo de escala «Linear» (Li-
neal), permite al usuario seleccionar el número de divisio-
nes de la escala, así como el número de líneas en 
pantalla. Si el valor es 1, sólo se mostrarán el cero y el 
máximo de la escala. Si el valor es 10 (el máximo), se 
mostrarán el cero, el máximo de la escala y nueve valores 
intermedios, con las líneas correspondientes.

Figura 88 Muestras de color de 
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Minor Divisions (Divisiones secundarias)    Para el tipo de escala «Linear» (Li-
neal), permite al usuario seleccionar el número de divisio-
nes en que se dividen las divisiones mayores.

Grid decades (Décadas de cuadrícula)Para las escalas logarítmicas (véase 
«Grid Type» [Tipo de cuadrícula]), permite al usuario se-
leccionar el número de décadas que se incluirán en la cua-
drícula.

Ejemplo de intervalo
En un rango de entrada que va de 0 a 600° C, el rango de temperatura más 
interesante está entre 500 y 600° C. En tal caso, se puede definir "Span Low" como 
500 y "Span High" como 600 para que el registrador represente únicamente esa 
parte del rango de temperatura, lo que equivale a aumentar la zona de interés.

Nota: La representación se limita al rango de PV ("Span High" - "Span Low"), pero 
el dispositivo puede mostrar valores fuera de ese rango.

Menú de Alarma 1
Este área de configuración permite definir las características de la alarma 1.

Figura 89 Ejemplo de menú de configuración de alarma 1 (tipo = superior absoluto)
Type (Tipo) Seleccione un tipo de alarma en la lista siguiente: Estas 

alarmas se describirán a continuación en «Alarm types» 
(Tipos de alarmas).

Status (Estado) Solo lectura.
0: Desactivado. El valor monitorizado está en la región segura y no es ne-

cesario confirmar la alarma. La alarma indica «Off» (Apa-
gada) cuando está deshabilitada.

1: Active (Activa) El valor monitorizado está en la región activa pero se ha 
confirmado la alarma (si procede).

2: SafeNack El valor monitorizado está ahora en la región segura pero 
no se ha confirmado la alarma.

.
0: Off 6: Rise ROC (Aumento de la tasa de 

cambio [variación creciente])
1: Abs.High (Alto absoluto) 7: Fall ROC (Reducción de la tasa de 

cambio [variación decreciente])
2: Abs. Low (Bajo absoluto) 10: Off (Alarmas digitales 

desactivadas)
3: Dev. High  (Desviación alta) 11: Digital alta
4: Dev. Low (Desviación baja) 12: Digital baja
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3: ActiveNack El valor monitorizado está en la región activa y no se ha 
confirmado la alarma.

Threshold (Umbral) Solo aparece para alarmas absolutas e indica el punto de 
disparo de la alarma.
En el caso de alarmas absolutas altas, la alarma se activa 
si el valor de proceso del punto supera el valor del umbral 
y se mantiene activa hasta que el PV cae por debajo del 
valor («Threshold» [Umbral] - «Hysteresis» [Histéresis]). 
En el caso de alarmas absolutas bajas, la alarma se activa 
si PV es inferior al valor del umbral y se mantiene activa 
hasta que PV aumenta por encima del valor ("Threshold" 
+ "Hysteresis").

Reference (Referencia)Solo aparece para alarmas de desviación e indica el 
«punto central» de la banda de desviación.
En el caso de alarmas de «desviación alta», la alarma se 
activa si la variable de proceso (PV) aumenta por encima 
del valor («Reference» (Referencia) + «Deviation» [Des-
viación]) y se mantiene activa hasta que PV cae por deba-
jo del valor («Reference» [Referencia] + «Deviation» 
[Desviación] - «Hysteresis» [Histeresis]).
En el caso de alarmas de desviación baja, la alarma se ac-
tiva si la variable de proceso (PV) cae por debajo del valor 
(Referencia - Desviación) y se mantiene activa hasta que 
PV aumenta por encima del valor (Referencia - Desviación 
+ Histeresis).
En el caso de alarmas de «banda de desviación», la alar-
ma se activa si la variable de proceso (PV) está fuera del 
intervalo (Referencia ± Desviación) y se mantiene activa 
hasta que PV vuelve a estar dentro de la banda, sumando 
o restando el valor «Hysteresis» (Histeresis) si es necesa-
rio.

Deviation (Desviación)Solo aparece para alarmas de desviación e indica la an-
chura de la banda de desviación a ambos lados del valor 
«Reference» (Referencia), tal y como se describe antes.

Amount (Cantidad) Solo para alarmas de velocidad de cambio. La alarma se 
activa si el valor de proceso aumenta («Rise ROC») o dis-
minuye («Fall ROC») más de el valor «Amount» (Canti-
dad) especificado durante el tiempo definido en «Change 
Time» (Cambiar tiempo). La alarma se mantiene activa 
hasta que la velocidad de cambio cae por debajo del valor 
("Amount"/"Change Time").

«Change Time» (Cambio de tiempo)Se puede configurar como 1 segundo, 1 
minuto o 1 hora. Consulte «Amount» (Cantidad) (arriba).

Average Time (Tiempo medio)Solo para alarmas de velocidad de cambio. Per-
mite especificar un tiempo de promedio (para el valor de 
proceso) con el fin de reducir las activaciones accidentales 
debidas a ruido en la señal o a que la velocidad de cambio 
está próxima al valor de activación.

Hysteresis (Histéresis)    Solo aparece para alarmas absolutas y de desviación. 
Permite evitar disparos múltiples de alarmas cuando el va-
lor de proceso está próximo al valor de activación.

Latch (Bloqueo) 0: Ninguno. La alarma se mantiene activa hasta que el 
valor controlado vuelve a un estado nor-
mal.

1: Auto. La alarma se mantiene activa hasta que el 
valor controlado vuelve a un estado nor-
mal y se reconoce la alarma.
La alarma se puede reconocer antes o 
después de que el valor vuelva a un esta-
do normal.
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2: Manual. La alarma se mantiene activa hasta que el 
valor controlado vuelve a un estado nor-
mal y se reconoce la alarma.

La alarma solo se puede reconocer después de que el va-
lor vuelva a un estado normal.

3: Trigger (Disparo)Este modo sólo se usa para iniciar una 
acción definida mediante conexiones del 
usuario en iTools o la interfaz de usuario.

Block (Bloque) 0 = Desactivado; 1 = Activado. Las alarmas con «Block» 
(Bloque) configurado como «On» (Activado) no funcionan 
hasta que el valor controlado alcanza un estado "seguro" 
después del encendido. De esta forma se evita que las 
alarmas se activen antes de empezar a controlar el proce-
so. Si una alarma con retención no está reconocida, se re-
cuperará (desbloqueará) salvo que se cambie el valor de 
umbral o referencia de la alarma, en cuyo caso se volverá 
a bloquear.

Dwell (Retardo) Inicia un retardo en segundos entre la causa y la activa-
ción de la alarma. Si la causa de activación vuelve a un es-
tado normal antes de que finalice el tiempo de pausa, la 
alarma no se activa y el temporizador de pausa se pone a 
cero.
Acknowledge (Reconocer)Seleccione «Yes» (Sí) para re-
conocer la alarma. La pantalla volverá a «No».

Active (Activo) Solo lectura. Indica «Yes» como estado de la alamra si la 
alarma está activa y «No» si está inactiva. El estado de 
alarma activa/inactiva depende del tipo de retención y del 
estado de reconocimiento de la alarma. Siempre muestra 
«No» si la alarma está deshabilitada (abajo).

«Inactive» (Inactivo) Igual que «Active» (Activo), pero indica «Yes» (Sí) si la 
alarma está inactiva y «No» si está activa. La alarma indi-
ca «Yes» (Sí) cuando está deshabilitada (abajo).

N.acknowledged Igual que «Active» (Activo), pero indica «Yes» (Sí) si la 
alarma no está reconocida y «No» si está reconocida. 
Siempre muestra «No» si la alarma está deshabilitada 
(abajo).

Acknowledgement (Reconocimiento)Indica brevemente «Yes» (Sí) cuando se 
reconoce una alarma y luego vuelve a indicar «No».

Inhibit (Deshabilitar) 0 = Desactivado; 1 = Activado. Cuando «Inhibit» (Desha-
bilitar) está activado,  la alarma se deshabilita. El estado 
se establece en «Off» (Desactivado); «Active» (Activo) y 
«N.acknowledged» (No reconocido) se establecen en 
«No», y «Inactive» (Inactivo) se establece en «Yes» (Sí). 
Si la alarma está activa cuando inhibir está habilitado, se 
desactiva hasta que inhibir se deshabilita, cuando su esta-
do depende de su configuración. De igual forma, si el dis-
parador de la alarma está activo cuando la alarma está 
deshabilitada, la alarma sigue desactivada hasta que inhi-
bir se deshabilita, cuando su estado depende de su confi-
guración.

Menú de Alarma 2
Igual que el menú Alarm 1.

Tipos de Alarma
Las siguientes figuras explican gráficamente el significado de los parámetros de 
alarma que se pueden configurar para los distintos tipos de alarmas.
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Alarmas absolutas

Figura 90 Parámetros de alarmas absolutas

Alarmas de desviación

Figura 91 Parámetros de la alarma de desviación

<D

Definiciones de alarmas 
absolutas altas
Umbral

Histéresis

Definiciones de alarmas 
absolutas bajas

Señal de entrada

Histéresis: 0
Retardo: 0

Histéresis: 0
Retardo: D

Histéresis: sí
Retardo: 0

Histéresis: sí
Retardo: D

= Alarma activa

Señal de entrada
Histéresis

Umbral

Histéresis: 0
Retardo: 0

Histéresis: 0
Retardo: D

Histéresis: sí
Retardo: 0

Histéresis: sí
Retardo: D

= Alarma activa

<D

Referencia
Desviación

Desviación

Histéresis
Señal de entrada

Histéresis
Desviación

Referencia

Señal de entrada

= Alarma activa = Alarma activa

Histéresis: 0
Retardo: 0

Histéresis: 0
Retardo: D

Histéresis: sí
Retardo: 0

Histéresis: sí
Retardo: D

Histéresis: 0
Retardo: 0

Histéresis: 0
Retardo: D

Histéresis: sí
Retardo: 0

Histéresis: sí
Retardo: D

Definiciones de alarmas 
de desviación baja

Definiciones de alarmas 
de desviación alta

Histéresis

Referencia
Desviación
Histéresis

Señal de entrada
Histéresis: 0

Retardo: 0
Histéresis: 0

Retardo: D

Histéresis: sí
Retardo: 0

Histéresis: sí
Retardo: D

= Alarma activa

Definiciones de alarmas 
de banda de desviación
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Alarmas de velocidad de cambio

Figura 91 Figura 92 Parámetros de alarmas de velocidad de cambio
Nota: El funcionamiento de las alarmas de velocidad de cambio puede variar si se 
aplica un filtro («IO Main» [E/S principal] en la página 79) a la señal de entrada.

Ejemplo de configuración de canal
Un termopar de tipo J se utiliza para medir un rango de temperatura que va de 100 a 
200 °C. La salida de este termopar se transmite al registrador con un transmisor de 4 
a 20 mA y se muestra como un valor entre 0 y 100%.

Defina la siguiente configuración para el canal correspondiente en Channel.Main:

Type (Tipo) = mA

Units (Unidades) = %

Input Low (Entrada baja) = 4.00

Input High (Entrada alta) = 20.00

Shunt (Derivación) = 5 ohmios (valor fijo - no editable)

Lin Type (Tipo de Lin) = Tipo J

Range Low (Rango bajo) = 100.00

Range High (Rango alto) = 200.00

Range Units (Unidades de rango)= °C

Scale Low (Escala baja) = 0

Scale High (Escala alta) = 100

Para los demás parámetros se pueden usar los valores predeterminados

Definiciones de alarmas de velocidad de cambio

Variación creciente

Unidades de «Change Time» (Cambio de tiempo) (segundo, minuto u hora)
Tiempo 
presente

C
an

tid
ad

Variación decreciente

Una alarma de velocidad de cambio está activa si el valor controlado varía más de una «Amount» (Cantidad) 
en menos de 1 «Change Time» (Tiempo de cambio). El tiempo de parada retarda el tiempo de activación de 

la alarma. El promedio elimina los efectos del ruido en la señal.
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Configuración de canal virtual
Esto permite configurar totalizadores, contadores  y canales matemáticos. La 
configuración se divide en las siguientes áreas: «Main» (Principal), «Trend» 
(Tendencia), «Alarm 1» (Alarma 1) y «Alarm 2» (Alarma 2). Las opciones incluidas 
en las áreas «Trend» (Tendencia), «Alarm 1» (Alarma 1) y «Alarm 2» (Alarma 2) son 
idénticas a las opciones equivalentes descritas en "Configuración de E/S 
(Entrada/Salida)" en la página 93.

Figura 92 Configuración de canal virtual (contador; principal)
Descriptor (Descripción)Permite al usuario introducir una descripción (con un 

máximo de 20 caracteres) para el canal matemático.
Type (Tipo) 1 = Canal matemático; 2 = Totalizador; 3 = Contador.

Los totalizadores permiten al usuario mantener un total 
continuo de cualquier canal de entrada o virtual. También 
es posible usar canales matemáticos para totalizar combi-
naciones de canales de entrada, como la suma o la dife-
rencia de dos canales.
Puede introducirse un valor de «rollover» (1.000.000 por 
defecto) y cuando el totalizador supere este valor, se es-
tablece la salida «rollover». Puede usarse para ampliar el 
rango del totalizador realizando una conexión con la entra-
da de activación de un contador.
La ecuación de un totalizador es:

donde:

tott = valor del totalizador de esta muestra

tott-1 = valor del totalizador de la última muestra

mat = valor de proceso de esta muestra

PSF = factor de escala de período (Period Scaling Factor) (Período)

USF= factor de escala de unidades (Units Scalling Factor) (Escala de unidades)

Nota: El tiempo entre muestras es de 125 ms.

tott = tott – 1 + mat 
PSF x USF
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Operation (Operación)Permite al usuario seleccionar la función matemática ne-
cesaria. Consulte «Maths operations» (Operaciones ma-
temáticas), a continuación.

Group (Grupo) Seleccione un número de grupo para usar operaciones re-
lacionadas con grupos.

PV Solo lectura. Indica el valor dinámico de este canal en las 
unidades especificadas en el campo «Units» (Unidades).

Status (Estado) Solo lectura. Indica el estado del canal, que refleja el esta-
do de las entradas.

0: Bueno. La variable del proceso es correcta.

1: Off (Desactivado)El canal está configurado para estar desactivado.

2: Over range (Superior al rango)
La señal de entrada es mayor que el límite superior del 
rango de hardware seleccionado.

3: Under range (Inferior al rango)
La señal de entrada es mayor que el límite superior del 
rango de hardware seleccionado.

4: Hardware error (Error de hardware)
Fallo del hardware de entrada

5: Ranging (Rango)Se está configurando el rango del hardware de entrada 
según lo exigido por la configuración del rango.

6: Overflow (Desbordamiento)Desbordamiento de variable del proceso, 
posiblemente debido a que el cálculo ha intentado dividir un 
número grande por un número relativamente pequeño.

7: Bad (Malo) La variable de proceso no es correcta y no debe usarse.

8: Hardware exceeded (Hardware excedido)
Se han excedido las capacidades del hardware en el 
momento de la configuración, por ejemplo la configuración 
se ha ajustado en de 0 a 40 V cuando el hardware de 
entrada es capaz de un máximo de 10 V.

9: No data (Sin datos)Muestreos de entrada insuficientes para realizar el 
cálculo 

Resolution Esto determina la resolución de la variable del proceso 
cuando se lee desde la región de comunicaciones de en-
tero con factor de escala. También especifica el número 
de posiciones decimales que se mostrarán

«Units» (Unidades) Permite especificar las unidades del canal mediante cade-
nas con un máximo de 5 caracteres.

Units scaler Permite seleccionar un escalador de unidades del totaliza-
dor. Si, por ejemplo, el canal de entrada tiene unidades de 
litros por hora y «Units Scaler» (Escalador de unidades) es 
1, por ejemplo, el valor totalizado se indicará en litros. Si 
«Units Scaler» (Escalador de unidades) es 1000, el valor 
totalizado estará en miles de litros.
Un valor negativo hace que el totalizador se decremente 
en lugar de incrementarse.

«Low Cut Off» (Corte bajo)Se utiliza para limitar el rango operativo de entrada 
del totalizador.
Valor mínimo = -100.000.

«Low Cut Off» (Corte bajo)Se utiliza para limitar el rango operativo de entrada 
del totalizador.
Valor máximo = 100.000.
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Modbus Input (Entrada de Modbus)Para un canal matemático, es el valor de 
entrada que se escribe en un canal matemático mediante 
Modbus cuando el valor de operación del canal matemáti-
co se ajusta en 9 (Modbus Input [Entrada de Modbus]).
El valor se muestra como la variable de proceso (PV) del 
canal matemático. Si se ha configurado un período de 
temporización de inactividad de las comunicaciones (véa-
se «Input Timeout» [Temporización de entrada] en "Mod-
Bus TCP" en la página 86), entonces si esta entrada no 
se escribe dentro del período de inactividad, la salida (PV) 
se establece en -9999.0 (SIN DATOS).

Input1 (Entrada1) El valor actual de la entrada 1. Utiliza la resolución de la 
fuente.

Input 2 (Entrada 2) Igual que «Input 1» (Entrada 1). Solo aparece si se nece-
sitan dos entradas para la operación.

Time Remaining (Tiempo restante)El tiempo que falta para el canal virtual efec-
túe la operación. Por ejemplo, el tiempo que necesita la 
operación de promedio del canal matemático para mues-
trear la entrada antes de realizar el cálculo.

Period (Período) Para las funciones de promediación, esto permite introdu-
cir un período sobre el cual se calcula el valor medio. Las 
posibles opciones son: También se utiliza como escalador 
del período con un totalizador (por segundo, por minuto, 
por hora, etc.)

«Reset» (Reiniciar) Permite al usuario restablecer funciones de retención (co-
mo «Channel Maximum» (Máximo de canal)) o de prome-
dio (como «Channel Average» (Media de canal)). 1 = 
Restablecer 

Preset (Predefinido) Configure en «Yes» (Sí) (1) para que el contador adopte 
un «Preset Value» (Valor predefinido).

Preset Value (Valor predefinido)Permite especificar un valor a partir del cual el 
totalizador comenzará a incrementar o disminuir. La direc-
ción del recuento se define con el signo de la escala de 
unidades: positivo = incremento; negativo = disminución.

Trigger (Activador)   Si está configurado como «Yes» (Sí) (1), el valor actual de 
la entrada se añade al valor del contador.

Rollover Value (Valor de rollover)Cuando el valor del totalizador excede este 
valor configurable, «rollover», como se muestra abajo, se 
ajusta en «Yes» (Sí) para un período de iteración. Esto se 
puede usar para incrementar un contador, conectando el 
parámetro «Rollover» al parámetro «Trigger» (Activador) 
del contador. Los contadores pueden conectarse en cas-
cada de forma similar. Consulte «Cacading counters» 
(Contadores conectados en cascada) a continuación.
Si el valor de «rollover» se excede en más de uno, el resto 
aparece como el nuevo valor de totalizador instantáneo. 
Por ejemplo, si el valor actual del totalizador = 998; el valor 
de «Rollover» = 1000 y el totalizador se incrementa en cin-
co, entonces la salida del Rollover se ajusta en «Yes» (Sí) 
y el nuevo valor del totalizador = tres. La característica fun-
ciona igual de bien para valores negativos.

Disable (Deshabilitar)Permite al usuario suspender temporalmente el funciona-
miento del totalizador.

Cuando se vuelve a activar, la salida conserva el valor anterior a la desactiva-
ción y el totalizador continúa a partir de ese valor.

Rollover Esta salida se ajusta en «Yes» (Sí) durante un período de 
iteración cuando el valor del totalizador excede el valor de 
«rollover» (véase arriba). Puede usarse para ampliar el 
rango del totalizador realizando una conexión con la entra-
da de activación de un contador.
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Contadores conectados en cascada

Operaciones matemáticas
0: Off (Desactivado) Out (Salida) = -9999; status (estado) = «Off»
2: Add (Sumar) Out (Salida) = Input1 (Entrada1) + Input2 (Entrada2)
3: Substract (Restar) Out (Salida) = Input1 (Entrada1) - Input2 (Entrada2)
4: Multiply (Multiplicar) Out (Salida) = Input1 (Entrada1) x Input2 (Entrada2)
5: Divide (Dividir) Out (Salida) = Input1 (Entrada1) Input2 (Entrada2). Si 

«Input2» (Entrada2) = 0, Out (Salida) = -9999; Status (Es-
tado) = «Bad» (Malo).

6: Group Avg (Promedio de grupo)    Out (Salida)= Suma instantánea de todos 
los puntos del grupo (excepto este y cualquier canal en el 
que «Operation» (Operación) esté configurado como 
«Group Average» (Promedio de grupo), «Group Mini-
mum» (Mínimo de grupo), «Group Maximum» (Máximo de 
grupo), «Group Minimum (Latched)» (Grupo mínimo [Ce-
rrado]), «Group Maximum (Latched)» (Gurpo máximo [Ce-
rrado]), «Channel Maximum» (Canal máximo) o «Channel 
Minimum» (Canal mínimo), dividido por el número de pun-
tos del grupo (excepto este).
El cálculo no incluye ningún punto cuyo estado no sea 
«Good» (Bueno).
Si el grupo no contiene ningún canal, Out (Salida) = -9999; 
Status (Estado) = «No data» (Sin datos).

7: Group Mim* (Mínimo de grupo)Out (Salida) = Valor instantáneo del punto del 
grupo de registro (excepto este) que tenga el valor más 
bajo.
El cálculo no incluye ningún punto cuyo estado no sea 
«Good» (Bueno).
Si el grupo no contiene ningún canal, Out (Salida) = -9999; 
Status (Estado) = «No data» (Sin datos).

8: Group Max* (Máximo de grupo) Out (Salida) = Valor instantáneo del punto 
del grupo de registro (excepto este) que tenga el valor más 
alto.
El cálculo no incluye ningún punto cuyo estado no sea 
«Good» (Bueno).
Si el grupo no contiene ningún canal, Out (Salida) = -9999; 
Status (Estado) = «No data» (Sin datos).

9: Modbus Input (Entrada Modbus)Out (Salida) = valor escrito en la entrada Mo-
dbus de este canal.

Totalizador

Entrada 1 Rollover

1 to 106

Contador 1

Disparo Rollover

106 to 1012

Contador 2

Disparo Rollover

1012 to 1018

Contador 3

Disparo Rollover

1012 to 1018

Contador 2

Disparo Rollover

106 to 1012

Contador 1

Disparo Rollover

1 to 106

Uso de los contadores conectados en cascada 
para aumentar el rango del totalizador (todos los 
valores de Rollover se ajustan en 1000000).

Contadores conectados en cascada (todos los 
valores de «rollover» se ajustan en 1000000).

etc.
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Si se supera el tiempo de espera para comunicaciones, 
Out (Salida) = -9999; status (estado) = «No data» (Sin da-
tos).

11: Copy (Copiar) Permite copiar una entrada u otro canal derivado.
20: Grp Min Latch (Retención mínima de grupo) Out (Salida) = Valor mínimo al-

canzado por cualquier punto del grupo de registro (excep-
to este) desde el último reinicio.
El cálculo no incluye ningún punto cuyo estado no sea 
«Good» (Bueno).
Si el grupo no contiene ningún canal, Out (Salida) = -9999; 
Status (Estado) = «No data» (Sin datos).

21: Grp Max Latch (Retención máxima de grupo) Out (Salida)= Valor máximo 
alcanzado por cualquier punto del grupo de registro (ex-
cepto este) desde el último reinicio.
El cálculo no incluye ningún punto cuyo estado no sea 
«Good» (Bueno).
Si el grupo no contiene ningún canal, Out (Salida) = -9999; 
Status (Estado) = «No data» (Sin datos).

34: Channel Max (Máximo de canal) Out (Salida) = Valor máximo alcanzado 
por «Input1» (Entrada 1) desde el último reinicio.
Si el estado de «Input1» (Entrada 1) no es «Good» (Bue-
no), entonces Out (Salida) = -9999 y Status (Estado) de-
pende del estado de «Input 1» (Entrada 1).

35: Channel Min (Canal mínimo)Out (Salida) = Valor mínimo alcanzado por 
«Input 1» (Entrada 1) desde el último reinicio.
Si el estado de «Input1» (Entrada 1) no es «Good» (Bue-
no), entonces Out (Salida) = -9999 y Status (Estado) de-
pende del estado de «Input 1» (Entrada 1).

36: Channel Avg (Media de canal)Out (Salida) = El valor medio de «Input 1» 
(Entrada 1) durante el tiempo especificado en «Period» 
(Período).
Si el estado de «Input1» (Entrada 1) no es «Good» (Bue-
no), entonces Out (Salida) = -9999 y Status (Estado) de-
pende del estado de «Input 1» (Entrada 1).

43: Config Revision (Configurar revisión)Out (Salida) = Valor de la revisión de 
configuración actual.

64: Off (Desactivado)La salida del totalizador se ajusta en -9999.0 con el estado 
de «Channel Off» (Canal desactivado).

65: On (Activado) La salida del canal virtual es el valor totalizado de la salida 
1.

80: Off (Desactivado)La salida del contador se ajusta en -9999.0 con el estado 
de ‘Channel Off’.

81: On (Activado) Proporciona un valor de contador en incremento/reduc-
ción.

Configuración maestro Modbus
La configuración del Modbus maestro se divide en tres áreas: a) configuración de los 
esclavos (principal), b) diagnóstico, y c)  definir la ubicación de los parámetros que 
se leerán (datos).
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Figura 93 Menús de configuración de maestro Modbus de nivel superior

Main

Menú principal de esclavo

Descriptor

En línea

Fallo de comunicaciones

Dirección IP

Unit ID (Identificación unidad)

Dispositivo de búsqueda

Resultado de búsqueda

Perfil

Retries (Reintentos)

Timeout

Tamaño máx. bloque

Prioridad alta

Prioridad media

Prioridad baja

Diagnósticos

(Menú diagnóstico de esclavo)

Real alta

Real media

Real baja

Estado del dispositivo

Ping

Prueba de lazo de retorno

Total

Exitoso

Fallos

Retries (Reintentos)

Timeouts (temporizaciones)

Función no válida

Dirección no válida

Datos no válidos

Fallo de esclavo

Sin ruta de pasarela

Rechazos de maestro

Restablecimiento

Datos

(Configuración de datos de 
Modbus maestro)

Descriptor

PV

Digital

Estado de alarma

Estado de alarma Cham

Juegos

Mode (modo)

Valor

Valor de fallback

Enviar

Estado

Dispositivo esclavo

Lista de parámetros

Número

Dirección Modbus

Código de función

Tipo de datos

Escala

Posición de bit

Prioridad

Límite bajo parámetro

Límite alto parámetro

Límite alto instancia

Unidad maestra 
de Modbus
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Menú principal de esclavo
Permite introducir la dirección IP, la identificación de unidad y otros parámetros de 
comunicación para los esclavos del 1 al 32.

Figura 94 Menú principal Modbus maestro/esclavo 1 (otros esclavos son similares)
Descriptor (Descripción)Una descripción para este dispositivo. Para el uso en 

comunicaciones Modbus, esto no es lo mismo que «Na-
me» (Nombre) que aparece en la configuración de infor-
mación del dispositivo ("Menú Info" en la página 73).

Online (En línea) El dispositivo siempre intenta comunicarse con el disposi-
tivo esclavo cuando está en línea. Cuando no está en lí-
nea, se suspenden todas las comunicaciones con el 
dispositivo esclavo y no se envía ninguna transacción. Po-
ner el esclavo fuera de línea desactiva temporalmente las 
transacciones de datos, no las reconfigura. 0 = Offline (Sin 
conexión); 1 = Online (En línea).

Comms Failure (Fallo de comunicaciones)1 (Yes [Sí]) = Activo. Un objeto de 
datos no ha respondido después de todos los reintentos.

IP Address (Dirección IP)La dirección IP del dispositivo esclavo correspondien-
te. Si la dirección IP se define en 127.0.0.1, se usa Mod-
bus RTU (mediante el tipo D de 9 vías - "Unidad de 
terminal del módulo controlador (IOC)" en la página 17) 
siempre que el puerto serie esté configurado como serie 
maestro.

Unit ID (Identificación de la unidad)La identificación de la unidad o la dirección 
de Modbus que se utilizará en cada transacción de datos 
con el dispositivo esclavo. Los límites son de 1 a 255

Search Device (Dispositivo de búsqueda)Si se ajusta en ‘1’ (Yes [Sí]) el dispo-
sitivo intenta determinar el tipo de dispositivo esclavo en la 
dirección IP configurada. Si tiene éxito, se selecciona el 
perfil para el dispositivo reconocido.

Search Result (Resultado de búsqueda)El estado de la solicitud «Search Devi-
ce» (Dispositivo de búsqueda) seleccionada.
0: Searching (Buscando) Buscando el dispositivo selec-
cionado en la red
1: Available (Disponible) El dispositivo está disponible 
para la comunicación.
2: No disponible. El dispositivo no está disponible para la 
comunicación.

Segundos
0,125
0,25
0,5
1
2
5
10
20
30

Minutos
1
2
5
10
20
30

Horas
1

Selecciones de prioridad disponibles
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3: Unreachable (No accesible) El dispositivo no está acce-
sible en la red
4: Cancelado. El usuario ha cancelado la búsqueda actual

Profile (Perfil) Se mantienen varios perfiles dentro del dispositivo que 
coinciden con una selección de dispositivos conocidos. Si 
el dispositivo es «conocido», se muestra su tipo, número 
de modelo, etc. Si el dispositivo es desconocido, aparece 
en su lugar «3rd Party» (Terceros).

Retries (Reintentos) El número de veces (de 0 a 3) que se vuelve a enviar una 
transacción de datos al dispositivo si no se recibe una res-
puesta dentro del período de tiempo de espera configura-
do (abajo).

Timeout (Tiempo de espera)El tiempo en milisegundos que el maestro espera 
una respuesta de un dispositivo esclavo antes de reinten-
tar

Max Block Size (Tamaño máximo del bloque)El número máximo de registros 
(palabras de 16 bits) que puede que contenga una sola 
transacción de datos.

High Priority (Alta prioridad)La tasa de intervalo entre cada transacción de da-
tos de alta prioridad. Predeterminado = 0,125 segundos.

Medium Priority (Prioridad media)La tasa de intervalo entre cada transacción 
de datos de prioridad media. Predeterminado = 1 segun-
dos.

Low Priority (Prioridad baja)La tasa de intervalo entre cada transacción de da-
tos de prioridad baja. Predeterminado = 2 segundos.

Niveles de prioridad
Se pueden introducir tres niveles de velocidad de actualización para su uso en la 
configuración de datos ("Configuración de datos de Modbus maestro" en la página 
115), para definir la frecuencia con la que se lee o escribe un valor. A fin de 
optimizar el rendimiento, se recomienda seleccionar la tasa más lenta que se ajuste 
a los requisitos. Los intervalos se seleccionan de una lista de desplazamiento, 
consulte Figura 94 más arriba.

Menú diagnóstico de esclavo

Figura 95 Menú de diagnóstico
Nota: Los valores de diagnóstico se restablecen al encenderse.
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Actual high (Alta real)La tasa de alta prioridad que este esclavo está ejecutando 
en realidad.
Esto nunca puede ser más rápido que la tasa de alta prio-
ridad que se configuró para este dispositivo (menú princi-
pal de esclavo, arriba), pero si el maestro está muy 
cargado, la tasa puede ser menor que la especificada.

Actual Medium (Media real)La tasa de prioridad media a la que este esclavo 
está ejecutando. Esto nunca puede ser más rápido que la 
tasa de prioridad media que se configuró para este dispo-
sitivo (menú principal de esclavo, arriba), pero si el maes-
tro está muy cargado, la tasa puede ser inferior a la 
especificada.

Actual Low (Baja real)La tasa real de baja prioridad a la que este esclavo está 
ejectuando. Esto nunca puede ser más rápido que la tasa 
de baja prioridad que se configuró para este dispositivo 
(menú principal de esclavo, arriba), pero si el maestro está 
muy cargado, la tasa puede ser inferior a la especificada.

Device Status (Estado del dispositivo)El estado de la última transacción a este 
dispositivo esclavo.

0: Success (Éxito) La transacción fue realizada correctamente por el disposi-
tivo esclavo.

1: Illegal Function (Función no válida)La solicitud al dispositivo esclavo conte-
nía un código de función no válido.

2: Illegal Address (Dirección no válida)La solicitud al dispositivo esclavo conte-
nía una dirección Modbus no válida. La dirección puede 
ser para un parámetro solo de lectura. Código de excep-
ción (2).

3: Illegal Value (Valor no válido)La solicitud al dispositivo esclavo contenía da-
tos no válidos para el parámetro especificado.

6: Slave busy (Esclavo ocupado)El dispositivo esclavo está ocupado en este 
momento y, por lo tanto, no puede realizar la solicitud

8: Parity error (Error de paridad)La solicitud no estaba en el formato correcto.
9: Bad Sub (Subfunción no válida)El código de subfunción en la solicitud no era 

válido
10: Bad Gateway (Pasarela no válida)No hay una pasarela o ruta válida me-

diante la que enviar la solicitud al dispositivo esclavo es-
pecificado.

11: No Response (Sin respuesta)No hay respuesta del dispositivo esclavo a 
una solicitud determinada

12: Ralentí: Este dato está en reposo actualmente y no se está comu-
nicando con el dispositivo esclavo.

13: Pending (En espera)La solicitud está en espera de ser enviada. Una causa 
común es que el dispositivo esclavo está fuera de línea.

14: Timeout (Tiempo de inactividad)No ha habido respuesta del dispositivo es-
clavo a una solicitud determinada en el tiempo configura-
do.

15: Unknown Host (Host desconocido)No se reconoce el dispositivo esclavo 
utilizado.

16: Connect Fail (Fallo de conexión)Ha fallado la conexión al dispositivo escla-
vo especificado.

17: No Sockets (Sin conectores)No hay conectores libres disponibles para es-
tablecer una conexión con el dispositivo esclavo.

18: Loopback Fail (Fallo de lazo de retorno) Ha fallado la solicitud de lazo de 
retorno al dispositivo esclavo.

19: Login Fail (Fallo de inicio de sesión)Ha fallado el intento de inicio de sesión 
en el dispositivo esclavo.

20: Unknown Error (Error desconocido)Se ha producido un error, cuya causa 
no ha podido determinarse.

22: Write Fail (Fallo de escritura)Ha fallado la solicitud de escritura.
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23: Rechazo de maestro, el maestro rechazó la solicitud antes de enviarla al dis-
positivo esclavo debido a una mala formación de la solici-
tud.

Loopback Test (Prueba de lazo de retorno)Si está configurado como «Yes» 
(Sí), envía una transacción de código de función 8 al es-
clavo y espera una respuesta. La respuesta se añade al 
recuento de diagnóstico en uno de los tipos de respuesta.

Total Se envía un recuento de todas las transacciones de lectu-
ra y escritura (buenas y malas) al esclavo, incluidos los 
reintentos.

Successful (Éxito) El número de transacciones enviadas al dispositivo escla-
vo que no produjeron una respuesta de excepción.

Failures (Fallas) Un recuento de todas las transacciones fallidas enviadas 
al esclavo. Puede ser causado por fallos de Illegal Func-
tion (Función no válida), Illegal Address (Dirección no vá-
lida) etc., como se detalla a continuación.

Retries (Reintentos) El número de transacciones que se han reenviado debido 
a las respuestas de tiempo excedido del dispositivo escla-
vo.

Timeouts (Tiempos de espera)Un recuento de todas las transacciones envia-
das al esclavo para las que no se recibió ninguna respues-
ta dentro del período de tiempo de espera configurado.

Illegal function (Función no válida)El número de las respuestas de excepción 
de función no válida desde el dispositivo esclavo.

Illegal address (Dirección no válida)El número de las respuestas de excepción 
de dirección no válida desde el dispositivo esclavo. Código 
de excepción (2).

Illegal Data (Datos no válidos)Un recuento de todas las transacciones enviadas 
al esclavo que el esclavo reclamó contenían un valor no 
válido. Código de excepción (3).

Slave Failure (Fallo del esclavo)Un recuento de todas las veces que este dispo-
sitivo esclavo ha fallado en la comunicación. Código de 
excepción (4).

No Gateway Path (No hay ruta de entrada)Un recuento de todas las veces que 
no ha sido posible acceder al dispositivo esclavo ya que 
está en otra red que requiere una puerta de entrada para 
el acceso.

Master Rejects (Rechazos del maestro)Un recuento de todas las transacciones 
que el maestro de Modbus se ha negado a enviar al escla-
vo debido a datos de configuración no válidos.

Reset (Reinicio) Una acción de un solo disparo que inmediatamente reini-
cia todas las cuentas de diagnóstico. 0 = No, 1 = Sí

Configuración de datos de Modbus maestro
Esta es la zona de configuración donde se seleccionan los distintos elementos de 
datos para su transmisión a través del enlace de comunicaciones del Modbus 
maestro.
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Figura 96 Configuración de datos de Modbus maestro
Descriptor (Descripción)Hasta 20 caracteres utilizados para describir el objeto 

de datos actual.
PV El valor de proceso que se está leyendo actualmente del 

esclavo seleccionado. Visible solo si el elemento de datos 
no es de tipo alarma.

Digital El estado del valor digital que se lee desde el dispositivo 
esclavo. 0 = Desactivado; 1 = Activado

Alarm status (Estado de alarma)Indica si hay una o más alarmas activas. 0 = 
Ninguna 1 = Al menos una alarma activa

Canal Estado de alarma0: Off (Inactiva) El valor monitorizado está en la región 
segura y no es necesario confirmar la alarma.
1: Active (Activa)El valor monitorizado está en la región 
activa pero se ha confirmado la alarma (si procede).
2: SafeNackEl valor monitorizado está ahora en la región 
segura pero no se ha confirmado la alarma.
3: ActiveNackEl valor monitorizado está en la región activa 
y no se ha confirmado la alarma.

Set (Establecer) Permite al usuario definir un valor digital en activado (1) o 
desactivado (0).

Mode (Modo) Permite al usuario definir un valor automático/manual en 
auto (0) o manual (1).

Value El valor que se enviará al esclavo seleccionado. Este pa-
rámetro solo está disponible con los códigos de función 6 
y 16.

Fall Back Value (Valor de fallback)Si se configura como una petición de escritu-
ra y el parámetro tiene un parámetro distinto de OK, enton-
ces se escribe el valor de fallback. No es posible realizar 
una conexión desde otro parámetro y solo puede configu-
rarse de forma manual.

Envía una acción de un solo disparo que envía los datos del parámetro «Value» 
(Valor) o del parámetro «Fall Back Value» (Valor de fall-
back) (dependiendo del estado de «Value» [Valor]) al es-
clavo seleccionado. Esto se clasifica como una escritura 
acíclica y por lo tanto solo está disponible para los códigos 
de función 6 y 16. El parámetro «Priority» (Prioridad) debe 
ser ajustado en «Acyclic» (Acíclico).
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Status (Estado) El estado de la última transacción con este esclavo
0: Success (Éxito)La transacción fue realizada correcta-
mente por el dispositivo esclavo.
1: Illegal Function (Función no válida)La solicitud al dispo-
sitivo esclavo contenía un código de función no válido.
2: Illegal Address (Dirección no válida)La solicitud al dis-
positivo esclavo contenía una dirección Modbus no válida. 
La dirección puede ser para un parámetro solo de lectura. 
Código de excepción (2).
3: Illegal Value (Valor no válido)La solicitud al dispositivo 
esclavo contenía datos no válidos para el parámetro espe-
cificado.
6: Slave busy (Esclavo ocupado)El dispositivo esclavo 
está ocupado en este momento y, por lo tanto, no puede 
realizar la solicitud
8: Parity error (Error de paridad)La solicitud no estaba en 
el formato correcto.
9: Bad Sub (Subfunción no válida)El código de subfunción 
en la solicitud no era válido
10: Bad Gateway (Pasarela no válida)No hay una pasarela 
o ruta válida mediante la que enviar la solicitud al disposi-
tivo esclavo especificado.
11: No Response (Sin respuesta)No hay respuesta del 
dispositivo esclavo a una solicitud determinada
12: Ralentí: Este dato está en reposo actualmente y no se 
está comunicando con el dispositivo esclavo.
13: Pending (En espera)La solicitud está en espera de ser 
enviada. Una causa común es que el dispositivo esclavo 
está fuera de línea.
14: Timeout (Tiempo de inactividad)No ha habido res-
puesta del dispositivo esclavo a una solicitud determinada 
en el tiempo configurado.
15: Unknown Host (Host desconocido)No se reconoce el 
dispositivo esclavo utilizado.
16: Connect Fail (Fallo de conexión)Ha fallado la conexión 
al dispositivo esclavo especificado.
17: No Sockets (Sin conectores)No hay conectores libres 
disponibles para establecer una conexión con el dispositi-
vo esclavo.
18: Loopback Fail (Fallo de lazo de retorno) Ha fallado la 
solicitud de lazo de retorno al dispositivo esclavo.

19: Login Fail (Fallo de inicio de sesión)Ha fallado el intento de inicio de sesión 
en el dispositivo esclavo.

20: Unknown Error (Error desconocido)Se ha producido un error, cuya causa 
no ha podido determinarse.

22: Write Fail (Fallo de escritura)Ha fallado la solicitud de escritura.
23: Rechazo de maestro, el maestro rechazó la solicitud antes de enviarla al dis-

positivo esclavo debido a una mala formación de la solici-
tud.

Salve Device (Dispositivo esclavo)Una lista de los esclavos disponibles con los 
que se comunicarán estos datos. 0 = dispositivo esclavo 
1; 1 = dispositivo esclavo 2, etc.

Parameter List (Lista de parámetros)Lista de parámetros disponibles para el 
perfil de dispositivos esclavos seleccionado. Estos pará-
metros no requieren ninguna configuración por parte del 
usuario. Consulte "Lista de parámetros" en la página 118.

Number (Número) El canal, lazo o grupo, etc., instancia.
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Modbus Address (Direcciónde Modbus)La dirección del registro Modbus donde 
se grabarán o leerán estos datos. Los límites son de 0 a 
65535

Function Code (Código de función)El código de función a utilizar, determina si 
los datos van a ser leídos o escritos al esclavo selecciona-
do. Los códigos de función soportados son:
1: Leer booleano. Leer bobinas de estado contiguo.
2: Leer discreto. Leer entradas discretas contiguas.
3: Leer retención. Leer registros de retención contiguos.
4: Leer entrada. Leer registros de entrada contiguos.
5: Escribir booleano. Escribir bobina única en act./desact.
6: Escritura única. Escribir en un registro único.
16: Escribir múltiple. Escribir en registros contiguos.

Data Type (Tipo de datos)El tipo de datos que define cómo se van a represen-
tar estos datos. Se admiten los tipos de datos que se indi-
can a continuación.
0: Punto flotante de 32 bits IEEE (REAL)
1: 32 bits largo con signo (DINT)
2: 16 bits entero con signo (INT)
3: Byte de 8 bits con signo (BYTE)
4: 32 bits largo sin signo (UDINT)
5: 16 bits entero sin signo (UINT)
6: Byte de 8 bits sin signo (UBYTE)
8: 32 bits punto flotante IEEE (little Endian, palabra inter-
cambiada) (REAL [Intercambio])
9: 32 bits largo con signo (little Endian, palabra intercam-
biada) (DINT [Intercambio])
10: 32 bits largo sin signo (little Endian, palabra intercam-
biada) (UDINT [Intercambio])
11: Bit desde registro (BIT)
Por defecto, todos los tipos de datos de 16 y 32 bits (a me-
nos que se especifique lo contrario) se transmitirán en for-
mato Big Endian, en el que el byte más significativo del 
valor se envía en primer lugar. Ordenamiento de Byte: (pa-
ra big Endian) (0x12 enviado primero)

16 bits 0x1234 0x12, 0x34
32 bits 0x12345678 0x12, 0x34, 0x56, 0x78
Scaling (Escala) Posiciones decimales para los tipos de datos escalados 

de 16 bit. Visible dependiendo del «Data Type» (Tipo de 
Datos) seleccionado. 0 = sin escala

Bit Position (Posición de los Bits)El bit en el registro a extraer, solo está dispo-
nible si «Data Type» (Tipo de Datos) seleccionado es «BIT 
in Register» (BIT en el Registro).

Priority (Prioridad) La frecuencia con la que se gestionarán estos datos. Con-
sulte "Niveles de prioridad" en la página 113.

0: Alta. Añade el dato a la cola de alta prioridad.
1: Media. Añade el dato a la cola de prioridad media.
2: Baja. Añade el dato a la cola de prioridad baja.
3: Acíclica. No añade el objeto de datos a ninguna cola, la 

petición debe enviarse manualmente.

Lista de parámetros
Facilita una lista de parámetros que el usuario puede decidir leer/escribir sin tener 
que conocer la dirección del Modbus, el tipo de datos, etc.
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0: Loop PV. Lee un valor de proceso desde un lazo en un 
controlador 2500

1: Target SP (Consigna objetiva) Lee un valor de punto de 
consigna objetivo desde un lazo en un controlador 2500

2: Target SP (Consigna objetiva) «Set» (Configurar). Escribe 
un valor de punto de consigna objetivo en un lazo en un 
controlador 2500

3: SP operativo. Lee un valor de punto de consigna operativo 
desde un lazo en un controlador 2500

4: Manual OP (Salida manual). Lee un valor de salida ma-
nual desde un lazo en un controlador 2500

5: Manual OP (Salida manual). «Set» (Configurar). Graba un 
valor de salida manual desde un lazo en un controlador 
2500

6: Working Output (Salida operativa) Lee un valor de salida 
operativo desde un lazo en un controlador 2500

7: Auto/Man  («Set» [Configurar]). Ajusta un lazo en modo 
automático o manual en un controlador 2500

8: Definido por el usuario. El usuario puede especificar todos 
los datos de configuración necesarios para leer cualquier 
parámetro desde el controlador 2500

9: Desactivado. No se intercambiarán datos. Loop PV. Lee 
un valor de proceso desde un lazo en un controlador serie 
2000

13: Target SP (Consigna objetiva) Lee un valor de punto de 
consigna objetivo desde un lazo en un controlador serie 
2000

14: Target SP (Consigna objetiva) («Set» [Configurar]). Escri-
be un valor de punto de consigna objetivo en un lazo en un 
controlador serie 2000

15: SP operativo. Lee un valor de punto de consigna operativo 
desde un lazo en un controlador serie 2000

16: Alarm 1 Status (Estado de alarma 1). Lee el estado de 
alarma 1 desde un lazo en un controlador serie 2000, no 
compatible con los productos 26/2704.

17: Alarm 2 Status (Estado de alarma 1). Lee el estado de 
alarma 2 desde un lazo en un controlador serie 2000, no 
compatible con los productos 26/2704.

18: Alarm 3 Status (Estado de alarma 1). Lee el estado de 
alarma 3 desde un lazo en un controlador serie 2000, no 
compatible con los productos 26/2704.

19: Alarm 4 Status (Estado de alarma 1). Lee el estado de 
alarma 4 desde un lazo en un controlador serie 2000, no 
compatible con los productos 26/2704.

20: Target Output (Salida objetivo) Lee un valor de salida ob-
jetivo desde un lazo en un controlador serie 2000

21: Working Output (Salida operativa) Lee un valor de salida 
operativo desde un lazo en un controlador serie 2000

22: Auto/Man  («Set» [Configurar]). Ajusta un lazo en modo 
automático o manual en un controlador serie 2000

24: Definido por el usuario. El usuario puede especificar todos 
los datos de configuración necesarios para leer cualquier 
parámetro desde un controlador serie 2000

25: Desactivado. No se intercambiarán datos
29: Loop PV. Lee un valor de proceso desde un lazo en un 

controlador 3500
30: Manual OP (Salida manual). Lee un valor de salida ma-

nual desde un lazo en un controlador 3500
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31: Manual OP (Salida manuaL) («Set» [Configurar]). Graba 
un valor de salida manual desde un lazo en un controlador 
3500

32: Active Output (Salida activa). Lee un valor de salida activo 
desde un lazo en un controlador 3500

33: Target SP (Consigna objetiva) Lee un valor de punto de 
consigna objetivo desde un lazo en un controlador 3500

34: Target SP (Consigna objetiva) («Set» [Configurar]). Escri-
be un valor de punto de consigna objetivo en un lazo en un 
controlador 3500

35: SP operativo. Lee un valor de punto de consigna operativo 
desde un lazo en un controlador 3500

36: Alarm Output (Salida de alarma). Lee el valor de salida de 
alarma desde un lazo en un controlador 3500

37: Auto/Man  («Set» [Configurar]). Ajusta un lazo en modo 
automático o manual en un controlador 3500

38: Definido por el usuario. El usuario puede especificar todos 
los datos de configuración necesarios para leer cualquier 
parámetro desde el controlador 3500

39: Desactivado. No se intercambiarán datos
40: Loop PV. Lee un valor de proceso desde un lazo en un 

controlador mini8
41: Manual OP (Salida manual). Lee un valor de salida ma-

nual desde un lazo en un controlador mini8
42: Manual OP (Salida manuaL) («Set» [Configurar]). Graba 

un valor de salida manual desde un lazo en un controlador 
mini8

43: Active Output (Salida activa). Lee un valor de salida activo 
desde un lazo en un controlador mini8

44: Target SP (Consigna objetiva) Lee un valor de punto de 
consigna objetivo desde un lazo en un controlador mini8

45: Target SP (Consigna objetiva) («Set» [Configurar]). Escri-
be un valor de punto de consigna objetivo en un lazo en un 
controlador mini8

46: SP operativo. Lee un valor de punto de consigna operativo 
desde un lazo en un controlador mini8

47: Alarm Output (Salida de alarma). Lee el valor de salida de 
alarma desde un lazo en un controlador mini8

48: Auto/Man  («Set» [Configurar]). Ajusta un lazo en modo 
automático o manual en un controlador mini8

49: Fixed DI1 PV (PV DI1 fijo). Lee el valor de proceso de en-
trada digital 1 desde un controlador mini8

50: Fixed DI2 PV (PV DI1 fijo). Lee el valor de proceso de en-
trada digital 2 desde un controlador mini8

51: Relay A PV (PV de relé A). Lee el valor de proceso del relé 
A desde un controlador mini8

52: Relay B PV (PV de relé B). Lee el valor de proceso del relé 
B desde un controlador mini8

53: Module 1 PV (PV de módulo 1). Lee un valor de proceso 
del módulo desde un controlador mini8

54: Definido por el usuario. El usuario puede especificar todos 
los datos de configuración necesarios para leer cualquier 
parámetro desde el controlador mini8

55: Desactivado. No se intercambiarán datos
61: Canal PV Lee el valor de proceso desde un canal de en-

trada en un registrador 6000
62: Canal PV («Set» [Configurar]). Graba un valor en un canal 

de entrada en un registrador 6000
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63: VChan. (Canal vitual) PV Lee el valor de proceso desde un 
canal matemático en un registrador 6000

64: VChan. (Canal vitual) PV («Set» [Configurar]). Graba un 
valor en un canal matemático en un registrador 6000

65: Canal Alm SP1 (Consigna de alarma 1) Lee el valor de la 
consigna de alarma 1 desde un canal de entrada en un re-
gistrador 6000

66: Canal Alm SP2 (Consigna de alarma 1) Lee el valor de la 
consigna de alarma 2 desde un canal de entrada en un re-
gistrador 6000

67: Math Alm SP1. (Consigna matemática de alarma 1) Lee el 
valor de la consigna de alarma 1 desde un canal matemá-
tico en un registrador 6000

68: Math Alm SP2. (Consigna matemática de alarma 1) Lee el 
valor de la consigna de alarma 2 desde un canal matemá-
tico en un registrador 6000

69: Batch Status (Estado de lote). Lee el estado de lote de un 
grupo desde un registrador 6000

70: Batch Start (Inicio de lote). Inicia un lote en un grupo en un 
registrador 6000

71: Batch Stop (Detención de lote). Detiene un lote en un gru-
po en un registrador 6000

72: Global Alm Ack. (Reconocimiento de alarma global) Reco-
noce el indicador de alarma global en un registrador 6000

73: Definido por el usuario. El usuario puede especificar todos 
los datos de configuración necesarios para leer cualquier 
parámetro desde un registrador 6000

74: Desactivado. No se intercambiarán datos
76: Loop PV. Lee un valor de proceso desde un lazo en un 

controlador/registrador nanodac
77: Manual OP (Salida manual). Lee un valor de salida ma-

nual desde un lazo en un controlador/registrador nanodac
78: Manual OP (Salida manuaL) («Set» [Configurar]). Escribe 

un valor de salida manual en un lazo en un controlador/re-
gistrador nanodac

79: Active Output (Salida activa). Lee un valor de salida activa 
desde un lazo en un controlador/registrador nanodac

80: Target SP (Consigna objetiva) Lee un valor de punto de 
consigna objetivo desde un lazo en un controlador/regis-
trador nanodac

81: Target SP (Consigna objetiva) («Set» [Configurar]). Escri-
be un valor de punto de consigna objetivo en un lazo en un 
controlador/registrador nanodac

82: SP operativo. Lee un valor de punto de consigna operativo 
desde un lazo en un controlador/registrador nanodac

83: Loop Break Almv (Valor de alarma de rotura de lazo) Lee 
el valor de alarma de desconexión del lazo desde un con-
trolador/registrador nanodac

84: Auto/Man  («Set» [Configurar]). Ajusta un lazo en modo 
automático o manual en un controlador/registrador nano-
dac

85: VChannel Input (Valor de canal de entrada). Escribe un 
valor en un canal virtual de entrada Modbus en el contro-
lador/registrador nanodac

86: Channel PV (PV de canal). Lee el valor de proceso de un 
canal de entrada en el controlador/registrador nanodac

87: VChannel PV (PV de canal virtual). Lee el valor de proce-
so de un canal virtual en el controlador/registrador nano-
dac
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88: Chan Alarm 1 (Canal de alarma 1). Lee el valor de un pun-
to de consigna de alarma 1 desde un canal de entrada en 
el controlador/registrador nanodac

89 Chan Alarm 2 (Canal de alarma 2). Lee el valor de un pun-
to de consigna de alarma 2 desde un canal de entrada en 
el controlador/registrador nanodac

90 VChan Alarm 1 (Canal virtual de alarma 1). Lee el valor de 
un punto de consigna de alarma 1 desde un canal virtual 
en el controlador/registrador nanodac

91 VChan Alarm 2 (Canal virtual de alarma 1). Lee el valor de 
un punto de consigna de alarma 2 desde un canal virtual 
en el controlador/registrador nanodac

92 Any Chan Alarm (Cualquier canal de alarma). Lee el esta-
do de las alarmas de cualquier canal desde el controla-
dor/registrador nanodac

93 Any Sys Alarm (Cualquier sistema de alarma). Lee el es-
tado de las alarmas de cualquier sistema desde el contro-
lador/registrador nanodac

94 Any Alarm (Cualquier alarma). Lee el estado de cualquier 
alarma desde el controlador/registrador nanodac

95 Start 121\xB0\x43 (Inicio 121\xB0\x43). Inicia un ciclo de 
esterilizador 121\xB0\x43 en el controlador/registrador

96 Start 134\xB0\x43 (Inicio 121\xB0\x43). Inicia un ciclo de 
esterilizador 134\xB0\x43 en el controlador/registrador

97 Running OP (Salida en funcionamiento). Lee el estado de 
la salida en funcionamiento de un ciclo de esterilizador en 
el controlador/registrador nanodac

98 Passed OP (Salida aprobada). Lee el estado de la salida 
superada de un ciclo de esterilizador en el controlador/re-
gistrador nanodac

99 User Defined (Configurado por el usuario). El usuario pue-
de especificar todos los datos de configuración necesarios 
para leer cualquier parámetro desde el controlador/regis-
trador nanodac

100 Off (Desactivado). No se intercambiarán datos
110 Loop PV (PV de lazo). Lee un valor de proceso desde un 

lazo en un controlador serie 3000
111 Target SP (Consigna objetiva). Lee un valor de punto de 

consigna objetivo desde un lazo en un controlador serie 
3000

112 Target SP (Consigna objetiva) («Set» [Configurar]). Escri-
be un valor de punto de consigna objetivo en un lazo en un 
controlador serie 3000

113 Working SP (Consigna operativa). Lee un valor de punto 
de consigna operativo desde un lazo en un controlador se-
rie 3000

114 Auto/Man («Set» [Configurar]). Ajusta un lazo en modo au-
tomático o manual en un controlador serie 3000

115 Manual OP (Salida manual). Lee un valor de salida ma-
nual desde un lazo en un controlador serie 3000

116 Manual OP (Salida manual) («Set» [Configurar]). Graba 
un valor de salida manual desde un lazo en un controlador 
serie 3000

117 Working Output (Salida operativa). Lee un valor de salida 
operativo desde un lazo en un controlador serie 3000

118 User Defined (Configurado por el usuario). El usuario pue-
de especificar todos los datos de configuración necesarios 
para leer cualquier parámetro desde un controlador serie 
3000
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119 Off (Desactivado). No se intercambiarán datos
127 Control PV (Valor de control). Lee un valor de proceso 

desde una red de control en un EPower
128 Control SP (Valor de control). Lee un valor de punto de 

consigna desde una red de control en un EPower
129 Control SP (Consigna de control) («Set» [Configurar]). Es-

cribe un valor de punto de consigna en una red de control 
en un EPower

130 Voltage (Voltaje). Lee un valor de voltaje desde un módulo 
de alimentación en un EPower

131 Current (Corriente). Lee un valor de corriente desde un 
módulo de alimentación en un EPower

132 Power (Tensión). Lee un valor de potencia desde un mó-
dulo de alimentación en un EPower

133 User Defined (Configurado por el usuario). El usuario pue-
de especificar todos los datos de configuración necesarios 
para leer cualquier parámetro desde un EPower

134 Off (Desactivado). No se intercambiarán datos
145 User Defined (Configurado por el usuario). El usuario pue-

de especificar todos los datos de configuración necesarios 
para leer cualquier parámetro desde un dispositivo de ter-
ceros

146 Off (Desactivado). No se intercambiarán datos

Configuración de Ethernet/IP
El versadac Ethernet/IP puede configurarse como «Server» (Servidor) «IO Client» 
(Cliente E/S) o «Tag Client» (Etiqueta de cliente).

Un servidor versadac Ethernet/IP solo puede comunicarse con un cliente usando las 
tablas de E/S Impicit pero puede aceptar dos conexiones de cliente TCP Explicit.

Nota: Las comunicacines implícitas solo aceptan tipos de datos de 16 bits.

Cuando se configura como cliente E/S, el versadac solo puede comunicarse con un 
servidor Ethernet/IP usando las tablas de E/S Implicit. Mediante iTools, también 
puede comunicarse con un solo servidor Ethernet/IP usando mensajería Explicit al 
mismo tiempo.

Cuando se configura como un cliente Tag, el versadac puede comunicarse con un 
solo PLC usando etiquetas configurando las tablas de etiquetas de entrada y salida. 
Las etiquetas PLC configuradas en las tablas de etiquetas de entrada y salida 
utilizarán los valores de parámetros correspondientes conectados con las tablas de 
E/S Implicit
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Figura 97 Estado EtherNet/IP

Modo = cliente

Modo = servidor

Modo = cliente Tag
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Configuración de menú principal de Ethernet/IP

Figura 98 Menú principal Ethernet/IP (todos los parámetros)
Net Status Code (Código de estado de la red)Estado de la red (solo en el servidor)

0: Offline (Sin conexión). El dispositivo no está comu-
nicándose

1: No hay conexiones CIP activas. El dispositivo está 
en línea pero no tiene conexiones CIP activas esta-
blecidas

2: Online (En línea). El dispositivo está en línea y tiene 
al menos una conexión CIP establecidas

3: Connection timeout (Tiempo de conexión excedi-
do). Se ha excedido el tiempo de al menos una co-
nexión CIP

4: Duplicate IP address (Dirección IP duplicada). Se 
ha detectado una dirección IP duplicada en la red

5: Server is initializing (El servidor está inicializándo-
se). El dispositivo está realizando la inicialización de 
arranque de EtherNet/IP

10: Connection already in use (La conexión ya está en 
uso). La conexión ya está en uso o duplicado de so-
licitud de reenvío abierto

11: Not a supported combination (No es una combina-
ción admitida). No se admite la combinación de cla-
se de transporte y activador

12: Ownership conflict (Conflicto de propiedad). No ha 
sido posible establecer la conexión, ya que otro 
cliente ya tiene la propiedad exclusiva

13: Target connection not found (No se ha encontrado 
la conexión objetivo). No ha sido posible encontrar 
la conexión que se solicita cerrar con una Forward 
Close

14: Invalid network connection parameter (Parámetro 
de conexión de red no válido). El dispositivo servi-
dor no ha reconocido el tipo de conexión, la priori-
dad o el propietario

15: Connection size mismatch (El tamaño de conexión 
no coincide). El tamaño solicitado no coincide con el 
tamaño necesario para una conexión de tamaño fijo 
en el dispositivo servidor
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16: Unsupported RPI (RPI no admitido). El RPI O->T o 
T->O solicitado no es admitido por el dispositivo 
servidor

17: Manager out of connections (Administrador sin co-
nexiones libres). El administrador de conexiones no 
admite más conexiones, se ha alcanzado el límite

18: Vendor or id product code mismatch (No coincide el 
código de identificación o fabricante del producto). 
La información especificada en el segmento lógico 
de la clave electrónica no coincide con la del dispo-
sitivo

19: Invalid produced or consumed application path (Ru-
ta de aplicación consumida o producida no válida). 
La ruta de aplicación consumida o producida espe-
cificada en la ruta de conexión no corresponde con 
una ruta de aplicación válida en el dispositivo servi-
dor

20: Invalid configuration application path (Ruta de apli-
cación de configuración no válida). Una ruta de apli-
cación especificada para los datos de configuración 
no corresponde con una aplicación de configura-
ción o es inconsistente con las rutas de aplicación 
consumidas o producidas

21: Non-listen only connection not opened (Ninguna co-
nexión de solo escucha abierta). Ha fallado la soli-
citud de conexión porque no hay ninguna conexión 
del tipo solo escucha abierta

22: Server object out of connections (Servidor de obje-
tos sin conexiones libres). Se ha excedido el núme-
ro máximo de conexiones que admite esta instancia 
del objeto destino

23: Se ha excedido el tiempo de espera de la conexión 
Se ha excedido el tiempo de espera de la conexión 
actual, el cliente debe establecer una nueva para 
continuar

24: Unconnected request timed out (Se ha excedido el 
tiempo de espera de la solicitud no conectada). El 
error de tiempo de espera excedido de solicitud no 
conectada se produce cuando se excede el tiempo 
de espera del UCMM antes de recibir una respues-
ta. Esto puede suceder para un servicio Unconnec-
ted_Send, Forward_Open, o Forward_Close. Esto 
significa normalmente que el UCMM ha intentado 
enlazar un número de veces determinado usando 
un temporizador de reintento de enlace específico y 
no ha recibido una confirmación ni respuesta. Pue-
de deberse a una congestión en el nodo de destino 
o ser el resultado de que un nodo no está presente 
o activado.

25: Unconnected parameter error (Error de parámetro 
no conectado). Se ha encontrado un parámetro de 
ruta no válido en el mensaje de desconectado

26: No buffer memory available (Sin memoria búfer dis-
ponible). Memoria búfer de conexión insuficiente en 
el dispositivo servidor

27: Network bandwidth not available for data (Ancho de 
banda de red no disponible para datos). Esto suce-
de si algún dispositivo productor no puede asignar 
suficiente ancho de banda para la conexión en su 
enlace. Esto solo sucede para conexiones de priori-
dad programada.
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28: No connection ID filter available (No hay ningún fil-
tro de identificación de conexión disponible). Esto 
significa que hay un dispositivo en la ruta, que con-
tiene un consumidor de enlace para la conexión 
pero no tiene un filtro consumed_connection _id 
disponible.

29: Not configured to send scheduled priority data (No 
configurado para enviar datos de prioridad progra-
mada). Se obtiene este error si se pide a un dispo-
sitivo que realice una conexión de prioridad 
programada pero no es capaz de enviar paquetes 
durante la parte programada del intervalo de tiempo 
de actualización de la red.

30: Scheduled signature mismatch (La firma programa-
da no coincide). La información de programación de 
conexión en el dispositivo de origen no coincide con 
la información de programación de la conexión en la 
red objetivo

31: Scheduled signature validation not possible (No es 
posible validar la firma programada). La información 
de programación de conexión en el dispositivo de 
origen no puede validarse en la red objetivo.

32: Port not available (Puerto no disponible). Un puerto 
especificado en un segmento de puerto no está dis-
ponible o no existe

33: La dirección de enlace especificada en el segmento 
de puerto no es válida

34: Invalid segment in connection path (Segmento no 
válido en la ruta de conexión). No es posible desco-
dificar la ruta de conexión.

35: Forward close service connection path mismatch 
(No coincide la ruta de conexión del servicio 
Forward Close). La ruta de conexión del servicio 
Forward_Close no coincide con la ruta de la cone-
xión que se cierra.

36: Scheduling not specified (Programación no especi-
ficada). El segmento de red de programación no 
está presente o el valor codificado en el segmento 
de red de programación no es válido

37: Link address to self not valid (Dirección de autoen-
lace no válida). En algunas condiciones (depende 
del dispositivo), una dirección de enlace en el seg-
mento de puerto que dirige al mismo dispositivo (au-
toenlace de retorno) no es válida.

38: Secondary resources not available (No hay recur-
sos secundarios disponibles). En un sistema redun-
dante de doble chasis, una solicitud de conexión 
realizada en el sistema primario se duplicará en el 
sistema secundario. Si el sistema secundario no es 
capaz de duplicar la solicitud de conexión, se de-
vuelve este código de estado extendido

39: Redundant connection mismatch (La conexión re-
dundante no coincide). No ha sido posible estable-
cer una conexión de propietario redundante a la 
misma ruta objetivo, una o más rutas no eran váli-
das

40: Unknown error (Error desconocido). El dispositivo 
servidor ha devuelto un error que no forma parte de 
la especificación CIP.

41: Unconfigured connection (Conexión no configura-
da). Se ha solicitado una conexión al dispositivo 
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servidor que no estaba configurada y la solicitud de 
conexión no contiene un segmento de datos para 
configuración.

42: Failed to establish a connection with the server (No 
ha sido posible establecer una conexión con el ser-
vidor). El cliente no ha logrado establecer una cone-
xión con el servidor debido a un problema de la red 
(no del servidor).

43: A fatal error has occurred (Se ha producido un error 
fatal). El EtherNet/IP puede funcionar de forma im-
previsible.

IO Status Code (Código de estado ES)Estado de ES (Solo para clientes (ES)). 
Como el anterior para el código de estado de red.

Tag Status code (Código de estado de etiqueta)Estado de etiqueta (solo clien-
te de etiqueta). (véase la siguiente Tabla 1)

UCMM Unconnected Message Manager. Muestra la dirección IP 
del dispositivo que utiliza esta conexión actualmente

Impllicit I/O (E/S implícitas)Dirección IP del servidor de E/S conectado.
Multicast (Multidifusión) Dirección IP del servidor IO conectado (solo si se selec-

ciona la multidifusión).
Explicit 1 (Explícito 1)Dirección IP del cliente/servidor conectado.
Explicit 2 (Explícito 1)Dirección IP del cliente/servidor conectado.
Mode (Modo) Modos de funcionamiento:

0: Server (Servidor). El dispositivo funciona como un dis-
positivo servidor EtherNet/IP en la red
1: IO Client (Cliente E/S). El dispositivo actúa como un dis-
positivo cliente EtherNet/IP en la red para intercambiar da-
tos E/S Implicit con un dispositivo servidor específico
2: Tag Client (Cliente de etiqueta) El dispositivo actúa 
como un dispositivo cliente EtherNet/IP en la red para 
intercambiar datos tag cíclicos con un dispositivo servidor 
específico

Enable comms (Habilitar comunicaciones)Habilita o deshabilita las comunica-
ciones del cliente con el dispositivo servidor configurado.
0: Habilitado. El cliente intenta establecer una conexión 
automáticamente con el dispositivo servidor configurado.
1: Deshabilitado. El cliente no intenta establecer una cone-
xión automáticamente con el dispositivo servidor configu-
rado.

Server Address (Dirección del servidor)El dispositivo intenta establecer comu-
nicaciones E/S Implicit con el dispositivo servidor.

Input Instance (Instancia de entrada)Número de instancia de clase de entrada 
(solo en modo cliente).

Size (Tamaño) (bytes)El tamaño en bytes de los datos que el cliente espera leer 
de la entrada implícita.

Output Instance (Instancia de salida)Número de instancia de la clase de salida 
(solo en modo cliente).

Output Size (Tamaño de salida)El tamaño de los datos que el cliente espera es-
cribir en el servidor.

Connection Type (Tipo de conexión)Tipo de conexión (solo en modo cliente).
0: Point To Point (De punto a punto). Los datos E/S Implicit 
solo se comunican directamente entre los dispositivos 
cliente y servidor.
1: Multicast (Multidifusión). Todos los datos de salida Im-
plicit del dispositivo se envían a una dirección IP multicast 
predefinida donde una serie de clientes pueden registrar 
su interés. Se admite solo para conexiones de clase de 
transporte CIP 0 y 1.
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Priority (Prioridad) C CIP define 4 niveles de prioridad de mensaje, todos los 
niveles se admiten en los modos cliente y servidor.
0: Baja. No hay recomendaciones CIP en este momento.
1: Alta. Se usa normalmente para datos E/S
2: Scheduled (Programado). Se usa normalmente para 
datos E/S de seguridad
3: Urgent (Urgente). Se usa normalmente para datos de 
control de movimiento CIP.

RPI Velocidad de conexión de E/S. El rango RPI para los mo-
dos servidor y cliente es de 10 milisegundos a 10 segun-
dos, ambos inclusive.

Slot Number (Número de ranura)Número de ranura del PLC (cero indexado) 
cuando se comunica mediante etiquetas. 

Reset Comms (Reiniciar comunicaciones)Aplica todos los cambios en Ether-
Net/IP al mismo tiempo. O puede usarse para restablecer 
las comunicaciones usando la configuración actual.
Tabla 1  Definiciones de códigos de estado de etiqueta

0 Success (Éxito). El servicio ha tenido éxito
1 Connection Failed (La conexión ha fallado). Ha fallado una 

conexión en la ruta
2 Invalid Parameter (Parámetro no válido). Un parámetro re-

lacionado con la petición no era válido
3 Memory Unavailable (Memoria no disponible). No hay re-

cursos disponibles en el servidor para atender la petición
4 Path Segment Error (Error de segmento de ruta). No se ha 

entendido la sintaxis de parte o toda la ruta
5 Path Dest. Error. (Error de destino de ruta) . La ruta hace 

referencia a un objeto, clase o instancia desconocida
6 Partial Transfer (Transferencia parcial). Solo se ha trans-

ferido parte de los datos esperados
7 Connection Lost (Se ha perdido la conexión). Se ha perdi-

do la conexión de mensajería
8 Service Unsupported (No se admite el servicio). Servicio 

no definido para el objeto solicitado
9 Invalid Attribute (Atributo no válido). Atributo de datos no 

válido detectado
10 Attribute Error (Error de atributo). Un atributo en la res-

puesta tenía un estado distinto de cero
11 Already Requested (Ya solicitado). El objeto ya está en el 

modo/estado en solicitud
12 Object Conflict (Conflicto de objeto). El objeto no puede 

realizar el servicio solicitado
13 Already Exists (Ya existe). La instancia u objeto solicitado 

ya existe
14 Attribute Error (Error de atributo). Solicita modificar un atri-

buto no modificable recibido
15 No Privileges (Sin privilegios). Ha fallado la comprobación 

de permisos/privilegios
16 State Conflict (Conflicto de estado). El estado o modo ac-

tual impide la ejecución del servicio solicitado
17 Reply To Large (Respuesta demasiado grande). El búfer 

de respuesta es demasiado pequeño para los datos de 
respuesta

18 Fragmented Value (Valor fragmentado). Por ejemplo, esta 
solicitud de servicio solo devolverá la mitad de un tipo de 
datos REAL

19 Not Enough Data (No hay suficientes datos). El servicio no 
facilita suficientes datos para realizar la petición
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20 Invalid Attribute (Atributo no válido). So se admite el atri-
buto solicitado.

21 Too Much Data (Demasiados datos). El servicio ha sumi-
nistrado más datos de los esperados.

22 Object Non-Exist (El objeto no existe). El objeto especifi-
cado no existe en el dispositivo

23 Seq. (Secuencia) Fragmentación La secuencia de frag-
mentación de este servicio no está activa

24 No Attribute Data (No hay datos de atributo). Los datos de 
atributo para este objeto no se han guardado en el servi-
dor antes de esta petición de servicio

25 Data Store Failure (Error al almacenar datos). Los datos 
de atributo para este objeto no se han guardado debido a 
un error durante el intento

26 Routing Failed (El direccionamiento ha fallado). El paque-
te de petición de servicio era demasiado grande para la 
transmisión en la red en la ruta hasta el destino. El dispo-
sitivo de enrutamiento fue forzado a abortar el servicio

27 Routing Failed (El direccionamiento ha fallado). El paque-
te de petición de servicio era demasiado grande para la 
transmisión en la red en la ruta hasta el destino. El dispo-
sitivo de enrutamiento fue forzado a abortar el servicio

28 Missing Attribute (Falta un atributo). El servicio no propor-
cionó un atributo en una lista de atributos que fuera nece-
sario para realizar el comportamiento solicitado

29 Invalid Attribute (Atributo no válido). El servicio devuelve la 
lista de atributos facilitada con información de estado para 
los atributos no válidos

30 (Embedded Tag Error) Error de tarjeta integrada. Un ser-
vicio integrado ha provocado un error. Lo más común es 
un nombre de etiqueta mal formateado

31 Vendor Error (Error de proveedor). Se ha encontrado un 
error específico del proveedor

32 Invalid Parameter (Parámetro no válido). Un parámetro re-
lacionado con la petición no era válido

33 Write Once Error (Error de escritura única). Se ha produ-
cido un intento de escribir en un parámetro de escritura 
única

34 Invalid Reply (Respuesta no válida). Se ha recibido una 
respuesta no válida

35 Buffer Overflow (Desbordamiento del búfer). El mensaje 
recibido es más grande que el búfer donde se recibe

36 Format Error (Error de formato). No se admite el formato 
del mensaje recibido.

37 Key Path Failure (Fallo de ruta clave). El segmento de cla-
ve en la ruta no coincide con la clave de destino

38 Path Size Error (Error de tamaño de ruta). El tamaño de 
ruta en la petición es demasiado grande

39 Unexpected Attribute (Atributo inesperado). Imposible de-
finir el atributo en este momento

40 Invalid Member ID (ID de miembro no válida). La ID de 
miembro solicitada no coincide con el objeto clase

41 Member Is R/O (El miembro es solo lectura). Se ha recibi-
do una solicitud para modificar un miembro solo lectura

42 Group 2 Server (Servidor grupo 2). Respuesta del servidor 
DeviceNet grupo 2

43 Translation Error (Error de traducción). Una solicitud de 
traducción Modbus CIP ha fallado
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44 Attribute Is R/O (El atributo es solo lectura). Se ha recibido 
una solicitud para leer un atributo solo lectura

64 No Tags Found (No se han encontrado etiquetas). No hay 
etiquetas configuradas en las tablas de entrada o salida

65 Invalid Config. (Configuración no válida). La longitud total 
en caracteres de todas las etiquetas de esta tabla hará 
que el PLC exceda su buffer interno de 500 bytes. Para eli-
minar este problema, reducir la longitud de algunos o to-
dos los nombres de las etiquetas

Entradas implícitas
Permite hacer clic en los nombres de parámetros y arrastrarlos a la tabla para 
proporcionar destinos para los datos entrantes.

Figura 99 Entradas implícitas

Salidas implícitas

Figura 100 Menú de salida implícita
Output1 (Salida1) Es posible hacer clic en los nombres de parámetro y arras-

trarlos a esta tabla para funcionar como fuentes para en-
viar datos al dispositivo EtherNet/IP. Se aplicará 
automáticamente cualquier formato de resolución necesa-
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rio usando la configuración de este parámetro conectado 
antes de enviarlo.

Output Value1 (Valor de salida1)Son datos Implicitos que se envían al disposi-
tivo EtherNet/IP. El valor se muestra aquí en formato ‘en 
bruto’ y se actualiza solo cuando Output 1 tiene un pará-
metro conectado válido.

Outputs 2 to 50 (Salidas de 2 a 50)Igual que para Salida1
Output Values 2 to 50 (Valores de salida de 2 a 50)

Igual que para «OutputValue1» (Valor de salida 1)

Entradas y salidas explícitas
Cuando se configura como servidor, versadac Ethernet/IP admite dos conexiones 
«Explicit TCP» (TCP explícitas) simultáneas con su objeto de aplicación explícito, 
que tiene la ID de clase = A2 (162 decimal). La ID de instancia es la dirección 
Modbus del parámetro y el atributo es siempre = 1. Se admiten códigos de servicio 
Explicit hex10 (decimal 16) y 0E (14) para lectura y escritura de atributos únicos, 
respectivamente

Figura 101 Especificaciones explícitas de los datos
Cuando se configura como cliente, hay dos conexiones de mensajería Explicit 
separadas disponibles, pero la interfaz de iTools solo permite un mensaje de lectura 
o escritura Explicit a un dispositivo servidor en un momento determinado.

La ID de instancia y el tipo de datos se obtienen de los datos del fabricante del 
servidor. Una vez introducida toda la información, se solicita la lectura ajustando 
«Send» (Enviar) en «Yes» (Sí). El campo de datos contiene la respuesta.

Figura 102 Menú de mensajes explícitos
Destination Addr (Dirección de destino)La dirección a la que se enviará el men-

saje. Service Code (Código de servicio)El código de ser-
vicio informa al servidor de la acción que se realizará.
0: Get Attribute (Obtener atributo). Obtiene un solo valor 
de atributo de un objeto clase.

Código de servicio ID de clase ID de 
instancia Atributo

Hex Dec Hex Dec Decimal

0010 16 A2 162 1-65535 1
000E 14 A2 162 1-65535 1
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1: Set Attribute (Definir atributo). Define un solo valor de 
atributo de un objeto clase.
2: Get Identity (Obtener identidad). Obtiene todos los atri-
butos del objeto clase identidad.

Class ID (ID de clase)El número de identificación de clase para el atributo.
Instance ID (ID de instancia)El número de instancia de clase para el atributo.
Attribute ID (ID de atributo)El índice de atributo para los datos.
Data Type (Tipo de datos)El tipo de datos que se leen o se escriben.

0: INT. 16 bits entero con signo.
1: UINT. Entero no firmado de 16 bits.
2: SINT. Entero corto firmado de 16 bits.
3: USINT. Entero corto no firmado de 16 bits.
4: BOOL. Booleano de 8 bits.
5: DINT. Entero doble firmado de 32 bits.
6: UDINT. Entero doble no firmado de 32 bits.
7: REAL. Coma flotante de 32 bits.

Data (Datos) El valor del atributo.
Vendor Number (Número de proveedor)Número de proveedor de la clase iden-

tidad.
Device Type (Tipo de dispositivo)Tipo de dispositivo de la clase identidad.
Product Code (Código de producto)Código de producto de la clase identidad.
Revision (Revisión) Revisión mayor y menor de la clase identidad.
Status (Estado) Vea el manual del dispositivo servidor para obtener más 

información sobre cómo se formatea la palabra de estado
Serial Number (Número de serie)Número de serie de la clase identidad (hex)
Product Name (Nombre del producto)Nombre de producto de la clase identidad
Send (Enviar) 1 (Yes [Sí]) = enviar mensaje al dispositivo servidor confi-

gurado.

Uso de etiquetas
Cuando funcionan como servidores, muchos PLC presentan sus datos en formato de 
etiqueta en lugar del formato de datos Implicit. Por este motivo, cuando el cliente 
está configurado como Mode (Modo) = «Client (Tags)» (Cliente [Etiquetas]), 
("Configuración de menú principal de Ethernet/IP" en la página 126), 30 etiquetas de 
entrada y 30 etiquetas de salida están disponibles para el usuario.

Permite introducir nombres de etiqueta, las etiquetas de entrada de 1 a 30 se 
asocian con las entradas Implicit de 1 a 30 respectivamente y las etiquetas de salida 
de 1 a 30 se asocian con las salidas Implicit de 1 a 30 respectivamente.

Figura 103 Tabla de etiquetas
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Notas:
1. La mayoría de los PLC tienen un búfer de datos con un límite de 500 Bytes. El 

número total de bytes usados se indica mediante la ecuación: Número total de 
bytes de datos = (longitud de etiqueta + 10) × el número de etiquetas solicitado.

2. La dirección de los datos de entrada es siempre hacia el dispositivo:
en el modo servidor, los datos de entrada se escriben en el dispositivo desde el 
cliente; en el modo cliente, los datos de entrada se escriben en el dispositivo 
desde el dispositivo servidor

3. La dirección de los datos de entrada es siempre desde el dispositivo:
en el modo servidor, los datos de salida se escriben en el cliente desde el 
dispositivo; en el modo cliente, los datos de salida se escriben en el servidor 
desde el dispositivo.

LIN de usuario
Permite especificar un máximo de cuatro tablas de linealización de usuario, 
cualquiera de las cuales puede estar seleccionada como «Lin Type» (Tipo Lin) en la 
configuración del canal («IO Main» [E/S principal] en la página 79). La configuración 
consiste en definir el número de puntos que se van a incluir (entre 2 y 32) y en 
especificar los valores X e Y de cada punto, donde los valores X son las entradas y 
los valores Y son las salidas correspondientes.

Tablas de linealización de usuario
1. Las tablas deben ser monótonas; es decir, no puede haber más de un 

valor X con el mismo valor Y asignado.

2. Cada valor X debe ser mayor que el anterior.

3. Cada valor Y debe ser mayor que el anterior.

4. Si se van a utilizar unidades que no sean de temperatura, los valores de 
escala superior e inferior del canal deben ser iguales a los valores de 
rango superior e inferior y se deben especificar las unidades de escala.

Figura 104 muestra la tabla de configuración para un ejemplo con un cilindro 
imaginario.
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Figura 104 Ejemplo de tabla de linealización de usuario
Al configurar un canal ("E/S principal" en la página 95) para usar una tabla de 
linealización de usuario:

Si «Type» (Tipo) está configurado como «Thermocouple2 (Termopar) o «RTD», 
los valores «Range High/Low» (Rango alto/bajo) deben ser los valores Y 
máximo y mínimo, respectivamente. El dispositivo buscará automáticamente los 
valores X (ohmios o mV) correspondientes.

Si «Type» (Tipo) está configurado como «mV», «V» o «mA», los valores «Range 
High/Low» (Rango alto/bajo) deben ser los valores Y máximo y mínimo, 
respectivamente. Los valores «Input High/Low» (Entrada alta/baja) deben ser los 
valores X máximo y mínimo en la tabla, respectivamente.

Mensajes personalizados
Permite crear un máximo de 50 mensajes para que se envíen al archivo de historial 
cuando lo indique una fuente conectada (una alarma que se activa, por ejemplo).

Es posible incluir un máximo de tres valores de parámetros en mensajes usando el 
formato [Address] (Dirección), donde «Address» (Direción) es la dirección ModBus 
decimal del parámetro.

Figura 105 Menú de mensaje
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Opción de bloque de zirconio
No disponible en esta versión de software.

Opción de bloque de esterilización
Este bloque (opción cargable) ofrece una forma de registrar ciclos de esterilización 
completos, incluido, por ejemplo, el venteo y bombeo además del período de 
esterilización propiamente dicho. Hay dos instancias disponibles, que utilizan el 
bloque de lote 1 y el bloque de lote 2, respectivamente.

Figura 106 Menú de configuración del bloque de esterilización
Cycle Status (Estado de ciclo)
0: Wait Start (Esperando inicio) El ciclo está en espe-

ra de iniciarse
1: Ramping (Rampa). Esperando a que la entrada 1 

alcance su punto de consigna 
objetivo.

2: Equilibration (Equilibrado). Actualmente en perío-
do de equilibrado

3: Sterilising (Esterilizando). Actualmente en período 
de esterilización
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4: Passed (Aprobado). El ciclo se ha completado satisfactoriamente
5: Failed (Fallo). El ciclo ha fallado
6: Cancelado. El ciclo se ha cancelado.
7: Test cycle (Ciclo de prueba): Hay un ciclo de prueba en curso
Remaining (Restante)El tiempo de esterilización restante para el ciclo actual.
Equilibration Time (Tiempo de equilibrado)El período de tiempo de equilibrado 

para el ciclo actual
Sterilising Time (Tiempo de esterilización)El tiempo durante el que la carga ha 

estado actualmente en condiciones de esterilización.
Cycle Time (Tiempo de ciclo)La duración total del ciclo, de inicio a fin.
F value (Valor F) El valor F0, FH o A0 actual
Running Output (Salida en ejecución)1 (Yes [Sí]) = Ciclo en ejecución;  0 (No) 

= ciclo detenido
Passed Output (Salida aprobada)1 (Yes [Sí] = salida superada;  0 (No) = salida 

no superada
Start Cycle (Iniciar ciclo)Disparador para iniciar un ciclo personalizado (por 

ejemplo, uno para el que la banda alta y baja y/o el punto 
de consigna objetivo se haya cambiado desde los valores 
predeterminados). 1 (Sí) = inicio.

Start 121 (Iniciao a 121)Disparador para iniciar un ciclo predefinido a 121 °C 
(los valores de punto de consigna, banda baja, banda alta, 
etc. se ajustan en los valores predeterminados a 121° 
cuando se inicia este ciclo). 1 (Sí) = inicio.

Target Time 121 (Tiempo objetivo a 121)Tiempo objetivo para un ciclo a 121 
°C. Se copia automáticamente en el campo «Target Time» 
(Tiempo objetivo) cuando se solicita «Start 121 °C» (Inicio 
a 121 °C). Valor desplazable en formato hh:mm:ss.

Start 134 (Iniciao a 121)Disparador para iniciar un ciclo predefinido a 134°C (los 
valores de punto de consigna, banda baja, banda alta, etc. 
se ajustan en los valores predeterminados a 134° cuando 
se inicia este ciclo).

134°C Time (Tiempo de 134 ºC)Tiempo objetivo para un ciclo de 134°C. Se co-
pia automáticamente en el campo «Target Time» (Tiempo 
objetivo) cuando se solicita «Start 134 °C» (Inicio a 
121 °C). Valor desplazable en formato hh:mm:ss.

Target Time 134 (Tiempo objetivo 134)El tiempo que los valores de entrada de-
ben permanecer en sus valores de esterilización para que 
se supere el ciclo. El ciclo falla si alguna entrada se sale 
de sus límites de banda especificados durante el tiempo 
objetivo. Valor desplazable en formato hh:mm:ss.

Target Time (Tiempo objetivo)Todas las entradas deben estar dentro de las es-
pecificaciones durante este plazo de tiempo para que el ci-
clo se complete satisfactoriamente.

Cycle Number (Número de ciclo)Cada ejecución del bloque esterilizador utiliza 
un número de ciclo único. Puede introducirse manualmen-
te o ajustarse para aumentar automáticamente definiendo 
«Auto Counter» (Contador automático) (a continuación) 
en 1 (Yes [Sí]).

Auto Counter (Contador automático)1 (Yes [Sí]) hace que el Cycle Number (Nú-
mero de ciclo) (arriba) aumente automáticamente cada 
vez que se inicia un nuevo ciclo. Si «Auto Counter» (Con-
tador automático) = «Yes» (Sí), el Cycle Number (Número 
de ciclo) forma parte de los datos de histórico y puede uti-
lizarse para ayudar a identificar datos durante la revisión 
posterior.

File By Tag (Archivo por etiqueta)*El «tic» garantiza que cada ciclo se registre 
en su propio archivo histórico único identificado por el nú-
mero de ciclo y «File tag» (Etiqueta de archivo) (abajo). 
0 = desactivado; 1 = activado.
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Nota: *  Nota...Para usar esta función, el lote asociado debe ajustarse en el modo 
de esterilizador. Para el esterilizador 1, el lote asociado es Batch 1 (Lote 1); para el 
esterilizador 2, el lote asociado es Batch 2 (Lote 2)

File Tag (Etiqueta de archivo)Este campo permite intorducir un identificador de 
cuatro caracteres para usarlo junto al Cycle Number (Ciclo 
de número) (arriba) para identificar el archivo histórico.

Input n Type (Tipo n de entrada)
0: Off (Desactivado) Esta entrada no se incluye en los cálculos de monitoriza-

ción del esterilizador
1: Thermocouple (Termopar)Entrada en grados Cel-

sius
2: Rising pressure (Presión ascendente)

Una entrada de presión mBar 
con una presión ascendente 
esperada durante el ciclo. Esta 
entrada de presión normal-
mente se sincronizaría con una 
entrada de temperatura, en la misma cámara, al realizar 
un ciclo de 121 °C o 134 °C.

3: Falling pressure (Presión descendiente)
Como presión ascendente arriba, pero con una presión 
descendente esperada durante el ciclo.

4: Rise Air Detect (Detector de aumento de aire)
Una entrada de presión mBar con una presión ascendente 
esperada durante el ciclo. Esta entrada de presión no está 
sincronizada con una entrada de temperatura cuando se 
realiza un ciclo de 121 °C o 134 °C, ya que se trata (por 
defecto) de una presión de cámara exterior.

5: Fall Air Detect (Detector de reducción de aire)Una entrada de presión en mi-
libares cuando se prevé que la presión disminuya durante 
el ciclo

Input n PV (PV n de entrada)Valor «n» de entrada. Consulte la nota 1 a conti-
nuación.

IP «n» Target SP (Consigna objetiva para entrada n)Punto de consigna objeti-
vo para esta entrada. Consulte la nota 2 a continuación.

IP «n» Band Low/High (Banda baja/alta para entrada n)La banda de presión o 
temperatura de esterilizador alta y baja para esta entrada. 
Consulte la nota 2 a continuación. Los valores son efecti-
vos solo durante el modo de esterilización.

Failure Dwell n (Fallo de retardo n)Se define una alarma de fallo si esta entrada 
está fuera del rango de banda durante un tiempo superior 
al «Failure Dwell» (Fallo de retardo n). Valor desplazable 
en formato hh:mm:ss.

Notas:
1. n = de 1 a 4, donde por defecto, las entradas de la 1 a  la 3 son de temperatura y 

la 4 es de presión.
2. Los valores del Target SP (Consigna objetiva) y de la Band High/Low (Banda 

Alta/Baja) del objetivo se fijan en sus valores por defecto relevantes cuando se 
inicia un ciclo de 121°C o 134°C.

Measured Temp (Temp. medida) Este valor debe estar en °C para los cálculos 
de F0 o A0.
Normalmente se conecta a un PV de canal de entrada.

Target Temp. (Temp. objetivo) La temperatura objetivo para los cálculos de F0 
o A0. Este es por defecto el mismo valor que el Target SP 
(Punto de consigna objetivo) (arriba).

Z Temperature interval (Intervalo de temperatura Z)
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Para cálculos de F0 o A0 , es un intervalo de temperatura 
que representa un aumento de factor 10 de la eficiencia de 
esterilización. Z = 10°C para F0 y A0, y 20°C para FH

Low Limit (Límite bajo)La temperatura por debajo de la que se suspenden los 
cálculos de F0 o A0.

Opción de bloque de humedad
El Humidity block (Bloque de humedad) (opción cargable) utiliza las entradas de 
temperatura de bulbo húmedo y seco y de presión atmosférica para obtener los 
valores de humedad relativa y punto de rocío. Hay dos bloques disponibles para su 
uso.

Figura 107 Configuración del cálculo de la humedad
Resolution (Resolución)El número de posiciones decimales para las visualiza-

ciones de humedad relativa y punto de rocío (0 a 4).
Psychro Const (Constante psicométrica)La constante psicrométrica (predeter-

minado = 6.66 x 10-4) (Véase la nota siguiente).
Peessure (Presión) La presión atmosférica actual en mBar.
Wet Temp (Temperatura húmeda)La temperatura del termómetro de bulbo hú-

medo.
Wet Offset (Compensación húmeda)Compensación de la temperatura del bul-

bo húmedo.
Dry Temp (Temperatura seca)La temperatura del termómetro de bulbo seco.
Rel Humid (Humedad relativa)El valor de humedad relativa calculado a partir de 

las entradas de temperatura de bulbo húmedo, temperatu-
ra de bulbo seco y presión.
El número de decimales depende de la configuración de 
Resolution (Resolución).

Dew Point (Punto de rocío)El valor del punto de rocío calculado a partir de las 
entradas de temperatura húmeda, temperatura seca y pre-
sión. El número de decimales depende de la configuración 
de Resolution (Resolución).

S Brk 1 (Yes [Sí]) Implica que se ha producido una desconexión 
entre uno (o más) de los transductores de presión o tem-
peratura y su entrada.

Nota: El valor por defecto 6,66 se puede editar, pero el multiplicador es siempre 
10-4 (es decir, no se puede editar).

Bloque de entrada BCD



Versadac Configuración

HA031352 Edición 3 141

Este bloque obtiene los valores de decimal y decimal con código binario 
duodecádico (BCD) desde ocho entradas discretas, donde la entrada 1 es la entrada 
menos significativa (20 = 1) y la entrada 8 es la más significativa (27 = 128). El 
ejemplo siguiente muestra que para las entradas 2, 4, 6 y 8 altas, el valor decimal de 
la entrada es 170, pero el valor BCD es inválido. En cualquier caso, el valor máximo 
de BCD para cada década se limita a 9.

Figura 108 Ejemplo de bloque BCD

Reglas de entrada
Las salidas válidas del BCD se producen solo con el siguiente conjunto de entradas:

• Cualquier combinación de las entradas 1, 2, 3, 5, 6 y 7

• Cualquier combinación de entradas 1, 4, 5 y 8

Configuración

Figura 109 Configuración del bloque de entrada BCD

Parámetros
In «n» (En «n») Entradas digitales de 1 a 8. 0 = Desactivado; 1 = Activado
Dec Byte (Byte decimal)El valor definido por las entradas activas, donde entra-

da 1 = 1, cuando está activa, input 2 (entrada 2) = 2, input 
3 (entrada 3) = 4, input 4 (entrada 4) = 8, etc.

BCD Val (Valor BCD)Una salida de dos dígitos que es la versión decimal en có-
digo binario de la entrada.

BCD Units (Unidades BCD)El dígito menos representantivo (más a la derecha) 
representa el valor de las entradas 1 a 4, donde input 1 
(entrada 1) = 1, input 2 (entrada 2)= 2, input 3 (entrada 3) 
= 4, input 4 (entrada 4) = 8. Maximum value (Valor máxi-
mo) = 9, incluso si la entrada es mayor de 9.

Número de entrada

Estado de entrada

Entrada decimal
Salida BCD
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BCD Tens (Tensión BCD)El dígito más representantivo (más a la izquierda) re-
presenta el valor de las entradas 5 a 8, donde entrada 5 = 
1, entrada 6 = 2, entrada 7 = 4, entrada 8 = 8. Maximum 
value (Valor máximo) = 9, incluso si la entrada es mayor 
de 9.

Bloque lógico (entrada 2)
Este bloque permite realizar una serie de operaciones lógicas y comparativas sobre 
un par de entradas. En el caso de las funciones lógicas, las entradas pueden 
invertirse para permitir, por ejemplo, que se implemente una función NOR invirtiendo 
las entradas en una función AND. Hay disponibles hasta 12 bloques lógicos de doble 
entrada.

Figura 110 Configuración del bloque lógico de dos entradas
Operation (Operación)0 = Desactivado

1 = AND
2 = PLU
3 = XOR
4 = LATCH (solo valores boo-
leanos)
5 = Igual (la salida es 1 (activa-
do) si In1 = In2)
6 = No igual (la salida es 1 (acti-
vado) si In1 ≠ In2)
7 =  Mayor de (la salida es 1 (ac-
tivado) si In1 > In2}
8 = Menor de (la salida es 1 (ac-
tivado) si In1 < In2)
9 = Mayor de (la salida es 1 (ac-
tivado) si In1 ≥ In2)
10 = Menor de (la salida es 1 
(activado) si In1 ≤ In2)

In1(2) (Entrada 1 [2])Las entradas para la operación especificada. Para las en-
tradas invertidas (abajo), esto muestra el estado «real» 
(no invertido).

Fallback Type (Tipo de fallback)Configura los valores 
de salida y estado que se usarán 
si alguna entrada tiene un estado 
distinto de «Good» (Bueno).
0 = FalseBad (Malofalso): Si «Ou-
tput» (Salida) = False (Falso), en-
tonces Status (Estado) = Bad 
(Malo)
1 = TrueBad (Maloverdadero): Si «Output» (Salida) = True 
(Verdadero), entonces Status (Estado) = Bad (Malo)
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2 = FalseGood (Malobueno): Si «Output» (Salida) = False 
(Falso), entonces Status (Estado) = Good (Bueno)
3 = TrueGood (Buenoverdadero): Si «Output» (Salida) = 
True (Verdadero), entonces Status (Estado) = Good (Bue-
no)

Invert (Invertir) Para operadores lógicos solo 
permite invertir ninguna, una o 
ambas entradas. In1 and In2 
(Entrada1 y entrada2) muestran 
el estado no invertido.
0 = No invertir ninguna;  1 = In-
vertir entrada1;  2 = Invertir entrada2;
3 = Invertir entrada1 y entrada2

Out (Salida) 1 (activado) o 0 (desactivado) según sus estados de entra-
da, etc.

Output Status (Estado de salida)El estado del resultado («Ok» o «Error»).
0: Bueno. La variable del proce-
so es correcta.
1: Desactivado. El canal está 
configurado para estar desacti-
vado
2: Over range (Superior al ran-
go). La señal de entrada es ma-
yor que el límite superior del 
rango de hardware selecciona-
do. Under range (Inferior al ran-
go). La señal de entrada es 
menor que el límite inferior del 
rango de hardware seleccionado
4: Hardware error (Error de hardware) Fallo del hardware 
de entrada
5: Ranging (Rango) Se está configurando el rango del 
hardware de entrada según lo exigido por la configuración 
del rango.
6: Desbordamiento Desbordamiento de variable del pro-
ceso, posiblemente debido a que el cálculo ha intentado 
sumar un número pequeño a un número relativamente 
grande.
7: Bad (Malo) La variable de proceso no es correcta y no 
debe usarse.
8: Hardware exceeded (Hardware excedido) Se han exce-
dido las capacidades del hardware en el momento de la 
configuración, por ejemplo la configuración se ha ajustado 
en de 0 a 40 V cuando el hardware de entrada es capaz 
de 12V como máximo. 
9: No data (Sin datos). Muestreos de entrada insuficientes 
para realizar el cálculo

Bloque lógico (entrada 8)
Este bloque permite realizar operaciones lógicas AND, OR y XOR en cascada* 
sobre un máximo de ocho entradas.

*Ejemplo de XOR en cascada para las entradas 1 a 4: (((Entrada1  Entrada2)  
Entrada3)  Entrada4). Hay dos bloques lógicos (8 entradas) disponibles para su 
uso.
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Figura 111 Configuración de bloque lógico de ocho entradas

Parámetros
Operation (Operación)1 = AND; 2 = OR; 3 = XOR
Num In (Número de entradas)El número de entradas del operador lógico
In Invert (Entrada invertida)Permite al usuario invertir entradas individuales, 

como se describe a continuación.
Out Invert (Salida invertida)«Yes» (Sí) invierte el estado de salida
In1 (Entrada1) El estado de entrada 1, ignorando el estado de inversión. 

0 = desactivado; 1 = activado.
In 2 to N (Entrada 2 a N)Igual que para entrada 1, donde N = el valor del pará-

metro ‘Number of Inputs’.
Output (Salida) «On» (Activado) o «Off» (Desactivado). Incluye el efecto 

del estado de «Invert Output» (Invertir salida).

Inversión de entrada
Usa un valor binario para introducir las entradas que desea invertir. 1 = invertir 
entrada1; 2 = invertir entrada2; 3 = invertir entrada1 y entrada2, etc. como se 
muestra en la tabla 2, a continuación.

Esquema

Figura 112 Esquema de bloque lógico (8 entradas)

Salida

Entrada 1

Entrada 2

Entrada 3

Entrada 4

Entrada 5

Entrada 6

Entrada 7

Entrada 8

Invertir 1

Invertir 2

Invertir 4

Invertir 8

Invertir 16

Invertir 32

Invertir 64

Invertir 128

Invertir salida
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Tabla de entrada invertida
En un enlace de comunicaciones, el estado de inversión se transmite como un valor 
decimal, que puede codificarse/descodificarse usando la tabla siguiente. («N» = esta 
entrada no se invierte).
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Entrada Entrada Entrada Entrada
8 7 6 5 4 3 2 1 Hex Dec 8 7 6 5 4 3 2 1 Hex Dec 8 7 6 5 4 3 2 1 Hex Dec 8 7 6 5 4 3 2 1 Hex Dec
N N N N N N N N 00 0 N 7 N N N N N N 40 64 8 N N N N N N N 80 128 8 7 N N N N N N CO 192
N N N N N N N 1 01 1 N 7 N N N N N 1 41 65 8 N N N N N N 1 81 129 8 7 N N N N N 1 Cl 193
N N N N N N 2 N 02 2 N 7 N N N N 2 N 42 66 8 N N N N N 2 N 82 130 8 7 N N N N 2 N C2 194
N N N N N N 2 1 03 3 N 7 N N N N 2 1 43 67 8 N N N N N 2 1 83 131 8 7 N N N N 2 1 C3 195
N N N N N 3 N N 04 4 N 7 N N N 3 N N 44 68 8 N N N N 3 N N 84 132 8 7 N N N 3 N N C4 196
N N N N N 3 N 1 05 5 N 7 N N N 3 N 1 45 69 8 N N N N 3 N 1 85 133 8 7 N N N 3 N 1 C5 197
N N N N N 3 2 N 06 6 N 7 N N N 3 2 N 46 70 8 N N N N 3 2 N 86 134 8 7 N N N 3 2 N C6 198
N N N N N 3 2 1 07 7 N 7 N N N 3 2 1 47 71 8 N N N N 3 2 1 87 135 8 7 N N N 3 2 1 C7 199
N N N N 4 N N N 08 8 N 7 N N 4 N N N 48 72 8 N N N 4 N N N 88 136 8 7 N N 4 N N N C8 200
N N N N 4 N N 1 09 9 N 7 N N 4 N N 1 49 73 8 N N N 4 N N 1 89 137 8 7 N N 4 N N 1 C9 201
N N N N 4 N 2 N 0A 10 N 7 N N 4 N 2 N 4A 74 8 N N N 4 N 2 N 8A 138 8 7 N N 4 N 2 N CA 202
N N N N 4 N 2 1 0B 11 N 7 N N 4 N 2 1 4E 75 8 N N N 4 N 2 1 8B 139 8 7 N N 4 N 2 1 CB 203
N N N N 4 3 N N 0C 12 N 7 N N 4 3 N N 4C 76 8 N N N 4 3 N N 8C 140 8 N N N 4 3 N N CC 204
N N N N 4 3 N 1 0D 13 N 7 N N 4 3 N 1 4D 77 8 N N N 4 3 N 1 8D 141 8 N N N 4 3 N 1 CD 205
N N N N 4 3 2 N 0E 14 N 7 N N 4 3 2 N 4E 78 8 N N N 4 3 2 N 8E 142 8 N N N 4 3 2 N CE 206
N N N N 4 3 2 1 0F 15 N 7 N N 4 3 2 1 4F 79 8 N N N 4 3 2 1 8F 143 8 N N N 4 3 2 1 CF 207
N N N 5 N N N N 10 16 N 7 N 5 N N N N 50 80 8 N N 5 N N N N 90 144 8 N N 5 N N N N D0 208
N N N 5 N N N 1 11 17 N 7 N 5 N N N 1 51 81 8 N N 5 N N N 1 91 145 8 N N 5 N N N 1 D1 209
N N N 5 N N 2 N 12 18 N 7 N 5 N N 2 N 52 82 8 N N 5 N N 2 N 92 146 8 N N 5 N N 2 N D2 210
N N N 5 N N 2 1 13 19 N 7 N 5 N N 2 1 53 83 8 N N 5 N N 2 1 93 147 8 N N 5 N N 2 1 D3 211
N N N 5 N 3 N N 14 20 N 7 N 5 N 3 N N 54 84 8 N N 5 N 3 N N 94 148 8 N N 5 N 3 N N D4 211
N N N 5 N 3 N 1 15 21 N 7 N 5 N 3 N 1 55 85 8 N N 5 N 3 N 1 95 149 8 N N 5 N 3 N 1 D5 213
N N N 5 N 3 2 N 16 22 N 7 N 5 N 3 2 N 56 86 8 N N 5 N 3 2 N 96 150 8 N N 5 N 3 2 N D6 214
N N N 5 N 3 2 1 17 23 N 7 N 5 N 3 2 1 57 87 8 N N 5 N 3 2 1 97 151 8 N N 5 N 3 2 1 D7 215
N N N 5 4 N N N 18 24 N 7 N 5 4 N N N 58 88 8 N N 5 4 N N N 98 152 8 N N 5 4 N N N D8 216
N N N 5 4 N N 1 19 25 N 7 N 5 4 N N 1 59 89 8 N N 5 4 N N 1 99 153 8 N N 5 4 N N 1 D9 217
N N N 5 4 N 2 N 1A 26 N 7 N 5 4 N 2 N 5A 90 8 N N 5 4 N 2 N 9A 154 8 N N 5 4 N 2 N DA 218
N N N 5 4 N 2 1 IB 27 N 7 N 5 4 N 2 1 5B 91 8 N N 5 4 N 2 1 9E 155 8 N N 5 4 N 2 1 DB 219
N N N 5 4 3 N N 1C 28 N 7 N 5 4 3 N N 5C 92 8 N N 5 4 3 N N 9C 156 8 N N 5 4 3 N N DC 220
N N N 5 4 3 N 1 ID 29 N 7 N 5 4 3 N 1 5D 93 8 N N 5 4 3 N 1 9D 157 8 N N 5 4 3 N 1 DD 221
N N N 5 4 3 2 N IE 30 N 7 N 5 4 3 2 N 5E 94 8 N N 5 4 3 2 N 9E 158 8 N N 5 4 3 2 N DE 222
N N N 5 4 3 2 1 IF 31 N 7 N 5 4 3 2 1 5F 95 8 N N 5 4 3 2 1 9F 159 8 N N 5 4 3 2 1 DF 223
N N 6 N N N N N 20 32 N 7 6 N N N N N 60 96 8 N 6 N N N N N AO 160 8 N 6 N N N N N E0 224
N N 6 N N N N 1 21 33 N 7 6 N N N N 1 61 97 8 N 6 N N N N 1 A1 161 8 N 6 N N N N 1 E1 225
N N 6 N N N 2 N 22 34 N 7 6 N N N 2 N 62 98 8 N 6 N N N 2 N A2 162 8 N 6 N N N 2 N E2 226
N N 6 N N N 2 1 23 35 N 7 6 N N N 2 1 63 99 8 N 6 N N N 2 1 A3 163 8 N 6 N N N 2 1 E3 227
N N 6 N N 3 N N 24 36 N 7 6 N N 3 N N 64 100 8 N 6 N N 3 N N A4 164 8 N 6 N N 3 N N E4 228
N N 6 N N 3 N 1 25 37 N 7 6 N N 3 N 1 65 104 8 N 6 N N 3 N 1 A5 165 8 N 6 N N 3 N 1 E5 229
N N 6 N N 3 2 N 26 38 N 7 6 I N 3 2 N 66 102 8 N 6 N N 3 2 N Ac 166 8 N 6 N N 3 2 N E6 230
N N 6 N N 3 2 1 27 3S N 7 6 N N 3 2 1 67 103 8 N 6 N N 3 2 1 A7 167 8 N 6 N N 3 2 1 E7 231
N N 6 N 4 N N N 28 40 N 7 6 N 4 N N N 68 104 8 N 6 N 4 N N N A8 168 8 N 6 N 4 N N N E8 232
N N 6 N 4 N N 1 29 41 N 7 6 N 4 N N 1 69 105 8 N 6 N 4 N N 1 A9 169 8 N 6 N 4 N N 1 E9 233
N N 6 N 4 N 2 N 2A 42 N 7 6 N 4 N 2 N 6A 106 8 N 6 N 4 N 2 N AA 170 8 N 6 N 4 N 2 N EA 234
N N 6 N 4 N 2 1 2B 43 N 7 6 N 4 N 2 1 6B 107 8 N 6 N 4 N 2 1 AE 171 8 N 6 N 4 N 2 1 EB 235
N N 6 N 4 3 N N 2C 44 N 7 6 N 4 3 N N 6C 108 8 N 6 N 4 3 N N AC 172 8 N 6 N 4 3 N N EC 236
N N 6 N 4 3 N 1 2D 45 N 7 6 N 4 3 N 1 6D 109 8 N 6 N 4 3 N 1 AD 173 8 N 6 N 4 3 N 1 ED 237
N N 6 N 4 3 2 N 2E 46 N 7 6 N 4 3 2 N 6E 110 8 N 6 N 4 3 2 N AE 174 8 N 6 N 4 3 2 N EE 238
N N 6 N 4 3 2 1 2F 47 N 7 6 N 4 3 2 1 6F 111 8 N 6 N 4 3 2 1 AF 175 8 N 6 N 4 3 2 1 EF 239
N N 6 5 N N N N 30 48 N 7 6 5 N N N N 70 112 8 N 6 5 N N N N B0 176 8 N 6 5 4 N N N F0 240
N N 6 5 N N N 1 31 4S N 7 6 5 N N N 1 71 113 8 N 6 5 N N N 1 B1 177 8 N 6 5 4 N N 1 F1 241
N N 6 5 N N 2 N 32 50 N 7 6 5 N N 2 N 72 114 8 N 6 5 N N 2 N B2 178 8 N 6 5 4 N 2 N F2 242
N N 6 5 N N 2 1 33 51 N 7 6 5 N N 2 1 73 115 8 N 6 5 N N 2 1 B3 179 8 N 6 5 4 N 2 1 F3 243
N N 6 5 N 3 N N 34 52 N 7 6 5 N 3 N N 74 116 8 N 6 5 N 3 N N B4 180 8 N 6 5 4 3 N N F4 244
N N 6 5 N 3 N 1 35 53 N 7 6 5 N 3 N 1 75 117 8 N 6 5 N 3 N 1 B5 181 8 N 6 5 4 3 N 1 F5 245
N N 6 5 N 3 2 N 36 54 N 7 6 5 N 3 2 N 76 118 8 N 6 5 N 3 2 N B6 182 8 N 6 5 4 3 2 N F6 246
N N 6 5 N 3 2 1 37 55 N 7 6 5 N 3 2 1 77 119 8 N 6 5 N 3 2 1 B7 183 8 N 6 5 4 3 2 1 F7 247
N N 6 5 4 N N N 38 56 N 7 6 5 4 N N N 78 120 8 N 6 5 4 N N N B8 184 8 N 6 5 4 N N N F8 248
N N 6 5 4 N N 1 39 57 N 7 6 5 4 N N 1 79 121 8 N 6 5 4 N N 1 B9 185 8 N 6 5 4 N N 1 F9 249
N N 6 5 4 N 2 N 3A 58 N 7 6 5 4 N 2 N 7A 122 8 N 6 5 4 N 2 N BA 186 8 N 6 5 4 N 2 N FA 250
N N 6 5 4 N 2 1 3B 59 N 7 6 5 4 N 2 1 7B 123 8 N 6 5 4 N 2 1 BB 187 8 N 6 5 4 N 2 1 FB 251
N N 6 5 4 3 N N 3C 60 N 7 6 5 4 3 N N 7C 124 8 N 6 5 4 3 N N BC 188 8 N 6 5 4 3 N N FC 252
N N 6 5 4 3 N 1 3D 61 N 7 6 5 4 3 N 1 7D 125 8 N 6 5 4 3 N 1 BD 189 8 N 6 5 4 3 N 1 FD 253
N N 6 5 4 3 2 N 3E 62 N 7 6 5 4 3 2 N 7E 126 8 N 6 5 4 3 2 N BE 190 8 N 6 5 4 3 2 N FE 254
N N 6 5 4 3 2 1 3F 63 N 7 6 5 4 3 2 1 7F 127 8 N 6 5 4 3 2 1 BF L91 8 N 6 5 4 3 2 1 FF 255
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Ejemplo: Decimal 146 significa que las entradas 8, 5 y 2 están invertidas.

Bloque de multiplexor
Este bloque selecciona una de ocho entradas analógicas para aparecer como su 
salida. Hay cuatro bloques de multiplexor disponibles para su uso.

Figura 113 Configuración del bloque del multiplexor
High Limit (Límite alto)El límite alto para los valores de entrada, salida y fall-

back. El valor mínimo es el Low Limit (Límite Bajo).
Low Limit (Límite bajo)El límite bajo para los valores de entrada y de fallback. 

Valor máximo es High Limit (Límite alto).
Fallback Clip Bad: Si el valor de entrada 

está por encima de High limit (lími-
te superior) o por debajo Low limit 
(límite inferior), el valor de salida 
se define en el límite apropiado y 
el estado se ajusta en «Bad» (ma-
lo). Si la señal de entrada se en-
cuentra dentro de los límites, pero 
su estado es malo, la salida se ajusta al valor «Fallback».
Clip Good (Clip bueno): Si el valor de entrada está por en-
cima de High limit (límite superior) o por debajo Low limit 
(límite inferior), el valor de salida se define en el límite 
apropiado y el estado se ajusta en «Good» (bueno). Si la 
señal de entrada se encuentra dentro de los límites, pero 
su estado es malo, la salida se ajusta al valor «Fallback».
Fall Bad: Si el valor de entrada está por encima de High 
limit (límite superior) o por debajo Low limit (límite inferior), 
el valor de salida se define en el valor fallback y el estado 
se ajusta en «Bad» (malo). 
Fall Good (Omisión buena): Si el valor de entrada está por 
encima de High limit (límite superior) o por debajo Low li-
mit (límite inferior), el valor de salida se define en el valor 
de omisión y el estado se ajusta en «Good» (bueno). Ups-
cale Bad (Aumentar malo): Si el estado de entrada es 
«Bad» (malo), o si la señal de entrada está por encima de 
High limit (límite superior) o por debajo Low limit (límite in-
ferior), el valor de salida se ajusta en el límite superior.
Downscale Bad (Reducir malo): Si el estado de entrada es 
malo, o si la señal de entrada está por encima del High li-
mit (límite superior) o por debajo Low limit (límite inferior), 
el valor de salida se ajusta en el límite inferior.

Fallback value (Valor de fallback)El valor que debe adoptar la salida, en condi-
ciones de error, si «Fallback Status» (Estado de fallback) 
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se configura en «Fall Good» (Caída bien) o «Fall Bad» 
(Caída mal).

Input Selector (Selector de entrada)Selecciona cuál de 
las ocho entradas se presenta en 
la salida.

Input 1 to 8 (Entradas de 1 a 8)Conectadas a las entra-
das analógicas correspondientes.

Out (Salida) La salida del bloque multiplexor.

Status (Estado) Indica el estado de la opera-
ción
0: Bueno. La variable del 
proceso es correcta.
1: Desactivado. El canal 
está configurado para estar 
desactivado
2: Over range (Superior al 
rango). La señal de entrada 
es mayor que el límite supe-
rior del rango de hardware seleccionado
3: Under range (Inferior al rango). La señal de entrada es 
menor que el límite inferior del rango de hardware selec-
cionado
4: Hardware error (Error de hardware) Fallo del hardware 
de entrada
5: Ranging (Rango) Se está configurando el rango del 
hardware de entrada según lo exigido por la configuración 
del rango.
6: Desbordamiento Desbordamiento de variable del pro-
ceso, posiblemente debido a que el cálculo ha intentado 
sumar un número pequeño a un número relativamente 
grande.
7: Bad (Malo) La variable de proceso no es correcta y no 
debe usarse.
8: Hardware exceeded (Hardware excedido) Se han exce-
dido las capacidades del hardware en el momento de la 
configuración, por ejemplo la configuración se ha ajustado 
en de 0 a 40 V cuando el hardware de entrada es capaz 
de 12V como máximo.
9: No data (Sin datos). Muestreos de entrada insuficientes 
para realizar el cálculo

Resolution (Resolución)Define el número de posiciones decimales para el valor 
de salida (máximo 4). Si la entrada seleccionada no está 
conectada, o si su estado es «Bad» (Malo), o si el valor de 
salida se ha ajustado a los límites, la resolución se definirá 
en una posición decimal.

Matemáticas (Entrada 2)
Este bloque de opciones del «Toolkit» (Herramientas) permite realizar una de varias 
operaciones utilizando dos valores de entrada que pueden ser de naturaleza 
analógica o digital. Una o ambas entradas pueden ser escaladas, usando un 
«Multiplier» (Multiplicador).

Hay tantos bloques matemáticos con dos entradas como canales virtuales estén 
habilitados.
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Figura 114 Bloque esquemático

Figura 115 Configuración de bloque (típica)

Parámetros
Operación 0: Off

1: Add (Sumar) Out (Salida) = 
In1 (Entrada1) + In2 (Entrada2)
2: SubOut (Restarsalida) = En-
trada1 - Entrada2
3: MulOut (Multiplicarsalida) = 
Entrada1 x Entrada2
4: DivOut (Dividir salida) = En-
trada1 ÷ Entrada2
5: Abs Dif Out (Diferencia de sa-
lida absoluta)Salida = la dife-
rencia entre la Entrada1 y la 
Entrada2, ignorando el signo
6: Sel Max Out (Selección de 
máxima de salida ) =  el mayor 
de la Entrada1 o Entrada2
7: Sel Min Out (Selección de mí-
nimo de salida ) =  el menor de 
la Entrada1 o Entrada2
8: Hot Swap Out (Cambio de salida) = Entrada 2 si Entrada 
1 es «Bad» (Error); en caso contrario, Salida = Entrada1
9: Smp Hld Out (Muestreo y retención de salida) rastrea 
Entrada 1 mientras que Entrada 2 = 1. El valor de salida 
se mantiene mientras Entrada 2 = 0 (para más detalles, 
véase «Sample and Hold Details» [Muestreo y retención])
10: Power* Out (Salida de alimentación)= Entrada1 iguala 
su potencia a la de la Entrada2. (Out [Salida] = Entrada1 y 
Entrada2)
11: SqrtOut (Raíz de salida) = Entrada1 (se ignora Entra-
da2)
12: LogOut (Cierre de sesión)Salida = Registro10 Entra-
da1 (se ignora Entrada2)

Entrada 1

SalidaMultiplicador Entrada 1

Entrada 2
Multiplicador Entrada 2

Bloque 
matemático 
(2 entradas)
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13: LnOut (Salida de línea) = Entrada1 de líne (se ignora 
Entrada2)
14: Expn Out () = eIn1 (se ignora Entrada2)
15: 10 x Out (Salida) = 10Entrada1 (se ignora Entrada2)
51: Sel1Out (Seleccionar salida1)= Input1 (Entrada1) si 
«Input Selector» (Selector de entrada) = Input1 (Entrada1)
Out (Salida) = In2 (Entrada2) si «Input Selector» (Selector 
de entrada) = Input2 (Entrada2)

Nota: * Para esta implementación:

0 iguala su potencia a 0 = 1.

Si se elevan valores negativos a cualquier potencia se produce un estado «Bad» 
(Malo).

Si se eleva 0 a una potencia negativa se obtiene un estado «Bad» (Malo).
In1(2) Mul (Multiplicador entrada1[2])El factor de escala para la entrada 1(2). 

Este factor de multiplicación se aplica a la entrada de la 
función, pero no afecta a los valores mostrados de In1 
(Entrada1) e In2 (Entrada 2) (a continuación).

Units (Unidades) Permite introducir una cadena de cinco caracteres para la 
función

Resolution (Resolución)Define el número de posiciones decimales del valor Ou-
tput (Salida). La resolución de entrada (si corresponde) es 
la de la entrada correspondiente.

High Limit (Límite alto)El límite alto para los valores de entrada, salida y fall-
back. El valor mínimo es el Low Limit (Límite Bajo).

Low Limit (Límite bajo)El límite bajo para los valores de entrada y de fallback. 
Valor máximo es High Limit (Límite alto).

Estrategia de fallback0: Clip Bad. Si el valor de entrada 
está por encima de High limit (límite 
superior) o por debajo Low limit (lími-
te inferior), el valor de salida se defi-
ne en el límite apropiado y el estado 
se ajusta en «Bad» (malo). Si la se-
ñal de entrada se encuentra dentro 
de los límites, pero su estado es ma-
lo, la salida se ajusta al valor Fall Back.
1: Clip bueno. Si el valor de entrada está por encima de 
High limit (límite superior) o por debajo Low limit (límite in-
ferior), el valor de salida se define en el límite apropiado y 
el estado se ajusta en «Good» (bueno). Si la señal de en-
trada se encuentra dentro de los límites, pero su estado es 
malo, la salida se ajusta al valor Fall Back.
2: Fall Bad. Si el valor de entrada está por encima del lími-
te superior o por debajo del límite inferior, el valor de salida 
se define en el valor Fall Back y el estado se ajusta en 
«Bad» (malo). 
3: Fall Good. Si el valor de entrada está por encima del lí-
mite superior o por debajo del límite inferior, el valor de sa-
lida se define en el valor Fall Back y el estado se ajusta en 
«Good» (bueno).
4: UpScaleBad. (Escala ascendente mala) Si el estado de 
entrada es «Bad» (malo), o si la señal de entrada está por 
encima de High limit (límite superior) o por debajo Low li-
mit (límite inferior), el valor de salida se ajusta en el límite 
superior.
5: DownScaleBad. (Escala descendende mala) Si el esta-
do de entrada es malo, o si la señal de entrada está por 
encima del High limit (límite superior) o por debajo Low li-
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mit (límite inferior), el valor de salida se ajusta en el límite 
inferior.

Fallback value (Valor de fallback)El valor que debe adoptar la salida, en condi-
ciones de error, si «Fallback Status» (Estado de fallback) 
se configura en «Fall Good» (Caída bien) o «Fall Bad» 
(Caída mal).

Select (Seleccionar) Solo para la operación «Select» (Seleccionar). Cuando se 
conecta a un parámetro válido, «Input Select» (Selector de 
entrada) se vuelve de solo lectura. Se selecciona In1 (En-
trada1) si «Input Select» (Selector de entrada) = 1; se se-
lecciona In2  (Entrada2) si «Input Select» (Selector de 
entrada) = 2. Los valores de «Input Select» (Selector de 
entrada) mayores de 2 se ignoran.

In1(2) (Entrada1[2]) Conectado a parámetros de entrada válidos. Los valores 
mostrados ignoran cualquier efecto multiplicador de entra-
da.

Out (Salida) Ofrece el valor de salida para la operación.
Status (Estado) Muestra el estado del valor de salida.

0: La variable del proceso es correc-
ta.
1: Desactivado. El canal está confi-
gurado para estar desactivado
2: Over range (Superior al rango). La 
señal de entrada es mayor que el lí-
mite superior del rango de hardware 
seleccionado. Under range (Inferior al rango). La señal de 
entrada es menor que el límite inferior del rango de hard-
ware seleccionado
4: Hardware error (Error de hardware) Fallo del hardware 
de entrada
5: Ranging (Rango) Se está configurando el rango del 
hardware de entrada según lo exigido por la configuración 
del rango.
6: Desbordamiento Desbordamiento de variable del pro-
ceso, posiblemente debido a que el cálculo ha intentado 
sumar un número pequeño a un número relativamente 
grande.
7: Bad (Malo) La variable de proceso no es correcta y no 
debe usarse.
8: Hardware exceeded (Hardware excedido) Se han exce-
dido las capacidades del hardware en el momento de la 
configuración, por ejemplo la configuración se ha ajustado 
en de 0 a 40 V cuando el hardware de entrada es capaz 
de 12V como máximo.
9: No data (Sin datos). Muestreos de entrada insuficientes 
para realizar el cálculo.

Detalles de muestreo y retención
Como se describió anteriormente, la salida sigue a la entrada 1 siempre y cuando la 
entrada 2 sea «High» (alta). Cuando la Entrada 2 es Low (Baja), la salida adopta el 
valor instantáneo de la Entrada 1 hasta que la Entrada 2 vuelve a estar High (Alta). 
Cuando la Entrada 2 sube, la salida salta al valor actual de la Entrada 1 y la sigue 
hasta que la Entrada 2 baja.
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Figura 116 Ejemplo de «Sample and Hold» (Muestreo y retención)

Temporizador
La función de temporizador permite al usuario configurar hasta 12 temporizadores 
como: Los tipos «On Pulse» (En pulso), «On Delay» (En retraso), «One Shot» (Uno 
solo) o «Min On». Los diferentes tipos se describen en "Modos de temporizador" en 
la página 152, a continuación.

Figura 117 Configuración de temporizador

Parámetros
Mode (Modo) Seleccionar 0: desactivado; 1: en pulso; 2: en retraso;  3: 

Uno solo o 4 Tiempo Min On
Time (Tiempo) Permite al usuario introducir un período para el temporiza-

dor.
Elapsed time (Tiempo transcurrido)Este parámetro de solo lectura muestra el 

progreso del tiempo en si la fuente disparadora está activa 
(1: activado) o inactiva (0: desactivado)

Out (Salida) Muestra si la salida está activa (1) o inactiva (0)
Triggered (Disparado)Muestra si el temporizador está actualmente disparado 

(puede permanecer disparado incluso después de que la 
fuente de disparo haya vuelto a estar apagada).
1 = activado; 0 = no activado.

Modos de temporizador

On Pulse
La salida se activa en cuanto la entrada de disparador se activa y permanece 
activada hasta que haya transcurrido el periodo de tiempo. Si el temporizador vuelve 
a dispararse durante el periodo de temporización, el temporizador se reinicia.

Entrada 1

Entrada 2

Salida

Salida 
sigue
Entrada 1

Salida 
sigue
Entrada 1

Salida sigue
Entrada 1

Salida se 
retiene

Salida se 
retiene
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Figura 118 Definiciones de «On Pulse» (En pulso)

En retraso
Introduce un retardo entre el punto de activación y la activación de la salida del 
temporizador.

Reglas:

1. Cuando se activa el disparador, la salida se activa una vez que transcurre 
el tiempo de retardo y permanece activada hasta que se desactive el 
disparador.

2. Si el disparador se desactiva antes de que haya transcurrido el tiempo de 
retardo, la salida no se activa.

Figura 119 Definiciones de «On Delay» (En retraso)

One Shot
Si la entrada del disparador está activa, la cuenta atrás se inicia tan pronto como se 
confirma el valor de tiempo introducido (tecla de desplazamiento). El tiempo 
introducido disminuye a cero, y el usuario debe volver a introducirlo antes de que se 
pueda iniciar cualquier otra función de temporizador.

Reglas

1. El valor de tiempo se reduce solo cuando está activa la entrada del 
disparador.

2. La salida está activada solo cuando el valor de activación está activo (y el 
valor de tiempo introducido no ha transcurrido).

3. El valor de tiempo introducido se puede editar en cualquier momento para 
aumentar o disminuir el período de tiempo restante.

Disparo

Salida

Tiempo transcurrido

Disparado

Tiempo

Redisparado

Tiempo Tiempo

Disparo

Salida

Tiempo transcurrido

Disparado

Tiempo Tiempo
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Figura 120 Definiciones de temporizador «One Shot» (Uno solo)
Nota: Para facilitar la comparación, las dos ediciones temporales de la figura 
anterior tenían el mismo valor. No es una condición necesaria.

Activación mínima
Esta función de «Off delay» (Retraso de apagado) proporciona una señal de salida 
que se «enciende» (On) cuando el disparador se activa y permanece encendida 
durante un período determinado después de que el disparador se desactiva.

Si el disparador se inactiva, y luego se activa de nuevo antes de que el período de 
tiempo haya transcurrido, entonces el tiempo transcurrido se pone a cero y la salida 
permanece encendida.

El parámetro «Triggered» (Activado) se activa siempre que el tiempo transcurrido 
está en cuenta regresiva.

Figura 121 Definiciones del temporizador «Min On»

Valor de usuario
Este bloque de opciones del «Toolkit» (Herramientas) permite configurar hasta 12 
valores para utilizarlos como entradas de otros parámetros.

� � �

Disparo
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Tiempo transcurrido
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Tiempo
Ediciones 
de tiempo

Tiempo

12 = Temporizador

Disparo
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Tiempo transcurrido
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Tiempo TiempoTiempo
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Figura 122 Configuración de valor de usuario

Parámetros
Units (Unidades) Permite introducir una cadena de cinco caracteres para 

las unidades de valor del usuario.
Resolution (Resolución) Define el número de posiciones decimales del valor del 

usuario (máximo 4).
High/Low Limit (Límite alto/bajo)Define los valores máximo y mínimo en los que 

puede ajustarse el valor de usuario
Value (Valor) El valor de usuario, introducido manualmente o conectado 

a otro parámetro apropiado.
Status (Estado) Muestra el estado del valor de salida.

0: La variable del proceso es 
correcta.
1: Desactivado. El canal 
está configurado para estar 
desactivado
2: Over range (Superior al 
rango). La señal de entrada 
es mayor que el límite supe-
rior del rango de hardware 
seleccionado. Under range (Inferior al rango). La señal de 
entrada es menor que el límite inferior del rango de hard-
ware seleccionado
4: Hardware error (Error de hardware) Fallo del hardware 
de entrada
5: Ranging (Rango) Se está configurando el rango del 
hardware de entrada según lo exigido por la configuración 
del rango.
6: Desbordamiento Desbordamiento de variable del pro-
ceso, posiblemente debido a que el cálculo ha intentado 
sumar un número pequeño a un número relativamente 
grande.
7: Bad (Malo) La variable de proceso no es correcta y no 
debe usarse.
8: Hardware exceeded (Hardware excedido) Se han exce-
dido las capacidades del hardware en el momento de la 
configuración, por ejemplo la configuración se ha ajustado 
entre 0 y 40 V cuando el hardware de entrada es capaz de 
soportar 12V como máximo.
9: No data (Sin datos). Muestreos de entrada insuficientes 
para realizar el cálculo.

Bloque OR de ocho entradas
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Un bloque OR lógico de 8 entradas cuya salida es 1 (On) si una o más de sus 
entradas es 1 (On). Un segundo bloque se introduce automáticamente si se 
necesitan más de 8 entradas, como se muestra en Figura 123. Los bloques 
mostrados en Figura 123 tienen por nombre «A» y «B», donde «A» y «B» pueden 
ser cualquiera de las 12 instancias posibles.

Figura 123 Bloque OR de ocho entradas
Las conexiones del usuario utilizan bloques OR automáticamente cuando hay más 
de un parámetro conectado al mismo parámetro de destino. Si se desea que un relé 
(Digital I/O 2A2B)" funcione cuando se active la alarma 1 del canal 1 y/o la alarma 1 
del canal 2, por ejemplo, el parámetro «Active» (Activado) de ambas alarmas tiene 
que estar conectado al parámetro «Main.PVin» del mismo relé. Figura 124 muestra 
como esto se hace introduciendo un bloque OR para conectar las dos salidas de 
alarma.

Figura 124 Representación de conexión gráfica de uso del bloque OR

Figura 125 Representación del explorador de parámetros del bloque OR
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Resumen de alarmas
Permite al usuario ver el estado general de las alarmas de la unidad y efectuar un 
reconocimiento global de todas las alarmas activas, si es necesario.

Figura 126 Menú superior de resumen de alarma

Pestaña de resumen de alarma
Global Ack (Reconocimiento global)Permite al usuario reconocer simultánea-

mente todas las alarmas. Las alarmas configuradas como 
«Manual» deben estar inactivas antes del reconocimiento. 
1 = Acknowledge (Reconocida).

Cualquier alarma de canal0: Ninguno. No hay alarmas de canal activas
1: YesAckd. (Reconocida) Hay al menos una alarma acti-
va pero todas las alarmas han sido reconocidas.
2: YesNAck. (Una no reconocida) Hay al menos una alar-
ma no reconocida 

Any Sys Alarm (Cualquier alarma del sistema)0: No.  No hay alarmas de siste-
ma activas.
1: Sí. Hay al menos una alarma de sistema activa.

Any Alarm (Cualquier alarma)0: No.  No hay alarmas de canal o sistema acti-
vas.
1: Sí. Hay al menos una alarma de canal o sistema activa.

AnyUnackAlarm (Cualquier alarma no reconocida)0: No.  No hay alarmas no 
reconocidas.
1: Sí. Hay al menos una alarma no reconocida.

Alarm n Ack (Alarma n reconocida)1 = Reconoce la alarma n más reciente.

Ventana de resumen de alarma y sistema

Figura 127 Ventana de resumen de alarma y sistema
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Alarm 1 ID (ID de alarma 1)Alarma de sistema más reciente
Alarm «n» ID (ID de alarma «m») Alarma de sistema n más reciente.

Alarmas de Sistema
0: Sin alarma. No hay alarmas de sistema activas en este 

momento
1: Low battery warning (Advertencia de batería baja.). Queda 

menos del 40 % de batería
2: Battery failure (Fallo de batería.). Queda menos del 10 % 

de batería, es necesario sustituirla de inmediato
3: System clock failure (Fallo del reloj del sistema). El reloj in-

terno se ha corrompido durante el encendido o no se han 
ajustado la fecha y la hora. Desaparece si se configura la 
fecha y la hora.

4: Channel error (Error de canal). Indica un fallo de hardware 
en el circuito del canal o la medida de temperatura CJ in-
terna

5: Channel failure (Fallo del canal). Indica un fallo de hardwa-
re en el circuito del canal de entrada. No es una alarma 
con compensación automática y el dispositivo debe apa-
garse y volver a encenderse

6: DHCP server failure (Fallo del servidor DHCP. ). El dispo-
sitivo no ha podido obtener los ajustes de red desde el ser-
vidor DHCP. Causa probable: no hay ningún servidor 
DHCP conectado a la red actual

7: FTP Archive file lost (Se ha perdido el fichero de archivo 
FTP). Se ha eliminado un fichero que todavía no se había 
archivado. Causas probables: imposible establecer comu-
nicación con el servidor, frecuencia de archivado desacti-
vada o demasiado lenta

8: FTP Archive slow (Archivado FTP lento). Posible pérdida 
de ficheros de archivo, cambio al modo automático. Causa 
posible: imposible establecer comunicación con el servi-
dor

9: FTP primary server failure (Fallo del servidor FTP prima-
rio.). Fallo después de dos intentos de establecer la comu-
nicación con el servidor primario. Intentando 
comunicaciones con el servidor secundario

10: FTP secondary server failure (Fallo del servidor FTP se-
cundario). Fallo después de dos intentos de establecer la 
comunicación con el servidor secundario.

11: Insufficient non-volatile memory (Memoria no volátil insufi-
ciente).

12: Maths channel failure (Fallo del canal matemático).
13: Se ha perdido el soporte del fichero de archivo. Se ha eli-

minado un fichero que todavía no se había archivado. 
Causas probables: el soporte falta, está lleno, protegido 
contra escritura, frecuencia de archivado desactivada o 
demasiado lenta

14: Media archive slow (Soporte de archivo lento). Posible 
pérdida de ficheros de archivo, cambio al modo automáti-
co. Causa posible: estrategia de archivo local demasiado 
lenta

15: Network boot failure (Fallo de inicio de red)
16: DC Output Calibration Error (Error de calibración de salida 

CC)
17: Recording failure (Fallo de registro). El registro ha fallado. 

Causa posible: error de archivo o desbordamiento interno
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18: Media failure (Fallo de soporte). Fallo al archivar en sopor-
te extraíble. Causa probable: soporte corrompido o forma-
to no compatible

19: Media full (Soporte lleno.). El soporte extraíble está lleno
20: SNTP failure (Fallo de SNTP). Se han recibido datos no 

válidos del servidor SNTP o no es posible acceder al ser-
vidor

21: Time synchronization failure (Fallo de sincronización de 
hora). La hora del dispositivo no se ha sincronizado con el 
servidor SNTP.

22: Media missing (Falta el soporte). No se ha detectado el so-
porte extraíble. Para reanudar el archivado, hay que inser-
tar un soporte apropiado, no se admiten de más de 8 GB.

23: Archive disabled (Archivado deshabilitado.). El archivado 
se ha deshabilitado en la página «Demand Archiving» (So-
licitar archivado)

24: Archiving failed (Fallo durante el archivado). Ha fallado el 
archivado en el destino configurado

25: Se ha excedido el tiempo de espera de archivado. Se ha 
excedido el tiempo de espera de archivado mientras se in-
tentaba archivar en el destino configurado

26: USB Over Current (Sobreintensidad de USB.). El disposi-
tivo USB conectado requiere demasiada intensidad (máxi-
mo de 100 mA)

27: USB unsupported (USB no compatible). El dispositivo 
USB conectado no es compatible

28: Invalid parameter database (Base de datos de parámetros 
no válida). La base de datos no volátil de parámetros se 
ha corrompido

29: Copia datavRAM no volátil no válida de la base de datos 
de parámetros no volátiles

30: Flash write failure (Fallo de registro flash). Los controlado-
res flash no han logrado grabar datos en flash, el histórico 
puede verse comprometido. Se recomienda formatear la 
unidad de histórico.

31: Wiring failure (Fallo del cableado). Fallo al validar la cone-
xión del usuario

32: Broadcast Storm (Tormenta de disfusión). Se ha detecta-
do una tormenta de difusión.

33: Non-volatile memory write frequency warning (Adverten-
cia de frecuencia de registro de la memoria no volátil.). 
Uno o más parámetros se graban en la memoria no volátil 
con frecuencia, lo que puede motivar que se agote la me-
moria si se realiza el mismo número de grabaciones du-
rante la vida útil del dispositivo.La causa probable es 
grabaciones frecuentes a través de las comunicaciones.

Configuración de eventos en tiempo real
Esto permite al usuario configurar hasta dos eventos para que se activen a una hora 
y fecha específicas, o en un día concreto, y que permanezcan activos durante un 
tiempo configurable, medido como una duración, o como un tiempo específico de 
«Off» (Desactivado).
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Eventos en tiempo real
Type (Tipo) Selecciona el tipo de evento en tiempo real (0 = Desacti-

vado; 1 = Día y hora; 2 = Fecha y hora)
On Month (En mes) Solo para «Time and Date» (Hora y fecha), es el mes en 

que se activará el evento.
1 = Enero, 2 = Febrero, etc.

On Date (En fecha) Solo para «Time and Date» (Hora y fecha), es el día del 
mes en que se activará el evento.

On Day (En día) Solo para «Time and Date» (Hora y fecha), es el día de la 
semana en que se activará la salida del evento.
0 = Domingo; 1 = Lunes; 2 = Martes; 3 = Miércoles; 4 = 
Jueves; 5 = Viernes; 
6 = Sábado; 7 = Cada día, de lunes a viernes incluidos; 8 
= Sábado y domingo;
9 = Cada día.

On Time (En hora) La hora del día en que la salida del evento debe encender-
se (00:00:00 a 23:59:59)

Off Type (Tipo de apagado)Selecciona la acción que desactivará el evento (0 = 
duración; 1 = hora)

Duration (Duración) Para el «Off Type» (Tipo de apagado) establecido en «Du-
ration» (Duración), esto especifica la duración para la cual 
la salida del evento debe permanecer encendida (de 
00:00:01 a 23:59:59 para Hora y Día, o de 00:00:01 a 
500:00:00 para Hora y Fecha)

Off Month (Mes de apagado)Para «Time and Date» (Hora y fecha) solo y con 
«Off Type» (Tipo deapagado) ajustado en «Time» (Tiem-
po), es el mes en que se desactivará el evento (como «On 
Month» [En mes]).

Off Date (Fecha de apagado)Solo para «Time and Date» (Hora y fecha) y con 
Off Type (Tipo de apagado) ajustado a «Time» (Hora), 
este es el número del día del mes en el que el evento debe 
apagarse.

Off Day (Día de apagado)Para «Time and Day» (Hora u día) solo y con «Off Ty-
pe» (Tipo de apagado) ajustado en «Time» (Hora), es el 
día de la semana en que se desactivará la salida del even-
to (como «On Day» [En día]).

Off Time (Hora de apagado)La hora en la que la salida del evento debe apagar-
se (00:00:00 - 23:59:59)

Output (Salida) La salida para el evento en tiempo real (0 = Desactivado; 
1 = Activado) (solo lectura)

Correo electrónico:

Time and Day (Hora Time and Date (Hora y fecha)



Versadac Configuración

HA031352 Edición 3 161

El dispositivo puede enviar correos electrónicos a uno o varios destinatarios. El 
usuario puede introducir la dirección de correo electrónico de 10 destinatarios en 
cada una de las 24 instancias de correos electrónicos. Un destinatario puede 
aparecer en tantas listas como sea necesario. Además del «Subject» (Asunto) y el 
cuerpo del mensaje, cada correo electrónico puede incluir uno de los mensajes 
definidos en «Custom Message Configuration» (Configuración de mensaje 
personalizado), y puede incluir valores integrados, estado de alarma, estado de lote, 
etc. como se describe en la "Mensajes personalizados" en la página 136.

Configuración de correo electrónico:
La figura 129 muestra la página de configuración del correo electrónico.

Figura 128 Configuración de correo electrónico:
Host name (Nombre del host)El nombre de host o dirección IP del servidor de 

correo electrónico Puerto. Este es el número de puerto uti-
lizado por SMTP por los servidores. La mayoría de los ser-
vidores utilizan el puerto 25 para esta función, y solo el 
personal con experiencia debería cambiar este valor pre-
definido.

Errors To (Errores a)Una dirección de correo electrónico a la que se pueden 
enviar los mensajes de error para su visualización, etc. El 
propio dispositivo no puede recibir correos electrónicos y, 
por tanto, no puede mostrar por sí mismo los mensajes 
(por ejemplo, «undeliverable» [imposible de entregar]). 
Debe realizarse una entrada en este campo. La misma di-
rección puede usarse para cualquier número de dispositi-
vos.

Recipient 1 to 10 (Destinatario del 1 al 10)Estos campos permiten introducir la 
dirección de correo electrónico de 10 destinatarios para la 
lista seleccionada. La primera dirección válida aparece en 
la parte «To:» (A:) del encabezado del correo electrónico; 
las demás direcciones válidas aparecen en la parte «Cc:» 
del encabezado del correo electrónico.

Subject (Asunto) Permite la introducción de hasta 100 caracteres que apa-
recen en la parte «Subject:» (Asunto:) del encabezado del 
correo electrónico.

Text (Texto) Permite la introducción de hasta 100 caracteres que apa-
recen como el cuerpo del correo electrónico. También de-
nominado «Body Text» (Texto del cuerpo).
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Attach message (Mensaje adjunto)Si está habilitado (Yes [1] [Sí]), es posible 
seleccionar uno de los mensajes en la zona de «Message 
Configuration» (Configuración de mensaje) (Custom Mes-
sages [Mensajes personalizados]) para que aparezca de-
bajo del cuerpo del correo electrónico.

Message Number (Número de mensaje)El número del mensaje se adjuntará si 
está habilitado «Attach message» (Mensaje adjunto).

Trigger (Activador) La entrada del activador que provocará el envío del men-
saje. (1 = enviar correo electrónico)

Temperatura cinética media (MKT)
MKT se define como ‘la temperatura isotérmica que corresponde a los efectos 
cinéticos de la distribución tiempo-temperatura’.

Figura 129 Menú de MKT
El registrador calcula la MKT usando la siguiente ecuación:

donde:
Tk = La temperatura cinética media necesaria en grados Kelvin
DH = El calor de activación
R = La constante de gas universal
T1max = La temperatura máxima alcanzada durante el primer pe-

ríodo de medida (en Kelvin)
T1min = La temperatura mínima alcanzada durante el primer perío-

do de medida (en Kelvin)
TNmax = La temperatura máxima alcanzada durante el n período de 

medida (en Kelvin)
TNmin = La temperatura mínima alcanzada durante el n período de 

medida (en Kelvin)
N = El número total de periodos de medida

Nota: La temperatura de entrada debe estar en Kelvin. Puede obtenerse ajustando 
las unidades del canal correspondiente en Kelvin o usando el canal matemático 
virtual para convertir las unidades de medida en Kelvin. (K = C + 273,15 o K = 0,555 
(F -32) + 273,15)

-D

-D -D -D-D
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Parámetros de configuración
MKT Type (Tipo MKT)0 = entrada sencilla; 1 = entrada grupo.
MKT enable (Habilitar MKT)1 (Yes [Sí]) habilita la función de MKT
Input (Entrada) Para MKT Type (Tipo MKT) = «Single» (Único), seleccio-

ne la fuente de la que se obtendrá la MKT. Puede ser un 
canal de entrada con escala en Kelvin, o bien un canal ma-
temático empleado para convertir una escala de tempera-
tura diferente en Kelvin (véase «Note» [Nota] anterior).

Group (Grupo) Para MKT Type = «Group» (Grupo), seleccione la fuente 
de la que se obtendrá la MKT.

PV El valor de proceso de MKT actual
Status (Estado) Muestra el estado del valor de salida.

0: La variable del proceso es correcta.
1: Desactivado. El canal está configurado para estar des-
activado
2: Over range (Superior al rango). La señal de entrada es 
mayor que el límite superior del rango de hardware selec-
cionado
3: Under range (Inferior al rango). La señal de entrada es 
menor que el límite inferior del rango de hardware selec-
cionado
4: Hardware error (Error de hardware) Fallo del hardware 
de entrada
5: Ranging (Rango) Se está configurando el rango del 
hardware de entrada según lo exigido por la configuración 
del rango.
6: Desbordamiento Desbordamiento de variable del pro-
ceso, posiblemente debido a que el cálculo ha intentado 
sumar un número pequeño a un número relativamente 
grande.
7: Bad (Malo) La variable de proceso no es correcta y no 
debe usarse.
8: Hardware exceeded (Hardware excedido) Se han exce-
dido las capacidades del hardware en el momento de la 
configuración, por ejemplo la configuración se ha ajustado 
en de 0 a 40 V cuando el hardware de entrada es capaz 
de 12V como máximo.
9: No data (Sin datos). Muestreos de entrada insuficientes 
para realizar el cálculo.

Resolution (Resolución)Número de posiciones decimales (de 0 a 6)
Num of Samples (Número de muestreos)Introducir el número de muestreos 

con las que se medirá la MKT.
Sample Interval (Intervalo de muestreo)Introducir el período de tiempo, en se-

gundos, entre muestreos. En cada intervalo de muestreo, 
se introducen en la ecuación las temperaturas máxima y 
mínima alcanzadas por la fuente de entrada desde el últi-
mo muestreo.

Heat of Activation (Calor de activación)El valor predeterminado es un valor pro-
medio basado en muchas reacciones orgánicas comunes. 
Permite al usuario introducir un valor alternativo, si se co-
noce.

Reset «Yes» (Sí) (1) restablece el cálculo.

EJEMPLO 1: Para producir un valor de MKT para cuatro semanas, tomando 
muestreos cada día.

Número de muestreos = 28
Intervalo de muestreo = número de segundos en un día = 24 x 60 x 60 = 86.400
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EJEMPLO 2: Para producir un valor anual de MKT, tomando muestreos cada 
semana.

Número de muestreos = 52
Intervalo de muestreo = número de segundos en una semana = 7 x 24 x 60 x 60 

= 604.800

Notas:

1. Esta función produce un resultado ‘continuo’. Es decir, cuando se ha 
tomado el último muestreo (N), el siguiente muestreo (N + 1) sustituye al 
muestreo 1, el muestreo (N + 2) sustituye al muestreo 2, etc.

2. Durante el primer muestreo, se introduce los valores de temperatura 
actual mínima y máxima en la ecuación a la velocidad de iteración del 
registrador (a 8 Hz).

Flujo másico
Nota: La precisión general de una instalación de medida de flujo depende de una 
serie de factores que están fuera del control del fabricante del registrador de datos. 
Por esta razón, el fabricante del registrador de datos no se responsabiliza de la 
exactitud de los resultados obtenidos mediante las ecuaciones de flujo másico 
implementadas en su software.

Figura 130 Menú de flujo másico

Parámetros de configuración
Mode (Modo) Seleccionar 0: desactivado; 1: Flujo másico lineal; 2: Flujo 

másico raíz cuadrada
Linear Flow (Flujo lineal)

Valor de flujo calculado para transductores lineales
Square root Flow (Flujo raíz cuadrada)

Valor de flujo calculado para transductores de tipo raíz 
cuadrada

Flow (Flujo) Entrada desde el caudalímetro
Delta P El valor de escala completa de la presión de gas diferencial
Temperature (Temperatura)

Temperatura del fluido en Kelvin
Pressure (Presión) Presión absoluta del gas en kPa(A)
Scale Output (Salida de escala)

Salida de escala completa del caudalímetro
Ma T La entrada de mA de escala completa del punto que lee la 

salida del caudalímetro
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Gas Constant (Constante de gas)
La constante de gas correspondiente (J/kg-K) de las ta-
blas publicadas.

Z Factor de compresibilidad. Una medida relacionada con la 
densidad sobre en qué medida un gas se desvía de un gas 
«perfecto» bajo una serie de condiciones de temperatura 
y presión, que se obtiene mediante la ecuación:

donde:

Z Factor de compresibilidad.

P Presión absoluta del gas en kPa(A)

T Temperatura absoluta del gas (Kelvin)

 densidad del gas a la presión P y la temperatura T (de las     
 tablas publicadas)

Resolution (Resolución)
Número de posiciones decimales para el cálculo del flujo 
másico (de 0 a 6).

Vapor saturado

Figura 131 Cálculos de vapor saturado

Mode (Modo) 0 = desactivado; 1 = flujo másico; 2 
= flujo térmico;
3 = calor consumido; 4 = ambos 
flujos

Heat flow (Flujo de calor)
Para aplicaciones de flujo térmico, 
es el valor de salida del flujo térmico calculado.

Mass flow (Flujo másico)
Para aplicaciones de flujo másico, es el valor de salida del 
flujo másico calculado.

Heat consumed (Calor consumido)
Para el modo = 3, es el valor calculado del calor consumido.

Flow (Flujo) Conectado (en el editor gráfico de conexiones) al canal 
que suministra el flujo medido.

Return Temperature (Temperatura de retorno)
Para cálculos del calor consumido, la temperatura de retorno

Use (Uso) Permite al usuario seleccionar 0 (temperatura) o 1 (pre-
sión en MPa) para el cálculo.

r
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Temperature (Temperatura)
Aparece solo si Use = Temperatura. Introducir el número 
del canal que proporciona la temperatura del vapor.

Fahrenheit No (0) = Usar Celsius; Sí (1) = Usar Fahrenheit.
Pressure (Presión) Aparece solo si Use = Presión. Introducir el número del ca-

nal que proporciona la presión del vapor.
Dryness (Sequedad) Introducir un valor entre 0 y 100 para representar la seque-

dad del vapor. 0 = sin vapor; 100 = sin líquido.
Resolution (Resolución)

El número de posiciones decimales que se usarán para la 
salida (de 0 a 6).

Informe
Permite establecer hasta 10 informes para enviar datos a una impresora. Cada 
informe puede contener hasta 10 objetos de datos.

Figura 132 Nivel superior del menú
Report Desc (Descripción del informe)

Permite al usuario introducir una 
descripción para el informe

Report Num Fields (Campos numéricos de informe)
Especifica el número de objetos de 
datos que aparecerán en el informe.

Destino de informe 0 = Grupo: 1 = Impresora; 2 = Grupo de impresora.
Report Trigger (Activador de informe)

1 = Enviar informe
Group Num (Número de grupo)

El número del grupo de destino para el informe.

Configuración del campo Informe

Figura 133 Campo de menú
Field ‘n’ Type (Tipo de campo «n)

»n = 1 al número de campos introducido en el menú principal.
0: Time date (Datos de hora)Hace que la fecha y hora de gene-

ración del informe se incluyan en el informe
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1: Raw Text (Texto sin formato)
Permite al usuario introducir un mensaje de texto 
con hasta 60 caracteres.

2: PV Permite incluir en el informe un valor de proceso del 
punto especificado (incluido descripción y unida-
des)

3: Batch Field (Campo de lote)
Puede incluirse en el informe el campo de lote 1.

4: Cust Msg (Mensaje personalizado)
Puede seleccionarse un mensaje para incluirlo en el 
informe. Consulte «Custom Messges» (Mensajes 
personalizados) para obtener más detalles de la 
configuración del mensaje.

5: Line Feed (Salto de línea)
Permite dejar una o más líneas en blanco. Puede 
resultar útil al final de un informe. Line Feed (Salto 
de línea) se aplica solo a las impresoras y se ignora 
al enviar informes a grupos.

Field ‘n’ Input (Entrada de campo «n»)
Permite elegir un punto cuando se selecciona «PV» como 
«Field Type» (Tipo de campo). El punto se selecciona de 
una lista que contiene todos los canales de entrada, cana-
les derivados, totalizadores, etc. del dispositivo.

Field ‘n’ Cust Msg (Mensaje personalizado de campo «n»)
Selecciona un número de mensaje para su inclusión, si 
Type (Tipo) = «CustMsg» (Mensaje personalizado).

Field ‘n’ Batch Group (Grupo de lote de campo «n»)
Número de grupo del lote

Field ‘n’ Text (Texto de campo «n»)
Una entrada de cadena de texto para Field Type (Tipo de 
campo) = RawText (Texto sin formato)

Field ‘n’ Style (Estilo de campo «n»)
Consulte la figura 135 para ver los ejemplos de «Normal», 
«Bold» (Negrita), «Emphasised» (Resaltado) y «Banner» 
(Titular). Para todos los estilos, si el texto es demasiado 
largo para caber en una línea, se «ajusta» como se mues-
tra (para el estilo normal) en la figura 135.

Figura 134 Estilos de impresión de campo

Lote
Esta sección permite al operador iniciar lotes establecidos en «Batch Control» 
(Control de lotes) "Configuración de lote" en la página 60.
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Figura 135 Menú de lote
Como se muestra en la figura anterior, algunos de los objetos (como «Batch fields» 
[Campos de lotes], «Fields 1 to 4» [Campos de 1 a 4]), reflejan los ajustes realizados 
en "Configuración de lote" en la página 60. El usuario puede completar los demás 
campos antes de iniciar el lote. Como es habitual, los campos disponibles para su 
edición dependen del contexto.

Start Date (Fecha de inicio)Muestra la fecha de inicio del lote actual.
Start Time (Hora de inicio)Muestra la hora de inicio del lote actual.
Duration (Duración) Muestra la duración (tiempo transcurrido) del lote actual.
Active (Activo) 0 (No) = no activo; 1 (Sí) = activo
Mode (Modo) 0 = continuo; 1 = arranque/detención; 2 = ciclo de esterili-

zador
Batch Fields (Campos de lote)El número de campos de lote activo actualmente 

y para el que deben configurarse campos de datos.
Batch Field 1 (Campo 1 de lote)La cadena de texto que se usará con «Data1» 

(Datos1) si «Batch Field 1» (Campo 1 de lote) (a continua-
ción) se ajusta en «Text» (Texto). En caso contrario, si 
«Batch Field 1» (Campo 1 de lote) se ajusta en «Use PV 
Start» (Usar PV de inicio) se utiliza el valor de la entrada 
de disparador.

Field 2 to ‘N’ (Campo 2 a «N»)La cadena de texto que se usará con de «Data 
2» (Datos 2) a «Data N» (Datos N), donde «N» es el valor 
de «Batch Fields» (Campos de lote).

On Start Log (En inicio del registro)Introducir el número de campos del 1 al 10 
que se incluirán en el archivo histórico en «Batch Start» 
(Iniciar el lote).

On Stop Log (En detención del registro)Introducir el número de  campos del 1 
al 10 que se incluirán en el archivo histórico en «Batch 
Stop» (Detener el lote).

On New Clear (En nuevo borrado)Solo para lotes «Use Text» (Usar texto), per-
mite al usuario borrar una o varias de las entradas del lote 
en cada inicio de lote. En el ejemplo anterior, si el usuario 
introduce un número de lote de, por ejemplo, 120825.001, 
con nombre de cliente: FishesRus, nombre de operador: 
Marvin, supervisor: Fred y, después, ajusta «On New 
Clear» (En nuevo borrado) en «1», provoca que el número 
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de lote se borre y tenga que volver a introducirse cada vez 
que se inicia un nuevo lote.
De forma similar, ajustar «On New Clear» (En nuevo bo-
rrado) en «2» provoca que se borren el valor del número 
de lote y el valor «Customer Name» (Nombre personaliza-
do). No es posible iniciar un nuevo lote sin introducir antes 
valores nuevos.

Print Versions (Versiones de impresión)Ajustar en 1 (Yes [Sí]) si van a incluirse 
los números de versión en la impresión.

Name Files by batch (Nombre de archivos por lote)Si está activado, se genera 
un nuevo archivo histórico para cada lote nuevo.

Start (Inicio) Ajustar en 1 (Yes [Sí]) para iniciar el lote.
Stop (Parada) Ajustar en 1 (Yes [Sí]) si va a detenerse el lote actual.
Data 1 to 10 (Datos del 1 al 10)Las cadenas de texto que se asociarán con los 

campos del 1 al 10, respectivamente.
PV Start (PV de inicio)El valor PV utilizado para iniciar un lote. Permite (por 

ejemplo) usar el incremento de un contador para iniciar un 
nuevo lote.

E/S Profinet
No disponible en esta versión

Servidor web

Figura 136 servidor web
Server Enable (Habilitar servidor)Permite habilitar o deshabilitar el acceso des-

de el servidor web ("Servidor web" en la página 169).
Security (Seguridad) Si está habilitada, el usuario deberá conectarse al servidor 

web usando una conexión HTTPS cifrada. Consulte la 
nota a continuación.
Si está deshabilitada, la conexión no se cifra y se permite 
el acceso usando una conexión HTTP.

Port (Puerto) El número de puerto usado por el servidor web 
Status (Estado) Inactivo. El servidor web no está activo

Preparado. El servidor web está preparado para conectar-
se
Conectado. El servidor web está conectado.

Consulte "Servidor web" en la página 169 para más detalles sobre el servidor web.

Nota: Todos los navegadores web comunes avisan de que los certificados SSL 
predeterminados incluidos con el versadac no proceden de una autoridad emisora 
reconocida, y que el certificado no coincide con el dominio desde el que se accede al 
dispositivo. Es posible confirmar las advertencias del navegador y continuar para 
acceder al dispositivo usando una conexión segura.
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Para solucionar este problema, debe obtenerse un certificado SSL válido de una de 
las muchas autoridades emisoras de certificados. Puede usarse la función de 
actualización ("Actualización" en la página 74) para descargar el certificado en el 
dispositivo. Los navegadores web mantienen una lista interna de autoridades 
emisoras de certificados reconocidas y no muestran un aviso si el certificado 
procede de una de estas organizaciones y si coincide el dominio de la red actual del 
dispositivo.

Comunicaciones serie
Consulte "Unidad de terminal del módulo controlador (IOC)" en la página 17 para 
más información sobre la configuración.

Figura 137 Menú de configuración de comunicaciones en serie
Protocolo* 0: Modbusesclavo

1: Unidad Modbus maestra. La norma EIA 485 permite la 
conexión de un dispositivo maestro y hasta 31 esclavos 
utilizando una conexión (multipunto) de tres hilos con una 
longitud de cable de hasta 1.200 m. Se recomienda 
EIA422/EIA485 para la instalación de la planta porque su 
transmisión de señal diferencial balanceada es menos 
propensa a interferencias que EIA232 en entornos ruido-
sos. 
EIA485 puede usarse con protocolos semiduplex como 
MODBUS RTU.
2: Entrada ASCII

Baud (Baudios) La velocidad en baudios de una red de comunicaciones 
especifica la velocidad de transferencia de los datos entre 
el dispositivo y el maestro. Por lo general, el valor de la ve-
locidad de transmisión debe ser lo más alto posible para 
permitir la máxima velocidad de transferencia. El disposi-
tivo puede funcionar de manera fiable a una velocidad de 
38.400 baudios en circunstancias normales y asumiendo 
una terminación correcta de la línea. En entornos ruido-
sos, podría ser necesario seleccionar una velocidad de 
baudios menor.
Aunque la velocidad de transmisión es un factor importan-
te, cuando se calcula la velocidad de comunicación de un 
sistema, suele ser la latencia entre el mensaje que se está 
enviando y la respuesta que comienza a darse lo que do-

Entrada ASCII Modbus maestro/esclavo
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mina la velocidad de la red. La latencia es la cantidad de 
tiempo que el dispositivo necesita antes de poder respon-
der cuando recibe una solicitud.
Por ejemplo, si un mensaje consiste en 10 caracteres 
(transmitidos en 10 ms a 9.600 baudios) y la respuesta 
consiste en 10 caracteres, el tiempo de transmisión sería 
de 10 + 10 = 20 ms. Sin embargo, si la latencia es de 20 
ms, el tiempo de transmisión es ahora de 40 ms. El valor 
de latencia suele ser más alto en el caso de comandos 
que escriben sobre un parámetro, más que los que lo leen; 
este valor dependerá hasta cierto punto de la operación 
que esté realizando el dispositivo en el momento en que 
se reciba la solicitud y del número de variables que se in-
cluyan en la escritura o lectura de bloques de datos. Como 
regla general, la latencia de operaciones con valor único 
será de entre 5 y 20 ms, lo cual significa un tiempo de pro-
ceso de la operación de entre 25 y 40 ms.
Si la velocidad de transferencia supone un problema, con-
sidere la posibilidad de sustituir las transacciones de pará-
metro único por transacciones en bloque de Modbus y 
aumentar la velocidad de transmisión hasta el valor máxi-
mo fiable.

Nota: El protocolo debe ajustarse en ‘Modbus Master’ para la transmisión Modbus 
Serial. Además, «Unit ID Enable» (Habilitar ID de unidad ) debe ajustarse en 
«Instrument» (Instrumento) ("ModBus TCP" en la página 86).

Parity (Paridad) Paridad es un método para garantizar que los datos trans-
feridos entre dispositivos no han sido alterados compro-
bando que un solo byte contiene un número par o impar 
de unos o ceros en los datos. En los protocolos industria-
les suele haber capas de comprobación para garantizar 
primero que el byte transmitido está en buen estado y des-
pués que también lo está el mensaje transmitido. Modbus 
aplica una comprobación de redundancia cíclica (Cyclic 
Redundancy Check o CRC) a los datos, para asegurarse 
de que el paquete de datos está intacto. Por tanto, el uso 
de una paridad par o impar no suele aportar ningún bene-
ficio; por otro lado, como este factor aumenta también el 
número de bits binarios que se transmiten en cualquier 
mensaje, provoca un descenso del rendimiento.
0 = sin paridad; 1 = paridad impar; 2 = paridad par

Stop Bits (Detener bits)0 = 1 bit de detención; 1 = 2 bits de detención
Timeout (Tiempo de espera)Ajusta el temporizador para el maestro Modbus 

Serial o el mensaje del temporizador para la entrada ASCII 
en milisegundos

Data Bits (Datos de bits)0 = siete bits de datos;  1 = ocho bits de datos
First Start Char (Primer carácter de inicio)El valor ASCII decimal para el primer 

carácter de inicio 
Second Start Char (Segundo carácter de inicio)El valor ASCII decimal para el 

segundo carácter de inicio
First End Char (Primer carácter de fin)El valor ASCII decimal para el primer ca-

rácter de fin
Second End Char (Segundo carácter de fin)El valor ASCII decimal para el se-

gundo carácter de fin
Group 1 to 30 (Grupo del 1 al 30)1 = Enviar mensaje al grupo correspondiente.
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Detalles del protocolo ASCII
El modo ASCII permite a la unidad recibir mensajes ASCII sencillos desde, por 
ejemplo, lectores de códigos de barras, controladores lógicos programables (PLC), 
sistemas de posicionamiento global (GPS) (protocolo NMEA-0183), etc.

Los mensajes se envían a tantos grupos como estén configurados para recibirlos y 
pasan a formar parte del histórico. Además, aparecen en las visualizaciones de 
tendencia vertical y horizontal en el formato siguiente:

23/01/2013  16:05:23 Mensaje (serie)

El mensaje puede llevar como prefijo 0, 1 o 2 caracteres específicos y puede llevar 
como sufijo 0, 1 o 2 caracteres específicos. Los primer y segundo caracteres de 
inicio y fin se introducen como códigos ASCII decimales entre 0 y 127, según 
necesario. 0 = ningún carácter, 10 = alimentación de línea; 13 = retorno de carro. 
Encontrará una lista de códigos ASCII en "Códigos ASCII" en la página 217. Solo se 
requiere un carácter de inicio o fin, debe introducirse el primer carácter y el segundo 
carácter debe introducirse como cero.

Selección del grupo
Para el protocolo de entrada ASCII, permite seleccionar (Yes [Sí]) o deseleccionar 
(No) los grupos para la recepción de los mensajes.

Información de mensaje
Los caracteres se leen en un búfer, se reciben caracteres hasta el final del mensaje o 
hasta que el valor de tiempo desde el último mensaje supere el valor de 
temporizador introducido. La fecha, hora y ‘(Serial)’ se añaden como prefijos del 
mensaje que, a continuación, se envía a los grupos seleccionados. La fecha y la 
hora hacen referencia al momento en que se recibió el primer carácter del búfer. Si 
se configuran caracteres de inicio del mensaje, los caracteres se leerán en el búfer 
solo después de haber recibido estos caracteres.

El búfer almacena hasta 120 caracteres más fecha/hora, etc. y caracteres de 
inicio/fin de mensaje. Los demás caracteres se descartan hasta que se recibe el final 
del mensaje o se produce una temporización.

Los caracteres del mensaje por debajo de Hex 20 (decimal 32) se sustituyen por 
signos de interrogación (?).

Los caracteres del mensaje por encima de Hex 7F (decimal 127) se tratan como 
Unicode.

Reglas de mensajes
1. Si no se configuran caracteres de inicio de mensaje pero se ha introducido 

un valor de temporización distinto de 0, el nuevo mensaje empieza 
después de que ha transcurrido el período de temporización.

2. Si no se configuran caracteres de fin de mensaje pero se ha introducido un 
valor de temporización distinto de 0, el nuevo mensaje finaliza después de 
que ha transcurrido el período de temporización.

3. Si no se configuran caracteres de inicio de mensaje y se ha introducido un 
valor de temporización distinto de 0, se ignoran todos os caracteres antes 
de los caracteres de inicio de mensaje.
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4. Si se configuran caracteres de inicio de mensaje pero no se han 
configurado mensajes de fin ni temporización, la configuración no será 
válida. Si esta configuración es un requisito, si se introducen los mismos 
caracteres como caracteres de fin de mensaje, cada mensaje se enviará a 
los grupos cuando se reciba el siguiente mensaje.

5. Si no se introducen caracteres de inicio ni fin del mensaje y no se 
introduce un valor de temporización, se descartan todos los caracteres 
recibidos 

6. Si un mensaje recibido se considera corrompido, se descarga y el 
software esperará a recibir otro mensaje.

7. Los caracteres de inicio y fin de mensaje se borran antes de enviar los 
mensajes a los grupos.

Diagnósticos
Ofrece una visualización solo lectura de una serie de objetos de diagnóstico.

Figura 138 Pantalla de diagnóstico
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Comunicaciones esclavas de Moodbus/TCP
Instalación

La instalación de la conexión ModBus consiste en conectar un cable de Ethernet 
estándar entre el conector RJ45 de la parte inferior de la unidad IOC y un ordenador, 
ya sea directamente o a través de una red.Puede utilizarse un cable directo o 
cruzado.

Introducción
El protocolo TCP ModBus permite que la unidad funcione como un dispositivo 
«esclavo» de uno o más ordenadores conectados a través del conector RJ45 de la 
parte posterior de la unidad.Cada registrador debe tener su propia dirección IP 
(Protocolo de Internet), configurada como se explica en "Interfaz" en la página 80 
(Network.Interface).

ModBus TCP (Protocolo de Control de Transmisión) es una variante de la familia 
ModBus de protocolos de comunicaciones. Se emplea para la supervisión y control 
de equipos automatizados y utiliza protocolos TCP/IP para regular el uso de 
mensajes ModBus en un entorno de intranet o internet.La mayoría de los detalles de 
Modbus de este manual se encuentran en el archivo openmbus.doc, disponible en 
http://www.modbus.org/default.htm.El documento mencionado incluye también 
instrucciones de ejecución para los usuarios.

Nota: El protocolo ModBus permite leer o escribir un máximo de 255 bytes de datos 
en una sola operación.Por este motivo, el número máximo de registros estándar (16 
bits) a los que se puede acceder en una operación es 255/2 = 127, mientras que el 
número máximo de registros IEEE (32 bits) es 127/2 = 63.

Códigos de función
Se admiten los códigos de función de Modbus 3, 4, 6, 8, y 16 definidos en Figura 
139.

Figura 139 Definición de los código de función de Modbus

Códigos de diagnóstico
La subfunción 00 (Devolver datos de consulta) del código de función 08 hace un 
"eco" de la consulta (lazo cerrado).

Código Definición en ModBus Descripción

03

04

06

08

16

Leer registros de salida

Leer registros de entrada

Predefinir un registro

Diagnósticos

Predefinir varios registros

Lee el contenido binario de registros de salida.Los códigos 3
y 4 funcionan de forma idéntica en esta implementación.

Lee el contenido binario de registros de salida.Los códigos 3
y 4 funcionan de forma idéntica en esta implementación.

Escribe un valor concreto en un registro completo.

Realiza una prueba simple de lazo cerrado.

Escribe valores en varios registros de salida.
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Códigos de excepción
TCP ModBus incluye códigos reservados que se usan para excepciones.Estos 
códigos proporcionan información sobre errores relacionados con peticiones 
fallidas.Las excepciones se señalizan sumando 80 (hexadecimal) al código de 
función de la petición, seguido de uno de los códigos indicados en Figura 140.

Figura 140 Códigos de excepción

Data Types (Tipos de datos)
Se pueden utilizar los siguientes tipos de datos:

1. Valores analógicos de16 bits con signo, complemento de 2 y punto decimal 
implícito.La posición del punto decimal se tiene que configurar tanto en el 
registrador como en el servidor.

2. Valores enteros con signo de 16, 32 y 64 bits.

3. Valores enteros sin signo de 16 bits.

4. Valores de punto flotante IEEE de 32 bits.

5. Cadenas de tamaño limitado, que se puede transmitir por TCP ModBus en 
formato Unicode usando un único grupo sin multiplexar de registros 
consecutivos.

Codificación de datos
ModBus utiliza un tipo de representación denominado «Big Endian» para direcciones 
y datos.Esto quiere decir que, cuando se transmite una cantidad numérica más 
grande que 1 byte, el primer byte que se envía es el más significativo.Por ejemplo, el 
valor hexadecimal de 32 bits 12345678 se transmitiría como 12, seguido de 34, 
seguido de 56 y finalmente 78.

Escrituras no válidas de múltiples registros
Si un registrador recibe una petición de escritura de múltiples registros, es posible 
que una o más peticiones sean rechazadas.Cuando eso ocurre, el registrador acepta 
todas las peticiones válidas de escritura e ignora las demássin generar ninguna 
respuesta de error.

Código
Dec Hex
01

02

03

04

09

10

11

01

02

03

04

09

0A

0B

Función no válida

Dirección de datos no válida

Valor de datos no válido

Error de dispositivo esclavo

Subfunción no válida

Gateway no disponible
Dispositivo de gateway no 
responde

Código Descripción (más información en las especificaciones de ModBus)

Se ha recibido un código de función no válido.

Se ha recibido una dirección de datos no válida.

Se ha recibido un valor de datos no válido.

Se ha producido un error irrecuperable en el dispositivo.

Se ha recibido una subfunción no válida.

Dispositivo de gateway no responde

El dispositivo no está en la red.
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Desconexión de la unidad maestra por tiempo de espera excesivo
Mientras el dispositivo está copiando archivos, es posible que las comunicaciones 
sean lo suficientemente lentas como para causar desconexiones por tiempo de 
espera excesivo.El dispositivo ModBus maestro debe estar configurado con un 
tiempo de espera lo bastante largo para evitar desconexiones molestas durante la 
copia de archivos.

Lista de parámetros
La lista de parámetros accesibles mediante comunicaciones puede encontrarse en 
la lista SCADA incluida en el archivo de ayuda de parámetros de iTools.Esta lista 
incluye direcciones tanto decimales como hexadecimales.Las enumeraciones (es 
decir, lo que significan los valores retornados) se encontrarán tanto en la ayuda de 
parámetros como en las distintas ventanas de configuración de iTools.

Direcciones
Las direcciones canónicas son generalmente las direcciones publicadas en los 
manuales de comunicaciones para usuarios de controladores de comunicaciones de 
terceros.

A menudo no son las direcciones utilizadas por iTools porque el mismo parámetro 
existe también como una segunda dirección donde puede ser leída con más 
precisión, como un punto entero o flotante IEEE de 32 bits, en vez de como un 
entero escalado.Algunos controladores de comunicaciones de terceros no admiten 
esta funcionalidad avanzada, por lo que es más difícil (o imposible) configurarlos 
cuando utilizan estas direcciones.
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Dispositivos USB
Los dispositivos enumerados a continuación pueden conectarse a un conector USB 
en la unidad de terminal IOC.

1. Unidad de memoria

2. Impresora

Notas:

1. Si el dispositivo se utiliza en un entorno con mucho «ruido» eléctrico, se 
recomienda trasladar el conector USB a la parte delantera del panel usando un 
prolongador cortopara evitar el riesgo de «bloqueo» del dispositivo USB, en cuyo 
caso habría que retirar y volver a conectarlo.Para unidades de memoria, los 
fallos debidos a EMC durante operaciones de escritura pueden dañar los datos 
en la unidad de memoria.Por este motivo se recomienda hacer una copia de 
seguridad de los datos antes de conectar la unidad y revisarlos después de 
desconectarla.

2. Al utilizar un cable alargador USB, debe utilizarse un cable apantallado de alta 
calidad.La longitud total del cable USB entre el dispositivo y el puerto USB no 
debe superar los 1,5 metros.

Unidad de memoria
El uso de la unidad de memoria como dispositivo de archivado se recoge en las 
secciones correspondientes de este manual.

Impresora
Permite la impresión de informes en una impresora de etiquetas Star 700 TPS II.



Versadac Servidor web

HA031352 Edición 3 179

Servidor web
Introducción

La opción de «Web Server» (Servidor web) permite al usuario ver un grupo de 
registro seleccionable y visualizar los canales en este grupo como un gráfico, como 
un gráfico de barras o valores numéricos. El usuario también puede reconocer 
alarmas, lotes de control, introducir datos del campo del lote y archivado de control si 
están ajustados los permisos de usuario relevantes en el editor de seguridad 
("Pestaña de perfiles de usuario" en la página 63).

Notas:
1. Es posible conectar hasta cuatro ordenadores al dispositivo versadac.
2. El ordenador (PC, tablet o teléfono móvil) debe usar uno de los siguientes 

navegadores o, de lo contrario, el servidor web podría no funcionar:

Google Chrome V22.0 o superior

Google Mobile Chrome (tecnología Android Mobile versión «4.0 Ice cream 
sandwich» o superior)

Internet Explorer V9.0 o superior

Mobile Safari (tecnología Apple Mobile versión IOS 5.0 o superior).
3. Los navegadores deben estar configurados para admitir Cookies, y la 

compatibilidad con caché de archivos también debe estar habilitada.

Conectando
1. Compruebe que el ordenador y el dispositivo versadac estén en la misma red 

("Interfaz" en la página 80) y que el ordenador utiliza uno de los navegadores 
indicados en la nota 2 anterior.

2. Ajuste «Server Enable» (Servidor habilitado) en «Enabled» (Habilitado) en la 
configuración de Web Server (Servidor web) (véase «Web Server» [Servidor 
web] en la página 152). En la misma zona de configuración, compruebe que 
«Security» (Seguridad) esté «Enabled» (Habilitado) o «Disabled» 
(Deshabilitado), según necesario.

3. Compruebe que «Web Server Account» (Cuenta del servidor web) esté 
seleccionado para el usuario ("Pestaña de perfiles de usuario" en la página 63), 
y que estén habilitados los permisos correspondientes. (Véase también la nota 
siguiente). 

4. Asegúrese de que el versadac no está en el modo de configuración ("Acceso a 
la configuración" en la página 40).

5. En el navegador web, escriba: http://IP1.IP2.IP3.IP4 o, si la seguridad está 
habilitada, https://IP1.IP2.IP3.IP4, donde IP1.IP2.IP3.IP4 es la dirección IP del 
versadac (véase "Interfaz" en la página 80), e inicie la búsqueda.

Nota: No es posible seleccionar «Web server Account» (Cuenta del servidor web) 
(la casilla de verificación está sombreada) para las ID de usuario predeterminadas 
(Logged out [Desconectado], Operator [Operador], Supervisor o Engineer 
[Ingeniero]).
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Si todo lo anterior es satisfactorio, se abre el navegador web y muestra la página de 
inicio de sesión. Una vez se haya iniciado sesión con éxito, aparece la ventana de 
inicio, como se describe en "Ventana de inicio" en la página 180.

Figura 141 Pantalla de inicio de sesión y detalles de inicio de sesión

Ventana de inicio
Figura 142 muestra una página de inicio típica, vinculada con los distintos objetos de 
la página.

Figura 142 Página Inicio

Diagrama de barras

Hacer clic para ver
Configuración IOC

Gráfico de líneas
Numéricos

Gráfico histórico

Resumen de alarmas
Mensajes

Notas del operador

Resumen de lote

Demanda de archivo

Resumen del
sistema

Resumen de alarmas

Vista de Configuración del 
módulo de E/S (Todavía sin 
implementar)

Haga clic para 
mostrar la 
pantalla de 
desconexión

Resumen del 
sistema
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Selección del grupo
Al hacer clic en este objeto se abre una lista de los grupos disponibles, que permite 
al usuario seleccionar un grupo para tendencias, etc. Si el grupo se ha configurado 
con una descripción, aparecerá dicha descripción en vez del «Group N» (Grupo N) 
predeterminado.

Figura 143 Lista de grupos

Análisis de tendencias
El tipo de tendencia seleccionado afecta a todos los grupos, no solo al actual.

Nota: El número máximo de puntos que puede mostrarse en cualquier grupo es de 
20.

Diagrama de barras
Al hacer clic en «Bargraph» (Diagrama de barras) se abre la visualización del gráfico 
de barras predefinida (Figura 144) para el grupo seleccionado. En este ejemplo hay 
seis puntos registrados. Si el usuario ha seleccionado un grupo vacío, aparece un 
mensaje de advertencia. Consulte "Configuración de grupo" en la página 88 para 
más detalles sobre la configuración de «Group» (Grupo).

La escala vertical se define según los valores superior e inferior asociados con todos 
los puntos en el grupo.
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Figura 144 Diagrama de barras predeterminado
Al hacer clic en el botón de opciones se abre la página de opciones del gráfico de 
barras, parte de la cual se ilustra a continuación.

Figura 145 Opciones del diagrama de barras

Opciones

Tipo de gráfico
Son posibles tres tipos de representación gráfica: Plano, gradiente y 3D. A 
continuación, Figura 146 es una composición que muestra los tres tipos juntos a 
modo de comparación. Por supuesto, no es posible combinar los tipos de gráficos de 
esta forma en el «Web Server» (Servidor web).

Leyenda

Lista de puntos 
incluidos en el grupo.
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Después de realizar cualquier cambio, debe hacer clic en el botón «Save» (Guardar) 
para confirmar los cambios y en el botón «Back» (Volver) para regresar a la 
visualización del gráfico de barras. Al hacer clic en el botón «Back» (Volver) antes de 
guardar se descartarán los cambios realizados.

Figura 146 Comparación de distintos tipos de diagramas de barras

Leyenda
Permite mostrar o no la leyenda, según sea necesario. La leyenda 
indica cada punto del grupo mediante un color y nombre, en el 
orden en el que se introducen en la configuración del grupo. Es una 
ayuda para determinar cuál es cada punto en la visualización. Si se 
ajusta en «Hide» (Ocultar), la visualización de tendencia se expande 
hasta ocupar la anchura disponible de la página.

Tipo de fondo
Permite al usuario seleccionar «Transparente» (Transparente) (gris), «White» 
(Blanco) o «Black» (Negro) como color de fondo para la visualización. Las 
cuadrículas (si se muestran) aparecen en un color que contrasta con el color de 
fondo seleccionado.

Posiciones decimales
El número de posiciones decimales para los valores visualizados.

Cuadrícula
La cuadrícula puede mostrarse («Show») u ocultarse («Hide») según sea necesario.

Alineación de valores
Los valores mostrados para los tipos de gráfico de barras 
plano o 3D pueden mostrarse en horizontal (como se 
muestra arriba) o en vertical (Figura 147).

Plano

Gradiente

3D

Figura 147 Alineación 
vertical
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Lista de puntos
Esta lista incluye todos los puntos en el grupo 
seleccionado, junto con una indicación de si cada uno 
se incluye en la visualización (ON) o no (OFF). Para 
excluir un punto, haga clic en «ON» (Activado). Para 
incluirlo, haga clic en «OFF» (Desactivado).

Gráfico de líneas
Este tipo de visualización muestra los puntos del grupo como tendencias sobre una 
gráfica que va de derecha a izquierda. Figura 149 Muestra el diseño de tabla 
predeterminado. La cantidad de datos mostrada depende del período de muestreo 
seleccionado en el menú de opciones.

Figura 149 Visualización del gráfico de líneas
Al hacer clic en el botón de opciones se abre la página de opciones del gráfico de 
líneas, parte de la cual se ilustra a continuación.

Figura 148 Estado de 
visualización del punto

Datos más 
antiguos de 
esta página

Datos más 
recientes
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Figura 150 Opciones de gráfico de líneas

Opciones

Grosor del trazado
Permite elegir «Narrow» (Estrecha), Normal (predeterminado) o «Wide» (Ancha) 
como el grosor del trazado. Figura 151 es una composición que muestra los tres 
grosores juntos a modo de comparación. Está claro que esto no puede suceder 
nunca en un sistema real, ya que solo es posible elegir un grosor en cada momento. 
El grosor de línea seleccionado se aplica a todos los grupos y visualizaciones del 
histórico.

Figura 151 Ejemplos de grosor del trazado

Estrecho

Normal

Ancho
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Figura 151 muestra la visualización de tendencia sobre un fondo blanco en vez del 
fondo transparente (gris) predeterminado. El color de fondo (en «Background Type» 
[Tipo de fondo]) se selecciona como se describe en "Diagrama de barras" en la 
página 181.

Leyenda, tipo de fondo y cuadrículas
Como se describe en "Diagrama de barras" en la página 181 anteriormente.

Período de muestreo
Permite seleccionar un período de muestreo para la visualización del gráfico de 
líneas. El período de muestreo puede ajustarse en una serie de valores, como se 
muestra en Figura 152 que también indica el período de tiempo que se visualiza en 
la página para cada selección. La selección se aplica a todos los grupos y a los 
datos del histórico.

Nota: El ancho de la pantalla contiene 100 muestreos

Figura 152 Selección de período de muestreo

Lista de puntos
Como se describe para los diagramas de barras en "Diagrama de barras" en la 
página 181

Numéricos
Este tipo de visualización muestra los puntos del grupo como valores numéricos 
sobre los colores de fondo de los puntos. Figura 153 muestra un ejemplo por 
defecto.

Figura 153 Pantalla numérica
Al hacer clic en el botón de opciones se abre la página de opciones de numéricos, 
parte de la cual se ilustra a continuación en Figura 154.

Predeterminada

Período de Cantidad de datos 

1 seg
2 segundos
5 segundos

10 segundos
20 segundos
30 segundos

1 minuto

1 minuto 40 segundos
3 minutos 20 segundos
8 minutos 20 segundos
16 minutos 40 segundos
33 minutos 20 segundos
50 minutos
100 minutos
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Figura 154 Opciones numéricas

Opciones

Canal y tamaño de la fuente de PV
Permite seleccionar «Small» (Pequeña), Normal o Large (Grande) para uno o los 
dos nombres del punto y su valor asociado. Figura 155, a continuación, muestra los 
tres valores a modo de comparación, aunque no es posible visualizar más de un 
tamaño a la vez.

Posiciones decimales
El número de posiciones decimales para los valores visualizados.

Figura 155 Comparativa de tamaño de fuente

Pequeño

Normal

Grande
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Nota: Figura 155 muestra el mismo tamaño de fuente usado para el identificador 
del punto «Channel Font Size» (Tamaño de fuente de canal) y para el valor «PV Font 
Size» (Tamaño de fuente de PV). También es posible utilizar un tamaño de fuente 
para el canal y otro para el PV.

Gráfico histórico
El gráfico histórico es una visualización de gráfico de líneas que muestra el histórico 
de tendencias del grupo, empezando por los últimos datos, que permite navegar 
hacia atrás por las seis pantallas de datos anteriores. Como con un gráfico de líneas 
normal, la cantidad de datos mostrada se fija en 100 puntos, pero como el intervalo 
de tiempo entre los puntos depende de la frecuencia de muestreo, el período de 
tiempo para todo el gráfico varía en consecuencia.

Se muestran las horas y fechas del principio y final de cada página del histórico, y los 
botones «Previous Data» (Datos anteriores) y «Next Data» (Siguientes datos) 
permiten la navegación.

El color de fondo, grosor del trazado, etc. son como se selecciona en la página 
«Options» (Opciones) (que se describe anteriormente en Diagrama de barras y 
Gráfico de líneas). Figura 156 muestra un ejemplo por defecto de página de 
histórico.

Figura 156 Típica página de histórico

Páginas de resumen

Resumen de alarmas
Esta página muestra el estado actual de todas las alarmas de puntos en el grupo 
actual.

Figura 157 muestra el aspecto de los distintos tipos de alarma y los indicadores de 
reconocida y no reconocida.

Haga clic aquí para 
ver los primeros datos

Haga clic aquí para 
ver los últimos datos

Haga clic 
aquí para 
configurar 
trazados

Fecha y hora para la 
última visualización 
de datos en esta 
páginaFecha y hora 

para la 
primera 
visualización 
de datos en 
esta página
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Figura 157 Página de resumen de alarmas
Para reconocer una o todas las alarmas, haga clic en la alarma que desea reconocer 
y, después, haga clic en dicha alarma o en «All alarms in group» (Todas las alarmas 
en grupo), según sea necesario (Figura 158)

Figura 158 Reconocer alarma
Para salir de la página de reconocer sin reconocer ninguna alarma, haga clic en el 
botón «X».

Mensajes
Al hacer clic en «Message» (Mensaje) se abre la primera página de resumen de 
mensaje, un ejemplo de la que se muestra en Figura 159, a continuación. La lista 
completa incluye los últimos 30 mensajes para el grupo actual, en orden cronológico.

Al hacer clic en el icono de actualización en la parte inferior de la página se 
actualiza la lista para mostrar cualquier mensaje que haya llegado desde 
que se abrió la página de resumen de mensaje o desde la última operación 
de actualización.

Absoluta alta

Desviación alta

Status (Estado) = activo 
reconocido

Absoluta baja
Desviación baja
Banda de desviación
Variación creciente

«Status» (Estado) = 
activo no reconocido

Variación decreciente

Haga clic aquí para salir 
de la página sin 
reconocer las alarmas.



Servidor web Versadac

190 HA031352 Edición 3 

Figura 159 Página de resumen de mensajes
Hacer clic en el botón «Options» (Opciones) permite al usuario filtrar los mensajes 
(Figura 160) para que solo se muestren los mensajes de una categoría determinada.

Figura 160 Filtro de mensajes

Notas del operador
Esta página permite al usuario escribir y enviar una «Custom Note» (Nota 
personalizada), o enviar una de las diez notas configuradas en la configuración del 
grupo (véase "Notas" en la página 92) en el archivo histórico.

Figura 161 muestra la página, donde se ha configurado la «Nota 1» (Nota 1).

Utilice la barra de 
desplazamiento para 
mostrar los mensajes 
anteriores.
(Solo aparece si hay 
más mensajes que 
pueden mostrarse en la 
altura de una página).

Icono de actualizar 
pantalla
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Figura 161 Página de resumen de notas del operador
Para enviar las notas de 1 a 10, el usuario hace clic en la nota que desea y, después, 
en «Send» (Enviar) en el mensaje de configuración que aparece (para «Note 1» 
[Nota 1]) en Figura 162.

Figura 162 Confirmar envío de la nota
El envío de la nota personalizada se realiza del mismo modo, excepto en que el 
usuario puede introducir el texto que desee (Figura 163) antes de hacer clic en 
«Send» (Enviar).

Figura 163 Entrada de texto de nota personalizada

Resumen de lote
Consulte"Configuración de lote" en la página 60 y «Batch» (Lote) en la página 150 
para más detalles sobre el control de lotes y la configuración.

La página «Batch Summary» Resumen de lote muestra el resumen del lote para 
cada grupo de registro actual (si Batch Scope está ajustado en ‘Group’), o para todo 
el dispositivo (si Batch Scope está ajustado en ‘Instrument’).

A continuación,Figura 164 muestra una página con tres lotes de grupo, los dos 
primeros están en ejecución y el tercero está detenido.

Haga clic aquí 
para salir de la 
página sin enviar

Haga clic aquí 
para salir de la 
página sin enviar



Servidor web Versadac

192 HA031352 Edición 3 

Figura 164 Página de resumen de lotes
Al hacer clic en cualquiera de los campos aparecerá la página de control del lote 
para el grupo seleccionado. Figura 165 muestra un ejemplo para un lote de modo 
«Start/Stop» (Inicio/Detención) en ejecución. 

Figura 165 Editor de control de lotes
La página para lotes detenidos o para lotes continuos es idéntica, excepto en que el 
botón «Stop» (Parar)  es sustituido por dos botones: «Store» (Archivar) que permite 
guardar los cambios para iniciar después el lote y «Start» (Iniciar) para iniciar el lote. 
Figura 166 muestra los tres botones.

Figura 166 Botones «Save/Store/Back» (Guardar/Archivar/Volver)

Demanda de archivo
Esta página permite al usuario iniciar una copia manual en una unidad de memoria 
USB o mediante FTP en un ordenador.

Estado = en 
ejecución
Estado = detenido

Campos de lote 
editables

(Solo lecturas para lotes 
«Start/Stop» 
[Inicio/Detención] en 
ejecución)

Haga clic aquí para 
detener el lote

Haga clic aquí para 
regresar a la página 
de resumen
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Figura 167 Página «Demand archive» (Demanda de archivo)

Parámetros
Status (Estado) Visualización de solo lectura del estado de archivo como 

‘Activo’ o ‘Inactivo’.
Last Archive (Último archivado)La fecha y hora del último archivado con éxito 

(incluida la información local)
Archive To (Archivar a)Seleccione «USB» o «TP Server» (Servidor FTP). Con-

sulte la ubicación del conector USB en Figura 8).
Archive Type (Tipo de archivado)Seleccione en la lista desplegable la cantidad 

de datos necesaria que se archivará.

Haga clic en «Start» (Inicio) para iniciar el archivado.

Configuración IOC
Al hacer clic en la imagen del IOC en la página de inicio se abre a página de 
configuración del dispositivo  (Figura 168) que ofrece los detalles básicos sobre la 
configuración del dispositivo. Toda la información es de solo lectura.

Figura 168 Configuración de dispositivo
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Configuración del módulo de E/S
No implementado en esta versión.

Resumen del sistema
Esta página muestra todas las alarmas activas del sistema y contiene una tabla 
aparte que muestra la frecuencia de registro, el estado de registro, el estado de 
alarma y el estado de mensaje para cada grupo disponible.

Figura 169 Resumen del sistema
Nota: Una vez se ha visitado la página de mensajes para el grupo desde cualquiera 
de las cuatro conexiones disponibles al «Web Server» (Servidor web), desaparecerá 
el icono de estado del mensaje para el grupo de todas las conexiones al «Web 
Server» (Servidor web).

Datos de contacto
Contiene enlaces a los siguientes sitios de Eurotherm.

Servicios acreditados: http://www.eurotherm.co.uk/services/accredited-services/

Atención al cliente y soporte técnico: http://www.getsatisfaction.com/eurotherm/

Instalación y puesta en servicio:
http://www.eurotherm.co.uk/services/installation-and-commissioning/

Servicios de reparación y soporte:
http://www.eurotherm.co.uk/services/service-and-repair/

Indicador rojo = grupo no 
registrando

Indicador verde = grupo 
registrando

Alarmas de sistema

El grupo tiene una alarma 
activa o sin reconocer.

Utilice la barra de 
desplazamiento para ver 
otros grupos

Mensaje no visto 
presente (véase nota)
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Figura 170 Página con los enlaces de contacto

Mensajes de error
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Imposible conectar con el error

Figura 171 Imposible conectar con el error
Este mensaje o uno similar, en función del navegador utilizado, aparece cuando no 
es posible contactar con el dispositivo, generalmente porque no está en la misma red 
que el host, porque está desactivado, o porque está deshabilitado «Server Enable» 
(Servidor habilitado) en la configuración de Web Server (Servidor web) (Véase «Web 
Server» [Servidor web]).

Nota: Para acceso web seguro (https), el versadac incluye de fábrica certificados 
SSL autofirmados. Es posible instalar certificados SSL personalizados, en caso 
necesario. Deben estar en formato pem y deben incluirse en un archivo de 
actualización ssl_cert.tgz. Es posible obtener detalles sobre cómo puede obtenerse 
del soporte técnico de Eurotherm. Los certificados SSL se instalan usando 
«Instrument/upgrade» (Instrumento/actualización) ("Actualización" en la página 74) 
ajustando el tipo de actualización en «SSl cert via USB» o en «SSL cert via FTP». 
Es posible volver a los certificados suministrados de fábrica usando el parámetro 
«DefaultSSL» (SSL por defecto) en «Instrument/upgrade» 
(Instrumento/actualización) (véase "Menú de seguridad" en la página 72).
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Otros mensajes de error
A continuación, se detallan los mensajes de error que pueden mostrarse. Los 
mensajes de error aparecen en el formato que se muestra en Figura 172, y se borran 
de la pantalla al hacer clic en la cruz blanca en la esquina superior derecha.

Figura 172 Mensajes de error por defecto

Acceso denegado El dispositivo está en modo de configuración
Se produce cuando se intenta iniciar sesión en Web Server (Servidor web) cuando el 
dispositivo está en modo de configuración.

Abra iTools y salga del modo de configuración.

Modo de configuración activo, se ha cerrado la sesión
El Web Server (Servidor web) cierra la sesión de todos los usuarios al poner el 
dispositivo en el modo de configuración. Vuelva a iniciar sesión de nuevo.

Los usuarios predefinidos no pueden acceder a la funcionalidad 
web
Se muestra si se intenta iniciar sesión mediante un usuario predefinido (como 
Engineer [Ingeniero], Operator [Operador], etc.)

Imposible conectar después de cinco intentos
Este mensaje aparece si se pierde la conexión con el dispositivo, normalmente 
porque el dispositivo pierde la alimentación, se desconecta el cable de red o surge 
cualquier otro problema de comunicaciones (quizás un tiempo de espera) entre el 
host y el dispositivo.

El problema puede solucionarse por sí solo, en cuyo caso al hacer clic en el botón 
«Refresh now» (Actualizar ahora) el usuario volverá a la página anterior mostrada o 
a la página de inicio de sesión.

De lo contrario, las comunicaciones deben restablecerse manualmente antes de que 
el botón «Refresh now» (Actualizar ahora) tenga algún efecto.

Datos históricos no válidos para esta configuración
Se muestra si se intenta seleccionar el modo de tendencia histórica para un grupo 
que no contiene ningún punto.

Contraseña no válida
Se produce si se intenta iniciar sesión usando una contraseña no asociada con la ID 
de usuario asociado.

No hay más sesiones disponibles
Aparece cuando se intenta iniciar sesión cuando ya hay cuatro ordenadores 
separados conectados.

Haga clic aquí para borrar



Servidor web Versadac

198 HA031352 Edición 3 

No hay puntos configurados para este grupo
Se muestra si se intenta seleccionar un modo de tendencia para un grupo que no 
contiene ningún punto. Seleccione otro grupo o configure el grupo seleccionado de 
forma que haya al menos un punto en él (véase "Configuración de registro de grupo" 
en la página 90).

No existe la cuenta del usuario
Se produce cuando se intenta iniciar sesión usando un nombre de usuario 
desconocido.

Cuentas de usuario deshabilitadas
Aparece si se intenta iniciar sesión usando una cuenta de usuario deshabilitada.

Cuentas de usuario caducada
Aparece si se intenta iniciar sesión usando una cuenta de usuario caducada.

El usuario no tiene permiso de acceso web
Aparece si intenta iniciar sesión un usuario sin permisos de acceso web.

Nota: Nota: Los intentos de inicio de sesión incorrectos sucesivos añaden un 
retardo de 2 segundos acumulado al tiempo de inicio de sesión del dispositivo, lo 
que tiene como objeto evitar los ataques de contraseña por fuerza bruta.
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Anexo A: Especificaciones
Categoría de instalación y grado de contaminación

Este producto se ha diseñado de acuerdo con la norma BS EN61010 para categoría 
de instalación II y grado de contaminación 2. Se definen del siguiente modo:

Categoría de instalación II
La tensión nominal impulsiva para equipos con alimentación nominal de 230 V es de 
2.500 V.

Grado de contaminación 2
Normalmente solo se genera contaminación no conductiva. No obstante, en 
ocasiones se debe esperar una conductividad temporal causada por condensación.

Especificaciones generales

Especificaciones físicas
Nota: Consulte Figura 1 y Figura 2 para consultar más detalles de las dimensiones.

Dimensiones de la unidad base
Módulo 0: 61mm (ancho) x 180mm (alto) x 132mm (fondo)
Módulo 4: 172,4 mm (ancho) x 180 mm (alto) x 132 mm (fondo)
Módulo 8: 274 mm (ancho) x 180mm (alto) x 132mm (fondo)
Módulo 16: 477 mm (ancho) x 180mm (alto) x 132mm (fondo)

Centros de fijación de la unidad base
Módulo 0: 26 mm
Módulo 4: 127,4 mm (1,02 in)
Módulo 8: 229 mm
Módulo 16: 432,2 mm (17,016 in)

Peso
Módulo 0 de la unidad base: 0,7 kg Incluido IOC
4 vías: Sin módulos = 0,7 kg. Incluidos IOC y 4 x módulos de E/S = 1,65 kg máx.
8 vías: Sin módulos = 0,98kg Incluidos IOC y 8 x módulos de E/S = 3,1 kg máx.
16 vías: Sin módulos = 1,6kg. Incluidos IOC y 16 x módulos de E/S = 5,24 kg máx.

Eléctricas
Nota: Si la tensión de alimentación cae por debajo de 19,2 VCC durante el inicio, el 
registrador puede empezar a reiniciarse continuamente.
Conexiones de toma a tierra Toma a tierra en la brida frontal inferior de la unidad base
Tensión de alimentación 24 VCC (±20 %)
Potencia de alimentación (max.) 82 W (base de 16 módulos)
Pico de tensión (máx.) 8 A
Suministro de reserva Pila botón BR2032 de litio instalada en la unidad terminal IOC. (Consulte Fi-

gura 8).
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Especificaciones ambientales

Temperatura Almacenamiento: De -20 a +85°C
Funcionamiento: de -0 a +55 °C

Humedad     Almacenamiento/funcionamiento: de 5 a 95 % RH (punto de rocío 50 °C) (Consulte el gráfico)
Atmósfera  No corrosiva, no explosiva.
Altitud (máx.) 2.000 m
Protección ambiental Panel: BS EN60529:IP20
RFI Emisiones EMC: BS EN61326-1:2006 clase A

Inmunidad EMC: BS EN61326-1 :2006 lugares industriales
Especificaciones de seguridad eléctrica BS EN61010-1: 2001 (consulte la sección «A1» anterior); UL61010
Vibración Según BS EN61131-2 (de 9 a 150 Hz a 0,5 G; 1 octava por minuto).
Choque  Resistencia a impactos BS EN61010 (prueba de caída en bordes 100 mm)
EmbalajeBS EN61131-2 (véase"Desembalaje del dispositivo" en la página 11)

Caída libre: BS EN60068-2-32, proc. 1 (5 caídas a 1 metro por cada una de las seis caras).
Inflamabilidad de los materiales plásticos UL746 UL V0
Conformidad RoHS2 UE; China

Autorizaciones
CE; cUL (UL61010); GOST

Comunicaciones vía Ethernet
Conectores: Conector RJ45 situado en el módulo IOC.

Soporte de red: Cables Ethernet categoría 5.
Protocolos: Modbus TCP RTU esclavo, FTP,
Velocidad: 10/100 Mb/s.

Topología de red: Conexión en estrella al concentrador.
Longitud de línea (máx.): 100 metros, ampliables con repetidor.

Asignación de dirección IP: Manual o DHCP.
Aislamiento: 50 V de CC; 30 V de CA. (IEEE 802.3)

Comunicaciones Modbus
Conector: Conector tipo D de 9 vías instalado en la unidad de terminal.

Soporte de red: EIA485, interruptor seleccionable como de 3 o 5 hilos.
Protocolos: MODBUS/JBUS RTU maestro y esclavo; entrada ASCII

Aislamiento: Ninguno.

Especificaciones de IOC

Unidad terminal

Especificaciones físicas
Dimensiones (aprox.) 50 mm (ancho) x 110 mm (alto)
Peso (aprox.) 0,1 kg
Interruptor de configuración

Segmento 1: Habilitar o deshabilitar depuración en serie
Segmento 2: línea Rx versadac con o sin terminación
Segmento 3: línea Rx versadac con o sin terminación
Segmento 4: selección de 3 hilos o 5 hilos
Segmento 5: selección de 3 hilos o 5 hilos

Nota: Los segmentos 4 y 5 deben ajustarse ambos en 3 hilos o en 5 hilos.
Segmentos de 6 a 8: No se usan en esta versión.

Conectores de usuario
Fuente de alimentación 2x bloques de terminal de 4 vías para alimentación.

Modbus Conector tipo D de 9 vías
USB Conector tipo A.

USB
Tipo de conector Tipo A situado en la unidad terminal IOC (véase figura 8)
USB estándar Comunicaciones host USB 2.0
Fuente de corriente 500 mA máx. (corriente limitada)
Fusible En IOC primario. No es sustituible por el usuario.

RH máxima con punto de rocío de 50 °C
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Módulo IOC

Hardware

Especificaciones generales
Dimensiones 25 mm (ancho) x 114,3 mm (alto) x 110 mm (fondo)
Memoria flash 128 MB

Indicadores LED
Estado (24 VCC nominal, alimentación principal), indicador de fallo, batería, co-
municaciones, Ethernet (velocidad), Ethernet (actividad), hardware USB y sof-
tware USB

Conexiones de usuario
Comunicaciones Ethernet Conector RJ45 en la parte inferior de la unidad IOC.

Nota: "Unidad de terminal del módulo controlador (IOC)" en la página 17 ofrece detalles de todos los LED del IOC
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Especificaciones del módulo de E/S

Módulo AI2

Especificaciones generales, comunes a todas las versiones 
(salvo indicación contraria)
Consumo energético 2 W máx.
Rechazo de modo común:
(47 a 63 Hz) >120 dB
Rechazo de modo serie:
(47 a 63 Hz) >60 dB
Aislamiento Entre canales: 300 V RMS o CC (aislamiento básico).

Al sistema: 300 V RMS o CC (doble aislamiento).
Tensión máx. en cualquier canal 10,3 VCC

Rango de entrada de termopar

entradas mV, entradas de termopar
Rango de entrada de -150 mV a 150 mV
Impedancia de entrada >100 MΩ (circuito de detección de rotura del sensor «Off» [desactivado])
Corriente de fuga de entrada >100 nA (circuito de detección de rotura del sensor «Off» [desactivado])
Precisión de calibración ±0,1 % del valor medido ±10 µV
Ruido 28 µV p-p con filtro desactivado: <4 µV p-p con filtro de 1,6 s (mejor con cons-

tantes de tiempo mayores).
Resolución Mejor que 2 µV con filtro de 1,6 s
Linealidad Mejor que 5 µV
Coeficiente de temperatura <40 ppm de lectura por °C
Protección de desconexión del sensor Conmutable como «High» (Alta), «Low» (Baja) u «Off» (desconectada). Co-

rriente del sensor: 125nA

Unión fría
Rango de temperatura: de -10 °C a +70 °C

Rechazo de CJ: >30:1
Precisión de CJ: ±0,5 °C típica (±1,0 °C máx.)

Tipo de sensor RTD Pt100  situado bajo el conector de entrada

Entrada de alta impedancia (solo canal dos)
Rango de entrada de 0,0 V a +1,8 V
Impedancia de entrada >100 MΩ (circuito de detección de rotura del sensor «Off» [desactivado])
Corriente de fuga de entrada >100 nA (circuito de detección de rotura del sensor «Off» [desactivado])
Precisión de calibración ±0,1 % del valor medido ±20 µV
Ruido <100 µV p-p con filtro desactivado: <15 µV p-p con filtro de 1,6 s (mejor con 

constantes de tiempo mayores).
Resolución Mejor que 7 µV con filtro de 1,6 s
Linealidad Mejor que 50 µV
Coeficiente de temperatura <40 ppm de lectura por °C

Rango de entrada de CC
Entradas de mV
Rango de entrada de -150 mV a +150 mV
Impedancia de entrada >100 MΩ (circuito de detección de rotura del sensor «Off» [desactivado])
Corriente de fuga de entrada >100 nA (circuito de detección de rotura del sensor «Off» [desactivado])
Precisión de calibración ±0,1 % del valor medido ±10 µV
Ruido <28 µV p-p con filtro desactivado: <4 µV p-p con filtro de 1,6 s (mejor con cons-

tantes de tiempo mayores).
Resolución Mejor que 2 µV con filtro de 1,6 s
Linealidad Mejor que 5 µV
Coeficiente de temperatura <40 ppm de lectura por °C
Protección de desconexión del sensor Conmutable como «High» (Alta), «Low» (Baja) u «Off» (desconectada). Co-

rriente del sensor: 125nA

Entrada de alta impedancia (solo canal dos)
Rango de entrada de 0,0 V a +1,8 V
Impedancia de entrada >100 MΩ (circuito de detección de rotura del sensor «Off» [desactivado])
Corriente de fuga de entrada >100 nA (circuito de detección de rotura del sensor «Off» [desactivado])
Precisión de calibración ±0,1 % del valor medido ±20 µV
Ruido <100 µV p-p con filtro desactivado: <15 µV p-p con filtro de 1,6 s (mejor con 

constantes de tiempo mayores).
Resolución Mejor que 7 µV con filtro de 1,6 s
Linealidad Mejor que 50 µV
Coeficiente de temperatura <40 ppm de lectura por °C

Entradas de tensión
Rango de entrada de -10,3 V a 10,3 V
Impedancia de entrada 303 kΩ
Precisión de calibración ±0,1 % del valor medido ±2 mV
Ruido <2 µV p-p con filtro desactivado: <0,4 mV p-p con filtro de 1,6 s (mejor con cons-

tantes de tiempo mayores).
Resolución Superior a 2 µV con filtro de 1,6 s
Linealidad Superior a 0,7 mV
Coeficiente de temperatura <40 ppm de lectura por °C
Entradas de resistencia
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Rango de entrada de 0 Ω a 560 Ω (incluye apoyo para las conexiones RTD de 2, 3 o 4 hilos)
Precisión de calibración ±0,1 % del valor medido
Ruido <0,05 Ω p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores).
Resolución Mejor que 0,02 Ω con filtro de 1 segundos
Linealidad Mejor que 0,05 Ω
Coeficiente de temperatura <30 ppm de lectura por °C

Entrada de alta resistencia
Rango de entrada de 0 a 7 kΩ
Precisión de calibración ±0,1 % del valor medido
Ruido <0,5 Ω p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores).
Resolución Mejor que 0,02 Ω con filtro de 1,6 s
Linealidad Mejor que 0,1 Ω
Coeficiente de temperatura <30 ppm de lectura por °C

Entradas de potenciómetro
Rango de entrada Rotación del 0 al 100 %
Resistencia de extremo a extremo de 100 Ω (mín.) a 6 kΩ (máx.)
Precisión de calibración ±0,1 % del valor medido
Ruido <0,01% p-p con filtro de 1,6 s (pot. de 5 kΩ); <0,3% p-p con filtro de 1,6 s (pot. 

de 100 Ω)
Resolución Mejor que 0,001 % con filtro de 1,6 s y pot. de 5 kΩ
Linealidad Mejor que 0,01 %
Coeficiente de temperatura <20 ppm de lectura por °C

Rango de entrada de mA
Entradas de lazo de 4 a 20mA
Rango de entrada de -25 mA a +25 mA con resistencia de carga de 5 Ω en unidad de terminal.
Precisión de calibración ±0,1 % del valor medido
Ruido <1 µA p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores)
Resolución Mejor que 0,05 μA con filtro de 1,6 s
Linealidad Mejor que 1 µA.
Coeficiente de temperatura <50 ppm de lectura por °C

Módulo AI3

Especificaciones generales
Consumo energéticoEntrada de corriente: 2,2W

Tres lazos de corriente: 1,5 W máx.
Rechazo de modo común (de 47 a 63 Hz) >120 dB
Rechazo de modo serie (de 47 a 63 Hz) >60 dB
Aislamiento Entre canales: 50 V RMS o CC (aislamiento básico).

Al sistema: 300 V RMS o CC (doble aislamiento).

Cumplimiento de Hart
La desconexión de los enlaces de circuito impreso (uno por canal) en la parte 
inferior de la unidad de terminal aplica resistencias de 195 Ω a los circuitos de 
entrada del módulo AI3  (véase "Unidad de terminal del módulo controlador 
(IOC)" en la página 17).

Entradas de canal
Rango de entrada de - 28 mV a +28 mV
Precisión de calibración ±0,1 % del valor medido
Ruido <1 µA p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores)
Resolución Mejor que 0,05 μA con filtro de 1,6 s
Linealidad Mejor que 1 µA.
Coeficiente de temperatura <50 ppm de lectura por °C
Resistencia de carga 60 Ω nominales; 50 mA de corriente máxima
PSU del canal de 22 V (mín. a 21 mA) a 30V (máx.) a 4 mA

Protección IP: 30 mA (nominal) disparo de corriente, restablecimiento automático.

Módulo AI4
Nota: Los canales 1 y 3 admiten las acciones de desconexión del sensor «Hi» (Alta), «Lo» (Baja) y «None» 
(Ninguna); los canales 2 y 4 solo admiten «Hi» (Alta).

Especificaciones generales (se aplica a todas las versiones de 
AI4)
Consumo energético 2 W máx.
Rechazo de modo común:
(47 a 63 Hz) >120 dB
Rechazo de modo serie:
(47 a 63 Hz) >60 dB
Aislamiento Del canal 1 al canal 2: Sin aislamiento

Del canal 3 al canal 4: Sin aislamiento
Del canal 1 o 2 al canal 3 o 4: 300 V RMS o CC (aislamiento básico).

Al sistema: 300 V RMS o CC (doble aislamiento).
Tensión máx. en cualquier canal: 5 VCC
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Rango de entrada de termopar

Entradas de termopar
Rango de entrada de -150 mV a 150 mV
Impedancia de entrada >20 MΩ (circuito de detección de rotura del sensor «Off» [Desactivado])
Corriente de fugas de entrada <125 nA (circuito de detección de rotura del sensor «Off» [Desactivado])
Precisión de calibración ±0,1 % del valor medido ±10 µV
Ruido <4 µV p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores)
Resolución Mejor que 2 µV con filtro de 1,6 s
Linealidad Mejor que 5 µV
Coeficiente de temperatura <40 ppm de lectura por °C
Protección de desconexión del sensor Tirador fijo. Corriente del sensor: 125nA
Unión fría

Rango de temperatura: de -10 ? a +70 ?
Rechazo de CJ: >30:1
Precisión de CJ: ±0,5° C típica (±1° C máxima)

Tipo de sensor RTD Pt100  situado bajo el conector de entrada

Rango de entrada de mV

Entradas de termopar
Rango de entrada de -150 mV a 150 mV
Impedancia de entrada >20 MΩ (circuito de detección de rotura del sensor «Off» [Desactivado])
Corriente de fugas de entrada <125 nA (circuito de detección de rotura del sensor «Off» [Desactivado])
Precisión de calibración ±0,1 % del valor medido ±10 µV
Ruido <4 µV p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores)
Resolución Mejor que 2 µV con filtro de 1,6 s
Linealidad Mejor que 5 µV
Coeficiente de temperatura <40 ppm de lectura por °C

Rango de entrada de mA
Rango de entrada de - 25 mV a +25 mV
Precisión de calibración ±0,1 % del valor medido ±2 µV
Ruido <1 µA p-p con filtro de 1,6 s (mejor con constantes de tiempo mayores)
Resolución Mejor que 0,05 μA con filtro de 1,6 s
Linealidad Mejor que 1 µA.
Coeficiente de temperatura <50 ppm de lectura por °C
Resistencia de carga5 Ω ±1 % (instalado en la unidad de terminal)

Módulo AI8

Especificaciones generales (se aplica a todas las versiones de 
AI8)

Número de canales 8 (4 para el RTD)
Consumo energético del módulo:<1.8 W
Rechazo de modo común (de 47 a 63 Hz)
En relación con el sistema, por ejemplo, en aislamiento galvánico >140dB
Rechazo de modo serie (de 47 a 63 Hz) >60 dB
Aislamiento Al sistema: Reforzado para redes <300V CA/CC - Categoría de instalación II.

Entre canales: Aislamiento galvánico por parejas (canales 1 & 5, 2 & 6, 3 & 7 y 4 & 8) 
Aislamiento básico para redes <300V CA/CC - Categoría de instalación II.
Aislamiento diferencial dentro del rango de ±1 V entre los dos canales de cada 
par en los módulos de termopar, mV y mA. El RTD proporcionar aislamiento bá-
sico (<300 V CA/CC) entre canales

Rango de entrada de mV
Tipos de transmisores aptosfuentes de mV con impedancia de salida <1 KΩ (flotantes o conectadas a tierra)
Rango de entrada +80mV
Impedancia de entrada10 MΩ diferencial, 2.5 MΩ común
Corriente de fuga de entrada<±25 nA (@ < 1 V común)
Precisión de calibración ±0,1 % de lectura de mV para valores que no estén entre los -8 mV y los +8 mV (a 25 °C de tem-

peratura ambiente)
±8μV para valores entre los -8 mV y los +8 mV (a 25 °C de temperatura ambien-
te)

Rechazo de modo común de CC
(en relación con otros canales de la misma pareja) >105 dB para el desajuste de la impedancia de la fuente <100 Ω
Resolución o ruido>17 bits con filtro de 1,6s (±1.5 μV)

Tramo de 16 bits sin filtro (±3 μV)
Linealidad de 10 ppm de rango de entrada

Coeficiente de temperatura <±30 ppm por °C
Compensación cero <±3 μV
Deriva del desplazamiento
Detección de desconexión del sensor en 250 ms usando el pulso de 25 μA. Umbral  >50 kΩ
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Rango de entrada de termopar

Entradas de termopar
Termopares aptosB, C, D, E, G2, J, K, L, N, R, S, T, U, NiMo/NiCo, Platinel, Ni/MiMo, Pt20%Rh/Pt40%Rh.
Como entrada de mV, con
Precisión de calibración como para la entrada de mV, dividido por 

la sensibilidad del ter-
mopar elegido 
(mV/unidad de tempe-
ratura) a la temperatu-
ra de medida

Linealidad de linealización ±0.1 °C (desviación de 
las curvas definidas)

Detección de desconexión del sensor en 250 ms usando el pulso 
de 25 μA.
Umbral  >50 kΩ

Unión fría
Rechazo de CJ: >50:1 por defecto (de-

pendiendo de la sensi-
bilidad del termopar)

Precisión CJ interno: ±0.8 °C por defecto

Rango de entrada de mA
Tipos de transmisores aptos sensores 4-20 mA (flotantes o conectados a tierra)
Como entrada de mV, con
Rango de entrada -24 mA con 3,33 Ω de resistencia de carga en la unidad de terminal
Precisión de calibración ±0,15% de lectura de mV para valores que no estén entre los -8 mV y los +8 mV (a 25 °C de tem-

peratura ambiente)
±3.6μA para valores entre los -2,4 mV y los +2,4 mV (a 25 °C de temperatura 
ambiente)

Resolución o Ruido >17 bit s con filtro de 1,6 s (±0.5 μA)
Tramo de 16 bits sin filtro (±1 μV)

Rechazo de modo común de CC
(en relación con otros canales de la misma pareja) >105 dB para el desajuste de la impedancia de la fuente <100 Ω
Linealidad de 10 ppm de extensión
Coeficiente de temperatura <±40ppm por °C (usando una resistencia de carga de 10 ppm)
Compensación cero <±1 μV
Deriva del desplazamiento <±8 pA/°C
Detección de desconexión del sensor No se detecta en el hardware (el software puede detectar la corriente en ese rango)

Rango de entrada de RTD
Esquema de conexión conexiones de 3 y 2 hilos conectadas a los terminales A y B, con enlace entre el terminal B y C. Del 

de 4 hilos se deja uno desconectado.
Número de canales  4
Tipos de RTD aptos Pt100, Pt1000
Rangos de entrada de 0 Ω a 500 Ω y de 0 Ω a 5 kΩ (incluida la resistencia de plomo)
Precisión de calibraciónrango de 500Ω ±0,1 % de lectura de resistencia por encima del 10 % de rango (>50 Ω) (a 25 °C 

de temperatura ambiente)
±50 mΩ por debajo del 10 %

rango de 5 kΩ  ±0,1 % de lectura de resistencia por encima del 10 % de rango (>500 Ω) (a 
25 °C de temperatura ambiente)
±500 mΩ por debajo del 10 %

Resolución o ruido >17 bits (±8 mΩ) (con filtro de 1,6 s)
16 bits (±16 mΩ) sin filtro

Linealidad rango de entrada de 20 ppm
Coeficiente de temperatura <±20 ppm por °C
Detección de desconexión del sensor En 125 ms por la detección de resistencia alta

Módulo AO2

Especificaciones generales
Consumo energético 2,2 W máx.
Aislamiento Entre canales: 300 V RMS o CC (aislamiento básico).

Al sistema: 300 V RMS o CC (doble aislamiento).

Salidas de corriente
Rango de salida  de -0,1 a +20,5 mA
Límites de carga de 0 a 500 Ω
Precisión de calibración Superior al ±0,1 % de la lectura
Linealidad rango de 0,03 % (0,7 µA)
Resolución Superior a 1 parte en 10 000 (1 µA por defecto)

Salidas de tensión
Límites de carga de salida

Rango de -0,1 a 10,1 V: 550 Ω mín.
Rango de -0,3 V a +10,3 V: 1500 Ω mín.

Precisión de calibración Superior al ±0,1 % de la lectura
Linealidad rango de 0,03 % (0,3 mV)
ResoluciónSuperior a 1 parte en 10 000 (0,5 mV por defecto)

Ejemplo:
Precisión de calibración usando termopar K a 500 

°C
500 °C20 = 20 644 mV
± 0.1 % de 20 644mV = ±20 644 μV
Sensibilidad del termopar a 500 ºC = 43 μV por °C
El error de calibración es ±20 644/43 °C = ±0.48 °C
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Módulo DI16

Especificaciones generales
Consumo energético Modo lógico: 0,75 W máx.

Modo de contacto: 2,0 W máx.
Aislamiento Entre canales: Los canales comparten conexiones («C») «comunes».

Al sistema: 300 V RMS o CC (doble aislamiento).
Ancho mínimo de pulso 78 125 ms
Tensión máx. en cualquier canal 30 VCC

Entradas lógicas
Tensión desconectada (lógica 0) de -30 V a +5 VCC
Tensión conectada (lógica 1) de 10,8 V a 30 VCC
Corriente de entrada 3,8 mA aprox. a 12 VCC; 2,8 mA aprox. a 24 VCC

Entradas de contacto
Resistencia desconectada (0) >7 kΩ
Resistencia activada 1 <1 kΩ
Corriente de sellado 4 mA mín.
Alimentación aislada interna del módulo (tensión del terminal P)

de 16 a 18 VCC
Tensión de sellado (efectiva) 12 VCC mín.

Módulo RLY8
Nota: Cada entrada está equipada con un condensador 100 pF para cumplir la norma EMC. Esto causa una 
corriente de fuga a tierra de unos 0,02 mA a 240 VCA a 60 Hz por cada relé.

Especificaciones generales
Consumo energético 2,5 W máx.
Aislamiento Entre canales: 300 V RMS o CC (aislamiento básico).

Entre canal y sistema: 300 V RMS o CC (doble aislamiento).
Vida del contacto (carga resistiva) 240 VCA, 2 A: >6x105 operaciones

240 VCA, 1 A: >107 operaciones
Vida del contacto (carga inductiva) Según las curvas de reducción
Vida mecánica >3x107 operaciones

Especificación del relé
Material de contacto AgCdO
Intensidad máxima de corriente de 2 A a 240 VCA; de 0,5 A a 200 VCC, aumenta a 2 A en 50 VCC (resistiva)
Intensidad mínima de corriente 100 mA en 12 V
Formato de contacto Contactos comunes y normalmente abiertos. (Circuito abierto con relé desacti-

vado)
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F1 = Resultados medidos
F2 = Valores típicos
Vida = Vida resistiva x factor de reducción

Curvas de reducción de carga inductiva CA

Factor de potencia (cos φ)
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Apéndice B: Referencia
Batería

El registrador cuenta con una batería que permite guardar la configuración y otros 
ajustes incluso estando apagado.La vida útil de la batería es de 1 año sin 
alimentación, siempre y cuando se mantenga a una temperatura ambiente de 25 ºC; 
en caso de que, de modo constante, funcione a una temperatura ambiente elevada, 
puede que se reduzca su vida útil.

Tan solo se notificará un fallo de batería cuando se vuelva a encender el registrador, 
es probable que una de las señales sea la pérdida de los valores paramétricos.

La batería no está diseñada para que el usuario realice su mantenimiento.Si 
cualquier registrador muestra señales de un fallo de batería, por favor póngase en 
contacto con su proveedor lo antes posible para que le aconseje o haga los trámites 
necesarios para el reemplazo de la batería.

* La clonación de un archivo se realiza con iTools, un paquete exclusivo que puede 
descargarse en www.eurotherm.com

Configuración de un servidor FTP usando Filezilla

 Descarga
FileZilla se puede descargar en internet de forma gratuita (busque «FileZilla server 
download» [descargar servidor FileZilla]).

1. Siga las instrucciones en pantalla para descargar la última versión.

2. Responda «No» a la pregunta «Do you want to view only the webpage content 
that was delivered securely? (¿Desea ver solo el contenido de la página web que 
fue entregado de manera segura?)».

3. Si es necesario, habilite la descarga de archivos.

AVISO
Dado que los ajustes de los parámetros son específicos de cada aplicación, 
se recomienda encarecidamente que, durante el funcionamiento correcto del 
registrador, se clone un archivo* y se almacene en una ubicación segura 
conocida para que estos ajustes puedan transferirse al registrador de 
repuesto o restaurarse en el propio dispositivo tras el reemplazo de la 
batería.O bien, asegúrese de mantener un registro de su configuración y otros 
ajustes importantes para que se puedan restablecer manualmente.
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4. Cuando Windows muestre el mensaje «Do you want to run or save this file?» 
(¿Desea guardar o ejecutar este archivo?), pulse «Run» (Ejecutar).

5. Cuando Windows muestre el mensaje «The Publisher could not be verified...» 
(No se pudo verificar la procedencia de...) , pulse «Run» (Ejecutar).

6. Acepte o rechace el acuerdo de licencia.Si lo acepta, seleccione «Standard» 
(Estándar) como tipo de instalación.

7. Elija el directorio de destino para el archivo.
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8. Seleccione la configuración inicial.

9. Pulse "Close" cuando termine la instalación.

10. Pulse «OK» en la ventana «Connect to Server» (Conectar con el servidor).

Configuración del servidor
1. Cree una nueva carpeta (directorio) llamada, por ejemplo, «Archive» (Archivo) 

en una ubicación adecuada, como en C: o en el escritorio.
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2. En la ventana del servidor FileZilla, pulse «File» (Archivo) y seleccione «Connect 
to server...» (Conectar con el servidor).

Cuando se muestre el mensaje «Logged on» (Conectado),

3. Seleccione «Users» (Usuarios) en el menú «Edit» (Edición). Cuando se abra la 
ventana «General», pulse «Add» (Añadir), escriba el nombre del usuario y pulse 
«OK».El nombre empleado en este ejemplo es «GeneralUser», aunque puede 
ser más conveniente usar «anonymous» (Anonimo), ya que es el nombre 
predeterminado en el registrador o controlador.Haga clic en «OK».

4. Seleccione «Users» (Usuarios) en el menú «Edit» (Edición). Cuando se abra la 
ventana «Shared Folders» (Carpetas compartidas), pulse «Add» (Añadir).
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En la ventana de exploración, el usuario puede seleccionar la carpeta nueva 
(«Archive» [Archivo]) creada en el paso 1.

Pulse «OK» para confirmar la selección. A continuación, la carpeta nueva se 
mostrará en la ventana central (con una «h» a la izquierda para indicar que es la 
carpeta de inicio en esta configuración de usuario de FTP).

5. Haga clic en la carpeta correspondiente para habilitar las casillas de 
verificación.Marque todas las casillas de verificación de «Files» (Archivos) y 
«Directories» (Directorios), y pulse «OK».

Configuración del PC
1. Pulse «Start» (Inicio) y, en la nueva ventana, seleccione «Control Panel» (Panel 

de control).Haga doble clic en «Windows Firewall» (Firewall de Windows).

2. En la nueva ventana, seleccione la pestaña «Exceptions» (Excepciones) y 
compruebe que «FTPControl» y «FTPData» están habilitas (marcadas).Si no es 
así, consulte al departamento de informática del usuario.
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3. Haga clic en «Add Program...» (Añadir programa) y seleccione el destino de 
Filezilla definido en el paso 7 de la sección de descarga (véase "Descarga" en la 
página 210).Seleccione «FileZilla server.exe» y pulse «Open» (Abrir).

Compruebe que «FileZilla server.exe» aparece en la lista de excepciones.

4. Haga clic en «OK».

Configuración del registrador o controlador
En el servidor FTP de la red ("ModBus TCP" en la página 86):

1. Especifique la dirección IP del PC configurado como servidor FTP en el campo 
«Primary Server» (Servidor primario).

2. Configure «Primary User» (Usuario primario) con el nombre de usuario 
(«GeneralUser» en este ejemplo) especificado en el paso 3 del procedimiento de 
configuración del servidor (véase "Configuración del servidor" en la página 212).
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3. Especifique la dirección IP de otro PC configurado como servidor FTP en el 
campo«Sec.Server» (Servidor secundario) y escriba el nombre de usuario en el 
campo«Sec.User Name» (Nombre secundario).

4. Configure los demás parámetros según sea necesario (véase "Archivado" en la 
página 82).

Nota: En el ejemplo anterior, no se ha habilitado el campo «Password» 
(Contraseña) en la página de configuración de cuentas de usuario (véase 
"Configuración del servidor" en la página 212), por lo que se ignorará cualquier 
contraseña primaria o secundaria.Si se hubiera especificado una contraseña en la 
página de configuración de cuentas de usuario,el campo «Primary (Sec.) Password» 
(Contraseña primaria o secundaria) tendría que estar configurado con la misma 
contraseña.

Actividad del archivo
Una vez iniciada una copia manual o automática, la página "FileZilla Server" muestra 
el estado de actividad a medida que se realiza la copia,Figura 173 muestra una 
ventana por defecto.La parte superior de la página muestra datos de las 
transacciones entre el servidor y los clientes a los que esté conectado,mientras que 
la parte inferior muestra datos de los archivos que se están transfiriendo.Estos 
ficheros se guardan en la carpeta «Archive» (Archivo).

Figura 173 Ventana de servidor FileZilla de actividad de transferencia de archivos 

Números de puertos TCP
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El registrador utiliza los siguientes puertos TCP:

Códigos ASCII
Este apartado incluye detalles de los caracteres ASCII que pueden utilizarse con la 
opción «Serial Comms» (Comunicaciones serie).Todos los caracteres ASCII 
indicados pueden usarse como caracteres de inicio o fin de mensaje, pero solo los 
caracteres con códigos decimales de 32 a 127 pueden usarse en los mensajes, ya 
que los códigos decimales de 0 a 31 se reemplazan por signos de interrogación.

Puerto Uso

20 Datos de FTP (protocolo de 
transferencia de archivos)

21 Control de FTP
502 Comunicaciones TCP ModBus

Caracter Decimal Hex Caracter Decimal Hex Caracter Decimal Hex Caracter Decimal Hex

NUL 0 00 Espacio 32 20 @ 64 40 « 96 60
SOH 1 01 ! 33 21 A 65 41 a 97 61
STX 2 02 « 34 22 B 66 42 b 98 62
ETX 3 03 # 35 23 C 67 43 c 99 63
EOT 4 04 $ 36 24 D 68 44 d 100 64
ENQ 5 05 % 37 25 E 69 45 e 101 65
ACK 6 06 & 38 26 F 70 46 o 102 66
BEL 7 07 ‘ 39 27 G 71 47 2 103 67
BS 8 08 ( 40 28 H 72 48 h 104 68
HT 9 09 ) 41 29 I 73 49 za 105 69
LF 10 0A * 42 2A J 74 4A j 106 6A
VT 11 0B + 43 2B K 75 4B k 107 6B
FF 12 0C , 44 2C L 76 4C l 108 6C
CR 13 0D - 45 2D M 77 4D m 109 6D
SO 14 0E . 46 2E N 78 4E n 110 6E
SI 15 0F / 47 2F O 79 4F o 111 6F
DLE 16 10 0 48 30 P 80 50 p 112 70
DC1 17 11 1 49 31 Q 81 51 q 113 71
DC2 18 12 2 50 32 R 82 52 r 114 72
DC3 19 13 3 51 33 S 83 53 s 115 73
DC4 20 14 4 52 34 T 84 54 t 116 74
NAK 21 15 5 53 35 U 85 55 u 117 75
SYN 22 16 6 54 36 V 86 56 v 118 76
ETB 23 17 7 55 37 W 87 57 w 119 77
CAN 24 18 8 56 38 X 88 58 x 120 78
EM 25 16 9 57 39 Y 89 59 sí 121 79
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Notas:
1. Todos los caracteres anteriores pueden usarse como caracteres de inicio o fin 

de mensaje (introducidos en decimal)
2. Si se usan los caracteres de 0 a 31 (de 00 a 1F) como caracteres del mensaje, 

serán sustituidos por signos de interrogación en la pantalla.

SUB 26 1A : 58 3A Z 90 5A z 122 7A
ESC 27 1B ; 59 3B [ 91 5B { 123 7B
FS 28 1C < 60 3C \ 92 5C | 124 7C
GS 29 1D = 61 3D ] 93 5D } 125 7D
RS 30 1E > 62 3E ^ 94 5E ~ 126 7E
US 31 1F ? 63 3F _ 95 5F No 

aparece
127 7F

Caracter Decimal Hex Caracter Decimal Hex Caracter Decimal Hex Caracter Decimal Hex
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